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1 SECTION 1 

INTRODUCTION 

2 SECTION 2: 

INTRODUCTION TO OFFICE ADMINISTRATION 

2.1 What is Office Administration 

Office Administration covers a basic knowledge of administrative and client services, communication 

skills and competency in computer typing, crucial to the successful functioning of any office or 

business environment. Office Administration will teach a learner essential skills for a prospective 

office environment for example how to communicate effectively in a professional situation, how to 

conduct and coordinate business office procedures and apply basic mathematical skills. It will 

enhance learners typing and internet skills as well as learning how to deal with customers and the 

reception area. 

 

The skills and the content embedded in the skills are taught over two years in Grade 4 and three 

years in Grade 5.  During each year in each grade all the topics are taught, and the teacher is allowed 

to adapt the difficulty level of the skills to the ability of the learner. 

 

The table below contains the topics in Office Administration highlighting the relevant focus areas: 

Office practice Computer application  Client services and communication 

Office equipment Keyboard techniques Hygiene and healthy habits 

Safety, health and 

environmental requirements 

Word processing and 

editing 

Office etiquette 

Office safety  Business documents Office first aid 

Reception area  Email Rights/responsibilities of office worker  

Computer care Job application Customer service  

Mailing Internet safety Personal finance  

Storage area Social networking safety Work ethics 

Filing   

 

2.2 Specific Aims:  

The purpose of this subject is to equip learners to work in an office and business environment. It is 

also the building block to advance the learner into a further qualification at a school for moderate 

intellectual disabilities (MID) or other institution where possible.  

 

This qualification recognizes the basic skills, knowledge and values acquired by learners to operate 

as efficient office workers. The aim of this qualification is to develop learners who, after completion, 

will be efficient in the following: 
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 Use and apply a variety of basic office administrative knowledge and skills such as filing, 

telephone and reception etiquette, receiving and sending mail, maintaining a safe working 

environment, using and caring for general office equipment. 

 

 Use and apply a variety of skills to produce an acceptable standard of business 

documentation using the available technology – covering general computer use and software 

(word processing, presentation and spreadsheets), internet and e-mail facilities. 

 

 Communicate (speak and demonstrate) effectively in order to achieve interpersonal, 

business and organizational objectives by reading of basic words, understanding and 

interpreting work instructions.  

 

2.3 Requirements for Office Administration as a subject  

2.3.1 Time Allocation 

The compulsory instructional time for the Vocational Learning Programme for learners experiencing 

severe intellectual disabilities amounts to 8 hours per 5-day cycle. Schools may offer either three (3) 

or four (4) vocational subjects, depending on the number of learners in the school and the resources 

available. The compulsory instructional time for Office Administration is either:  

 2 hours per 5-day cycle plus three (3) other vocational subjects or 

 2, 5 hours per 5-day cycle plus two (2) other vocational subjects. 

Twenty percent (20%) of the above mentioned time is utilized to teach subject content which should 

be embedded in teaching the learners to execute the skills. This implies that theoretical lessons 

should not be instructed in isolation, but during the teacher’s demonstration that takes place before 

the learners practise the skills. The learners are required to utilize eighty percent (80%) of the time 

to practise the various skills in the classroom. The Office Administration periods should be divided 

into two (2) timeslots.  

2.3.2 Resources 

2.3.2.1 Human Resources: 

An appropriately qualified teacher registered with SACE in line with the Collective Agreement 5 of 

2001 is required to teach Office Administration. 

 

Office Administration teachers are required to: 

Teach the subject content with confidence and flair 

Interact with learners in a relaxed but firm manner 

Manage the resourcing, budget & safety 

Manage the teaching environment 



 

2018   CAPS GRADE R-5 FOR LEARNERS WITH SEVERE INTELLECTUAL DISABILITY                                                             Page 3 

Conduct stock taking and inventory 

Plan for practical work 

Plan for theory lessons 

Conduct weekly practical sessions 

Maintain and service the classroom as a whole 

Maintain and service the tools and instruments 

Ensure learner safety 

Plan for Practical Assessment Tasks  

Carry out School Based Assessment (SBA) 

Implement innovative methods to keep the subject interesting 

Be self motivated to keep her/him abreast of the latest technological developments 

Regularly attend skills workshops 

 

2.3.2.2 Infrastructure and equipment  

The minimum infrastructure to teach the subject is: 

 A secure classroom 

 One computer per learner  

 One printer per network 

 Internet facilities 

 Microsoft Office package 

 Suitable tables, chairs and wooden block for short learners feet to assist with correct typing 

posture 

 Assistive keyboard and mouse devices 

 White/green board and/or data projector 

 General office stationary: stapler, punch, guillotine, calculator, files and folders etc. 

 Non-working telephone, telephone directory and diaries 

 Storage area (shelves or store room) and filing cabinet 

 Text books or worksheets with typing exercises, speed tests, etc. 

 Software: operating system, office suite (word processing, spread sheet, presentation) and 

security software 

 Lever arch files for each learner to serve as portfolio of work. 

 

2.3.2.3 Finances 

The subject may not be offered without the necessary finances provided by the school. 

 Software licensing 

 Cartridges, paper, storage media 
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 Breakage and maintenance (regular service plan) 

 Sustainability plan to upgrade or replace software and equipment regularly 

 Assistive keyboards and pointer devices and wooden blocks to lift feet 

 

2.3.3 Career opportunities 

 Secretarial services  

 Reception services  

 Switchboard operator  

 Filing or general office assistant 

 Typing and/or data capturing 

 Stock controller assistant 

 Mail room assistant 



 

 

3 SECTION 3: 

OVERVIEW OF TOPICS PER TERM AND ANNUAL TEACHING PLANS  

Each week has a compulsory contact time of 2 or 2.5 hours (depending on the number of vocational subjects offered at the school) for the subject Office 

Administration. 

3.1 Overview of theoretical topics  

The content is embedded in the skills and the learners should execute the skills in a simulated working environment re created in the classroom. The 

table below indicates the topics and content in the Office Administration learning programme in Grade 4 and 5. 

 

TOPIC Grade 4 Grade 5 

Office practice -Identify, point out or name the different parts of the 

computer. 

-Understand the basic operations on a computer. 

-Demonstrate the correct typing position and ergonomics. 

-Understand computer care. 

-Identify, point out or name general office equipment and 

what they are used for. 

-Understand general office equipment. 

-Understand the basic operation of a photocopying and fax 

machine.   

-Understand the basic principles of office safety. 

-Identify, point out or name official safety signs in the office. 

-Understand an emergency evacuation drill. 

-Understand the requirements for a successful reception 

area: verbal and non-verbal communication. 

-Identify, point out or name the different parts of the 

computer. 

-Demonstrate how to take care for a computer. 

-Demonstrate basic operations on the computer. 

-Use general office equipment and understand the basic 

operation of a photocopying, fax and shredder machine.   

-Understand different types of office layouts. 

-Interpret a basic office floor plan. 

-Understand what furniture is used in an office environment. 

-Understand why office cleanliness is important. 

-Understand basic principles of mailing systems. 

-Understand and name unsafe practices, hazards and 

dangerous substances and how to reduce or remove them. 

-Understand the need for and use of fire fighting equipment 

in the workplace. 
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-Understand the requirements for a successful reception 

area: characteristics of the office worker. 

-Understand the requirements for a successful reception 

area: effective communication. 

-Understand the requirements for a successful reception 

area: human relations. 

-Understand the difference between assets and consumables 

and how they are monitored and replaced.  

-Demonstrate an understanding of how to store stock safely 

and to use an inventory checklist.  

-Demonstrate an understanding of basic filing. 

Computer application -Identify, point out or name the different components on the 

keyboard. 

-Identify, point out or name the different parts of the 

keyboard that are used for entering and editing. 

-Demonstrate basic operations on the computer: to delete, 

select, copy and paste, cut and paste, drag and drop, find 

and replace. 

-Understand the basic operations on the computer: open a 

programme, navigate the desktop moving through windows, 

save a document, close a document and activate an existing 

document. 

-Identify, point out or name the components on the keyboard 

relating to the home row alphabet keys (asdfgh;lkj). 

-Identify, point out or name the components on the keyboard 

relating to the top row alphabet keys (qwertyuiop). 

-Identify, point out or name the components on the keyboard 

relating to the bottom row alphabet keys (zxcvbnm). 

-Identify, point out or name the home, bottom and top row on 

the keyboard and understand the correct typing position. 

-Understand the basic operations with a table in a word 

processor: insert a table, change or delete borders, shading, 

-Demonstrates knowledge of the parts of the keyboard and 

use the correct typing position: the function, alphabet, 

numeric, control, windows, shift, alt, enter and cursor keys. 

-Use the keyboard skilfully and accurately by typing the home 

row (asdfgh;lkj), top row (qwertyuiop) and bottom row 

(zxcvbnm), inserting a capital letter, using bold, italics and  

underline, change the font type and size and punctuation and  

special characters. Understand the use of the calculator 

functions. 

Word processor skills: 

-Demonstrate the basic editing functions in a paragraph: text 

selection, copy, paste, insert letters or words, delete letters or 

words, change order of words, insert or delete rows and 

columns, change borders and shadings, change cell 

alignment, change text direction, save with a new name.  

-Demonstrate basic file management.  

-Demonstrate basic operations with shapes: insert and edit a 

shape. 

-Demonstrate basic operations with clipart: insert a picture or 

clip art. 

-Demonstrate basic operations with text boxes and WordArt -
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vertical text, different alignment of cells and columns, insert 

or delete columns or rows, merge and split cells. 

-Understand basic formatting in a word processor: typing 

capital letters and using the header / footer function. 

-Understand basic formatting in a word processor: bold, 

italics and underline. 

-Understand basic formatting in a word processor: change 

the font type, size and colour. 

-Understand basic formatting in a word processor: change 

alignment (left, center, right, and justify) and the line spacing 

of the text.  

-Understand basic special characters in a word processor on 

the computer: type special characters, symbols and 

punctuation marks available on the keyboard 

(!@#$%^&*?<>.,) 

-Demonstrate basic page layout changes in a word 

processor : to change the A4 orientation to landscape or 

portrait, change the paper size and page margins.  

-Demonstrate the basic operating system features on the 

computer: how to print a document.  

Demonstrate basic picture editing. 

-Demonstrate the typing of a paragraph using bullets and 

numbering. 

-Demonstrate the use of indents and tabs.Understand 

-Demonstrate the use of the spelling and grammar tool. 

-Demonstrate an understanding of electronic mail. 

-Demonstrate and understanding of internet safety. 

-Demonstrate knowledge and understanding of 

responsibilities when learning about and using social media. 

 

 

 

 

 

 

 

Client services and 

communication 

-Understand healthy personal habits.  

-Understand the importance of personal grooming habits 

for customer services.  

-Understand dress code that is in accordance with a 

specific work place requirement. 

-Understand the basic terms related to HIV and AIDS.  

-Understand the basic principles of office safety.  

-Understands healthy personal habits and basic hygiene. 

-Understands unhealthy personal habits and bad basic 

hygiene and the basic principles of sick leave. 

-Interpret body language in a business environment. 

-Understand different methods of handshakes and the 

importance of personal space. 

-Understand basic first aid procedures for nose bleeds, cuts, 
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-Identify and or list the basic principles of fire safety and 

what to do if a fire breaks out in the office.  

-Understand basic first aid procedures for nose bleeds, 

cuts, scratches, fainting, bruising and sprains.  

-Identify, point out or name items needed in a first aid kit. 

-Understand basic telephone etiquette. 

-Speak professionally to clients over the telephone using 

general telephone etiquette. 

-Understand the difference between “needs” and “wants” 

concerning personal finance.  

-Understand personal income vs. expenditure concerning 

personal finance. 

-Show an understanding about the need for ethics in the 

workplace.  

-Understand the basic rights and responsibilities of the 

office worker 

-Understand the types of customers one can expect to 

come across in the work environment. 

-Understand how to greet a customer correctly. 

scratches, fainting, bruising and sprains.  

-Identify, point out or name potential hazards in the office 

environment.  

-Understand the need to be punctual at work, the smoking 

policy and good listening skills.  

-Understand the need for a positive attitude to work, to keep 

your colleagues informed about work activities and code of 

conduct in the workplace.  

-Differentiate between “needs” and wants” concerning 

personal finance.  

-Understand the basic personal financial principals of income 

vs. expenditure for example food, shelter, water air, bicycle, 

toys, sweets, bread or clothing. 

-Demonstrates knowledge of banking services regarding 

accounts, credit card facilities and ATM use.  

-Understands and deals with conflict in the office 

environment 

-Demonstrate an understanding of how to prepare a resume. 

-Demonstrate an understanding of how to prepare a cover 

letter for a resume. 

-Demonstrate an understanding of characteristics to ensure 

job success, workplace attire and personal hygiene.   
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3.2 Teaching plans  

 

A learner in Grade 4 will be in the grade for 2 years (14 &15 years old). The teaching plan includes two or more suggested activities, namely activity 1 

for the first year the learner is in the grade, and activity 2 for the second year the learner is in the grade. A learner in Grade 5 will be in the grade for 3 

years (16, 17 &18 years old). The teaching plan includes three suggested activities to be taught over the three years. Activity 1 is suggested for the first 

year the learner is in the grade, activity 2 for the second year the learner is in the grade and activity 3 for the third year the learner is in the grade. 

Activities should be chosen depending on resources, time available and level of understanding of learners.  

The Occupational Health and Safety (OHS) Act 85 of 1993 requires the teacher to comply with the safety regulations when issuing equipment and tools 

to the learners and the teacher may not leave learners unattended during Office Administration instructional time. A group discussion on the safety 

precautions that must be followed during all the instructional time is compulsory. Learners with a severe intellectual disability are not always able to 

make abstract judgements, and they are often not able to apply learned knowledge from one topic to the next. Impulsive behaviour as well as the 

inability to make fast decisions can easily lead to learners finding themselves in, or being exposed to dangerous situations.  
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3.2.1 Grade 4: 1st and 2nd year Term 1 

Grade 4: Term 1 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

1-2 Office 

practice 

Office 

equipment 

 

Practical 

introduction to 

a personal 

computer 

system 

Identify, point out or name the different parts of 

the computer: 

Hardware: 

A. The tower case, disk 

drive and USB ports. 

 

B. Input devices such as the keyboard, 

mouse, touchpad, scanner, digital camera 

and graphics tablet. 

 

Grade 4: First year: 

Activity 1: Identify, point out or name the tower case components and its 

function: 

Components: 

CD  and DVD drive to insert disks 

USB ports to insert devices 

Activity 2: Identify, point out or name the input devices and its functions: 

Keyboard  

Mouse  

Touchpad  

Scanner  

Digital camera  

Graphics tablet 

Activity 3:  Identify, point out or name the output devices and its functions: 

The monitor  

The speaker/headset  

The printer  

Grade 4: Second year:  

Activity 1: Make a collage or poster that illustrates the components, input and 

output devices of a computer. 

Activity 2: Participate in a discussion of the functions of input and output devices 

of a computer.  Write key words on the board.  
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Grade 4: Term 1 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

C.  Output devices such as the monitor, speaker 

and printer. 

 

Activity 3: Complete a word search worksheet about components, input and 

output devices of a computer and paste in the workbooks.  

Computer 

application 

 

Practical 

introduction to 

the keyboard  

Identify, point out or name the different 

components on the keyboard i.e. the function, 

typing, numeric, control, windows, shift, alt, enter 

and cursor keys. 

 

 

Grade 4: First year:  

Activity 1: Participate in a discussion about the different components on the 

keyboard. Write key words on the board.  

Activity 2: Practical demonstration by teacher showing the parts of a keyboard 

(alphabet keys, numeric pad, function keys, special control keys and cursor keys. 

Activity 3: Complete a matching worksheet pairing the names of the 

components on the keyboard with the correct picture and paste in the 

workbooks.  

Grade 4: Second year:  

Activity 1:  Identify, point out or name the different components on the keyboard, 

namely the function, typing, numeric, control, windows, shift, alt, enter and cursor 

keys. 

Activity 2: Demonstrate what the function keys do by typing short words in a text 

document and then using the function keys. 

Activity 3: Make a collage or poster using pictures or words about the parts of 

the keyboard. 
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Grade 4: Term 1 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Client 

services and 

communi-

cation 

 

Practical 

introduction to 

good hygiene 

and healthy 

habits 

Understand healthy personal habits for e.g. brush 

your teeth twice daily, shower or bath once a day, 

wash your hair regularly and wash your hands 

often.  

  

Grade 4: First year:  

Activity 1: Participate in a discussion about what healthy personal habits are. 

Write down key words on the board.  

Activity 2: Practice to wash and dry their hands as well as role- play how to 

wash their hair and brush their teeth. 

Activity 3: Make a collage or poster depicting good hygiene and healthy habits. 

Grade 4: Second year:  

Activity 1: View videos about the importance of being and looking healthy in an 

office environment. Class discussion to follow after watching the video on what 

was learned. 

Activity 2: Show and tell the class about different products that are used to 

ensure personal hygiene.  

Activity 3: Complete a worksheet about good hygiene and healthy habits by 

listing good hygiene and healthy habits in column A and how often this is 

required in column B.  

3-4 

 

Office 

practice 

Office 

equipment 

 

Practical 

introduction to 

a personal 

Understand the basic operations on a computer: 

switch the computer on and off, move and click 

the mouse correctly, identify the basic keys on the 

keyboard, identify the icons of the programmes 

on the computer and exit the programmes. 

 

 

 

Grade 4: First year:  

Activity 1: Practical demonstration by teacher on how to switch the computer on 

and off, log-in, move and click the mouse correctly, identify the basic keys on the 

keyboard, identify the icons of the programmes on the computer and exit the 

programmes. 

Activity 2: View videos about how to move and click the mouse correctly and 

discuss techniques learned in groups. Class discussion to follow after watching 

the video on what was learned. Fill in the missing words on a worksheet 

depicting the different clicks of the mouse.  
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Grade 4: Term 1 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

computer 

system  

Activity 3: Practice to open and close specific programmes identified by the 

teacher on the computer. 

Grade 4: Second year:  

Activity 1: Demonstrate how to switch the computer on and off by following 

correct procedure. 

Activity 2: Complete a matching worksheet pairing the icons of the programmes 

with the correct name of the programme and paste in the workbooks. 

Activity 3: Show and tell the class about the basic keys on the keyboard and 

their functions.  

Computer 

application 

 

Practical 

introduction to 

keyboard 

skills 

Identify, point out or name the different parts of 

the keyboard that are used for entering and 

editing (enter, backspace, space bar, delete keys 

and navigation/cursor keys (arrows for up, down, 

left and right). 

 

 

Grade 4: First year:  

Activity 1: Practical demonstration by teacher on parts of the keyboard used for 

entering and editing: enter, back space, delete, space bar and cursor keys. 

Activity 2: Practice using the enter key by typing short words for e.g. name and 

surname, then pressing the enter key. Vary the instruction and ask learners to 

press the space bar between every letter of their name and surname. 

Activity 3:  Practice using the space bar key by typing short words for e.g. name 

and surname, then pressing the space bar key.   

Grade 4: Second year:  

Activity 1: Identify, point out or name the entering and editing keys named by 

teacher for e.g. enter, backspace, delete, space bar and cursor keys.  

Activity 2: Practice to use the cursor keys by typing short words for e.g. name, 

surname, address, telephone number etc. Show learners how to use the 

navigation / cursor keys to go to a specific letter that was typed and then press 

back space or delete keys. Repeat the activity until the learner understands the 
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Grade 4: Term 1 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

functions.  

Activity 3: Complete a worksheet by filling in missing words on the keyboard for 

entering and editing and paste in the workbooks.  

Client 

services and 

communi-

cation 

Good hygiene 

and healthy 

habits 

Understand the importance of personal grooming 

habits for customer services.  

 

Grade 4: First year:  

Activity 1: Participate in a discussion about the meaning of customer services 

and write down key words on the board.  

Activity 2: Discuss in groups the importance of the appearance of the office 

worker and the effect it has on customer services. Present your findings to the 

class.  

Activity 3: Bring clothes from home and show and tell about the appropriate 

appearance of an office worker.  

Grade 4: Second year:  

Activity 1: Identify, name and list words associated with customer services.  

Activity 2: Design a poster to illustrate the appropriate appearance of the office 

worker and show the class.  

Activity 3: Bring clothes from home and show and tell about the appropriate 

appearance of an office worker. 
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Grade 4: Term 1 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

5-6 Office 

Practice 

 

Health and 

environmental 

requirements  

 

Typing 

position  

 

Demonstrate the correct typing position and 

ergonomics.    

 

 

 

 

 

 

 

Grade 4: First year:  

Activity 1: Participate in a discussion about the correct posture in front of the 

computer and brain storm ideas on how to place body, hands and fingers. 

Practice the typing position. Teacher’s note: 

http://www.freetypinggame.net/proper-hand-placement.asp gives the 

following tips:  

Body Position  

You should sit with your back straight and your feet flat. Your feet should be 

about shoulder length apart. This will give your back and shoulders the least 

amount of stress while typing.  

Monitor position 

The monitor should be completely viewable when you 

are looking straight ahead. Usually the top of the 

monitor should be at eye height or just above the 

eyes.  

Keyboard Position 

The keyboard is best in a flat position, at a height that 

allows your forearms to be parallel to the floor. Often a 

keyboard tray beneath the desk can help. We do not recommend using the pegs 

in the back of most keyboards or the use of wrist rests.  

Arm and Hand Position 

Your forearms should be parallel to the floor. Your wrists and hands should be 

straight. Your wrists should NOT rest on the desk or table. This is very important 

and a common error!  
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Grade 4: Term 1 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Finger Position 

Your fingers should barely touch the home row keys. Let your left forefinger 

naturally sit on the F key, and then place the middle finger on the D key, the ring 

on the S key and the pinky on the A. Do the same with the right hand, beginning 

with the forefinger, let it rest on the J Key. Place your middle finger on the K key, 

the ring finger on the L and the pinky finger on the semicolon (;) key.  

       

Rest and stretch 

Be sure to take frequent breaks from the keyboard and from sitting. Stand 

up, stretch your arms and legs, and take a walk if you can. Some great 

stretching techniques that can be done before and after keyboarding can be 

seen here.  

www.ualr.edu/star/healthy_keyboarding/techniques.htm  

Activity 2: View videos about ergonomics and discuss if it corresponds with 

brains storming ideas.  

Activity 3: Instruct learners to locate the letters T, G, and B. Show learners 

how to divide the keyboard into two halves by drawing a red line along the 

right side of the T, G, and B keys. Discuss using the right hand to press keys 

on the right side of the keyboard; left hand for keys on the left side. (The line 

is red to serve as a reminder to STOP - not to cross to the other side of the 

keyboard.) (Teacher’s note: Activity taken from: 

alex.state.al.us/lesson_view.php?id=7505) 

http://www.ualr.edu/star/healthy_keyboarding/techniques.htm
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Grade 4: Term 1 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Grade 4: Second year:  

Activity 1: Find pictures that show the appropriate ergonomic sitting 

position. Work in groups and make a collage to put on class wall. Groups’ 

present their collage to the class. 

Activity 2:  View videos about ergonomics and discuss the basic principles 

of ergonomics. List key words in a text document.  

Activity 3: Research ergonomic guidelines on the internet and write down 

basic guidelines in a new document for when in front of a computer.  

Computer 

application 

 

Introduction 

to operating 

functions on 

the keyboard 

 

 

Demonstrate basic editing features in a word 

processor: to delete, select, copy and paste, 

cut and paste, drag and drop, find and 

replace.  

 

 

 

 

Teacher’s note: Activities and screenshots taken from the free website: 

http://www.gcflearnfree.org/word2010/2 

Grade 4: First year:  

Activity 1: To delete text:  

Move your mouse to the location where you want 

text to appear in the document. 

Click the mouse. The insertion point appears. 

Type the text you want to appear. 

Place the insertion point next to the text you want to delete. 

Press the Backspace key on your 

keyboard to delete text to the left of the 

insertion point. 

Press the Delete key on your keyboard to 

delete text to the right of the insertion 

point. 

Activity 2: To select text: 
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Grade 4: Term 1 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Place the insertion point next to the text you want to select. 

Click the mouse. While holding it down, drag your mouse over the text 

to select it. 

Release the mouse button. You 

have selected the text. 

A highlighted box will appear 

over the selected text. 

 

When you select text or images 

in Word, a hover toolbar with 

formatting options appears. This 

makes formatting commands easily accessible, which can save you 

time. If the toolbar does not appear at first, 

try moving the mouse over the selection. 

 

3.2.1.1 Activity 3: To copy and paste text: 

Select the text you want to copy. 

Click the Copy command on the Home tab. 

You can also right-click your document and 

select Copy. 

Place your insertion point where you want the text to appear. 

Click the Paste command on the Home tab. The text will appear. 

 

Grade 4: Second year:  

Activity 1: To cut and paste text: Select the text you want to copy. 



 

2018   CAPS GRADE R-5 FOR LEARNERS WITH SEVERE INTELLECTUAL DISABILITY                                                             Page 19 

Grade 4: Term 1 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Click the Cut command on the Home tab. You 

can also right-click the document and select Cut. 

 

Place your insertion point where you want the 

text to appear. 

Click the Paste command on the Home tab. The 

text will appear. 

You can also cut, copy, and 

paste by right-clicking the 

document and choosing the 

desired action from the 

drop-down menu. When you 

use this method to paste, 

you can choose from three 

options that determine how 

text will be formatted: Keep Source Formatting, Merge Formatting, 

and Keep Text Only. You can however the mouse over each icon to 

see what it will look like before clicking it. 

 

3.2.1.2 Activity 2: To drag and drop text: 

Select the text you want to copy. 

Click and drag the text to the location where you want it to appear. 

The cursor will have a rectangle under it to indicate that you are moving 

text. 
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Grade 4: Term 1 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Release the mouse button, 

and the text will appear. 

If text does not appear in 

the exact location you 

want, you can click 

the Enter key on your 

keyboard to move the text 

to a new line. 
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Grade 4: Term 1 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

 

Activity 3: Finding and replacing text: 

When you're working with longer 

documents, it can be difficult and time 

consuming to locate a specific word or 

phrase. Word can automatically search your 

document using the Find feature, and it 

even allows you to change words or 

phrases using Replace. 

To find text: 

From the Home tab, click 

the Find command. 

The navigation pane will 

appear on the left side of the 

screen. 

Type the text you want to find 

in the field at the top of the 

navigation pane. 

If the text is found in the 

document, it will be highlighted in yellow, and a preview will appear in 

the navigation pane. 

If the text appears more than once, you can click the arrows on the 

navigation pane to step through the results. You can also click 
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Grade 4: Term 1 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

the result previews on the navigation pane to jump to the location of a 

result in your document. 

 

When you close the navigation pane, the highlighting will disappear. 

3.2.1.3 To replace text: 

From the Home tab, click 

the Replace command. The Find and 

Replace dialog box will appear. 

Type the text you want to find in the Find 

what field. 

Type the text you want to replace it with in 

the Replace with field. 

Click Find Next and then Replace to replace text. You can also 

click Replace All to replace all instances within the document. 
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Grade 4: Term 1 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Client 

services and 

communi-

cation 

 

Introduction 

to office 

etiquette 

 

 

 

 

Understand dress code that is in accordance with 

a specific work place requirement. 

 

 

 

 

Grade 4: First year:  

Activity 1: Participate in a discussion about appropriate workplace attire and 

write down key words on the board.  

Activity 2: Copy and paste pictures from the internet in a text document and 

illustrate the difference between appropriate and inappropriate workplace attire.  

Activity 3: Create a check list in a text document about the appropriate dress 

code in the workplace. Evaluate the teacher according to your check list and 

giver her/him feedback.   

Grade 4: Second year:  

Activity 1: Participate in a discussion about appropriate workplace attire. List 

key words associated with appropriate workplace attire in a text document. 

Activity 2: Draw up a list illustrating dress code for your workplace.   

Activity 3: Search the internet to find different types of dress codes for e.g. 

business, casual, school and professional dress codes. Copy and paste images 

in a new document to illustrate the different types of dress code.  

7-8 Office 

practice 

 

Computer 

care 

Understand how to take care of a computer by 

cleaning the peripherals and using removable 

devices carefully and correctly.  

 

 

Grade 4: First year:  

Activity 1: Practical demonstration by teacher on how to take care of a computer 

by cleaning the hardware.  

Teacher’s note: Follow the link to the following free website and learn more 

about keeping your computer clean: 

http://www.gcflearnfree.org/computerbasics/14 

Activity 2: View videos about using removable devices carefully and correctly. 

Class discussion to follow after watching the video on what was learned.  

Activity 3: Set up a code of conduct for working on the computers / in the 
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Grade 4: Term 1 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

computer laboratory. 

Grade 4: Second year:  

Activity 1: Demonstrate, in groups, how to clean the screen and wipe the 

keyboard correctly.  

Activity 2: Show and tell the class how to use removable devices carefully and 

correctly.  

Activity 3: Set up a code of conduct for working on the computers / in the 

computer laboratory. 

Computer 

application 

 

Word 

processing 

and editing 

 

 

Understand basic operations on the computer: 

open a programme, navigate the desktop moving 

through windows, save a document, close a 

document and activate an existing document. 

 

 

Grade 4: First year:  

Activity 1: Identify, point out or name where to open and close a 

programme.  

Activity 2: Practical demonstration by teacher on how to save a 

document and create files to save documents in.  

Activity 3: Practice to open and close programmes, how to navigate 

the toolbar and how to save the document in the correct file. 

Grade 4: Second year:  

Activity 1: Practical demonstration by teacher on how to open an 

existing document.  

Activity 2: Complete a work sheet identifying the icons of where to 

open a document, close a document, minimize a document, maximise a 

document, save a document and icons showing files to save in.  

Activity 3: Open an existing document and save it under a new name.  

Client 

services and 

Understand the basic terms related to HIV and 

AIDS.  

Grade 4: First year: 

Activity 1: Participate in a discussion about HIV and AIDS. Learners share their 
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Grade 4: Term 1 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

communi-

cation 

 

Health and 

environmental 

requirements  

 

 

 

 

knowledge on the subject and view videos on the internet to gather information. 

List key words on the board. 

Activity 2: Complete the worksheet about signs and symptoms of HIV and AIDs 

by searching the internet.  

Activity 3: Complete a worksheet by naming the abbreviations concerning this 

subject and defining the key words associated with this illness.  

Grade 4: Second year: 

Activity 1: Participate in a discussion about HIV and AIDS. Learners share their 

knowledge on the subject and view videos on the internet to gather information. 

List key words on the board. 

Activity 2: Participate in a discussion about the treatment of HIV/AIDS. Search 

the term “treatment” on the internet and copy and paste images in a text 

document illustrating treatment for this illness.  

Activity 3: Learners fill in the online quiz at http://www.avert.org/quizzes/hiv-

aids-quiz-easy 

about HIV/AIDS to test their knowledge about the subject  

Teacher’s note: Follow the link to the following free website and learn more 

about HIV/AIDS:  

http://www.gcflearnfree.org/everydaylife/healthandsafety/hiv-aids-

workbook 

9 Fun 

activities 

Search the internet to find videos and play 

games.  

 

Grade 4: First and Second year: 

Open the web browser and explore the following websites: 

Activity 1: PBSKids.org 

Activity 2: www.sesamestreet.org 
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Grade 4: Term 1 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Activity 3: kidsgames.org 

 

FORMAL ASSESSMENT TASK: GRADE 4:  

Assessment is formally recorded during four (4) practical sessions with a minimum of four (4) skills reported. Learners, regardless of abilities, shall 

be assessed on the same skill. The following serves as suggestion of skills to record and report on. 

 

GRADE 4: FIRST YEAR: TERM 1  

Week 1-2:  

Identify, point out or name the tower case components and its function. 

Identify, point out or name the input devices and its functions. 

Identify, point out or name the output devices and its functions. 

Participate in a discussion about the different components on the keyboard. Write key words on the board.  

Complete a matching worksheet pairing the names of the components on the keyboard with the correct picture and paste in the workbooks.  

Participate in a discussion about what healthy personal habits are. Write down key words on the board.  

Practice to wash and dry their hands as well as role- play how to wash their hair and brush their teeth. 

Make a collage or poster depicting good hygiene and healthy habits. 

Week 3-4: 

View videos about how to move and click the mouse correctly and discuss techniques learned in groups.  

Fill in the missing words on a worksheet depicting the different clicks of the mouse.  

Practice to open and close specific programmes identified by the teacher on the computer. 

Practice using the enter key by typing short words for e.g. name and surname, then pressing the enter key.  

Practice using the space bar key by typing short words for e.g. name and surname, then pressing the space bar key. 

Participate in a discussion about the meaning of customer services and write down key words on the board.  

Discuss in groups the importance of the appearance of the office worker and the effect it has on customer services. Present your findings to the class.  
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Bring clothes from home and show and tell about the appropriate appearance of an office worker. 

Week 5-6:  

Participate in a discussion about the correct posture in front of the computer and brain storm ideas on how to place body, hands and fingers. Practice the typing 

position. 

View videos about ergonomics and discuss if it corresponds with brains storming ideas.  

Discuss using the right hand to press keys on the right side of the keyboard; left hand for keys on the left side.  

Delete text correctly. 

Select text correctly. 

Copy and paste text correctly. 

Participate in a discussion about appropriate workplace attire and write down key words on the board.  

Copy and paste pictures from the internet in a text document and illustrate the difference between appropriate and inappropriate workplace attire.  

Create a check list in a text document about the appropriate dress code in the workplace. Evaluate the teacher according to your check list and giver her/him 

feedback.   

Week 7-8:  

View videos about using removable devices carefully and correctly.  

Set up a code of conduct for working on the computers / in the computer laboratory. 

Identify, point out or name where to open and close a programme. 

Practice to open and close programmes, how to navigate the toolbar and how to save the document in the correct file. 

Participate in a discussion about HIV and AIDS. Learners share their knowledge on the subject and view videos on the internet to gather information. List key 

words on the board. 

Complete the worksheet about signs and symptoms of HIV and AIDs by searching the internet.  

Complete a worksheet by naming the abbreviations concerning this subject and defining the key words associated with this illness.  

 

GRADE 4: SECOND YEAR: TERM 1  

Week 1-2:  

Make a collage or poster that illustrates the components, input and output devices of a computer. 

Participate in a discussion of the functions of input and output devices of a computer.   
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Complete a word search worksheet about components, input and output devices of a computer and paste in the workbooks. 

Identify, point out or name the different components on the keyboard, namely the function, typing, numeric, control, windows, shift, alt, enter and cursor keys. 

Demonstrate what the function keys do by typing short words in a text document and then using the function keys. 

Make a collage or poster using pictures or words about the parts of the keyboard. 

View videos about the importance of being and looking healthy in an office environment.  

Show and tell the class about different products that are used to ensure personal hygiene.  

Complete a worksheet about good hygiene and healthy habits by listing good hygiene and healthy habits in column A and how often this is required in column B. 

Week 3-4: 

Demonstrate how to switch the computer on and off by following correct procedure. 

Complete a matching worksheet pairing the icons of the programmes with the correct name of the programme and paste in the workbooks. 

Show and tell the class about the basic keys on the keyboard and their functions.  

Identify, point out or name the entering and editing keys named by teacher for e.g. enter, backspace, delete, space bar and cursor keys.  

Practice to use the cursor keys.  

Complete a worksheet by filling in missing words on the keyboard for entering and editing and paste in the workbooks. 

Identify, name and list words associated with customer services.  

Design a poster to illustrate the appropriate appearance of the office worker and show the class.  

Bring clothes from home and show and tell about the appropriate appearance of an office worker. 

Week 5-6:  

Find pictures that show the appropriate ergonomic sitting position. Work in groups and make a collage to put on class wall. Groups’ present their collage to the 

class. 

View videos about ergonomics and discuss the basic principles of ergonomics. List key words in a text document. 

Research ergonomic guidelines on the internet and write down basic guidelines in a new document for when in front of a computer. 

Cut and paste text correctly 

Drag and drop text correctly 

Find and replace text correctly 

Participate in a discussion about appropriate workplace attire. List key words associated with appropriate workplace attire in a text document. 

Draw up a list illustrating dress code for your workplace.   
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Search the internet to find different types of dress codes for e.g. business, casual, school and professional dress codes. Copy and paste images in a new 

document to illustrate the different types of dress code. 

Week 7-8:  

Demonstrate, in groups, how to clean the screen and wipe the keyboard correctly. 

Show and tell the class how to use removable devices carefully and correctly. 

Set up a code of conduct for working on the computers / in the computer laboratory. 

Complete a work sheet identifying the icons of where to open a document, close a document, minimize a document, maximise a document, save a document and 

icons showing files to save in.  

Open an existing document and save it under a new name. 

Participate in a discussion about HIV and AIDS. Learners share their knowledge on the subject and view videos on the internet to gather information. List key 

words on the board. 

Participate in a discussion about the treatment of HIV/AIDS. Search the term “treatment” on the internet and copy and paste images in a text document illustrating 

treatment for this illness. 

Fill in the online quiz at http://www.avert.org/quizzes/hiv-aids-quiz-easy about HIV/AIDS to test their knowledge about the subject. 

 

 

 

 

3.2.2 Grade 4: 1st and 2nd year Term 2 

 

Grade 4: Term 2 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

1-2 Office practice 

 

Office 

equipment 

Review the different parts of the computer, 

e.g. screen, keyboard, mouse, system unit 

and printer. 

Grade 4: First year:  

Activity 1: Identify, point out or name the different parts of the computer and 

electronic devices. 

Activity 2: Demonstrate how to clean the screen and wipe the keyboard correctly.  
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Grade 4: Term 2 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

 

 

Review how to take care of the different 

parts of the computer.  

Review different electronic devices, e.g. 

tablets, cell phones, mp3 players, 

removable disks, CD’s and cameras. 

Activity 3: Set up a code of conduct for working on the computers / in the computer 

laboratory. 

Grade 4: Second year:  

Activity 1: Participate in a discussion about how to use removable devices carefully 

and correctly.  View videos about this topic to reinforce content.  

Activity 2: Search the internet for new electronic devices on the market and discuss 

what is new.  

Activity 3: Set up a code of conduct for working on the computers / in the computer 

laboratory. 

Computer 

application 

 

Keyboard skills 

Identify, point out or name the components 

on the keyboard relating to the home row 

alphabet keys (asdfjkl ;). 

 

 

 

Grade 4: First year:  

Activity 1: Practical demonstration by teacher showing the home row on the 

keyboard. Participate in a discussion on where the row is located and what letters 

are involved.  

Activity 2: Practical demonstration by teacher showing the correct placement of 

fingers and hands to type the home row. Learners practice to type home row letters 

with correct placement of fingers and hands.  

Activity 3: Visit http://www.dancemattypingguide.com and practice typing the 

home row. 

Grade 4: Second year:  

Activity 1: Practical demonstration by teacher showing the correct placement of 

fingers and hands to type the home row. Learners practice to type home row letters 

with correct placement of fingers and hands.  

Activity 2: Visit http://www.dancemattypingguide.com and practice typing the 

home row. 

http://www.dancemattypingguide.com/
http://www.dancemattypingguide.com/
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Grade 4: Term 2 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Activity 3: Use short words starting with letters from home row given by teacher and 

practice typing words. 

 

Suggested typing software:  

http://www.dancemattypingguide.com  for learning the keyboard(online) 

Typing tutor software(freeware) 

Typing queen software(freeware) 

Tucows(freeware)  

Client services 

and 

communication 

 

Office first aid 

 

 

Understand the basic principles of office 

safety i.e. things that are dangerous in the 

office for e.g. liquids, stairs, windows, 

carpets, stacked items, plugs, sharp edges 

of furniture etc.  

 

 

 

Grade 4: First year:  

Activity 1: Brainstorm dangerous practices in the office environment and write ideas 

down on a poster to put on class wall.   

Activity 2: Discuss what to do in case of an emergency where someone gets hurt in 

the office. Use five fingers to learn the emergency numbers 10111 and 112. 

Activity 3: Role-play phoning the emergency number after someone got hurt in the 

office.  

Grade 4: Second year:  

Activity 1: Identify and list dangerous practices in the office environment.  

Activity 2: Match words to pictures on a worksheet showing dangerous situations in 

the office.  

Activity 3: Design a poster showing the emergency numbers and put up around the 

school.  

3-4 Office practice 

 

Office 

Identify, point out or name general office 

equipment and what they are used for. 

 

Grade 4: First year:  

Activity 1: Display general office equipment in the class room. Teacher shows and 

tells learners how equipment works.  

http://www.dancemattypingguide.com/
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Grade 4: Term 2 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

equipment and 

mailing systems 

Activity 2: Complete a matching worksheet pairing the names of general office 

equipment with the correct picture and paste in the workbooks.  

Activity 3: Use scrap paper to try out different staplers, punch holes in the paper 

and cut paper with a guillotine (make sure you have safety measures in place). 

Grade 4: Second year:  

Activity 1: Put names of general office equipment in a bag and each learner draws 

one. Show and tell by learner on how that equipment works.  

Activity 2: Complete a word search worksheet about general office equipment and 

paste in the workbooks. 

Activity 3: Practical demonstration by teacher on the use of a calculator to do basic 

calculations. Learners to practice a few sums.  

Computer 

application 

 

Keyboard skills 

Identify, point out or name the components 

on the keyboard relating to the top row 

alphabet keys (qwertyuiop). 

 

 

Grade 4: First year:  

Activity 1: Practical demonstration by teacher showing the top row on the keyboard. 

Participate in a discussion on where the row is located and what letters are involved.  

Activity 2: Practical demonstration by teacher showing the correct placement of 

fingers and hands to type the top row. Learners practice to type top row letters with 

correct placement of fingers and hands.  

Activity 3: Visit http://www.dancemattypingguide.com and practice typing the top 

row. 

Grade 4: Second year:  

Activity 1: Practical demonstration by teacher showing the correct placement of 

fingers and hands to type the top row. Learners practice to type top row letters with 

correct placement of fingers and hands.  

Activity 2: Visit http://www.dancemattypingguide.com and practice typing the top 

http://www.dancemattypingguide.com/
http://www.dancemattypingguide.com/
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Grade 4: Term 2 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

row. 

Activity 3: Use short words starting with letters from top row given by teacher and 

practice typing words. 

Client services 

and 

communication 

 

Office first aid 

 

 

 Identify and or list the basic principles of 

fire safety and what to do if a fire breaks 

out in the office.  

 

Grade 4: First year:  

Activity 1: Participate in a discussion on what can cause a fire to break out and 

what action to take.  

Activity 2: Identify and list dangerous substances in an office environment. 

Activity 3: Unscramble the words about fire and safety on the worksheet provided. 

Grade 4: Second year:  

Activity 1: Role- play what action you would take if a fire breaks out in the home or 

office environment. 

Activity 2: Use the following website to learn about fire safety: 

http://www.firefacts.org/ 

Activity 3: Visit the fire brigade and learn how to use a fire distinguisher in case of 

emergency.  

5-6 Office practice 

 

Office 

equipment and 

mailing systems 

Understand general office equipment: 

staplers, punches and a guillotine.  

Grade 4: First year:  

Activity 1: Participate in a discussion about the dangers of certain office equipment 

and draw up a list of safety measures that must be adhered to at all times. 

Activity 2: Copy and paste images of general office equipment to design a pamphlet 

showcasing different types. 

Activity 3: Use scrap paper to try out different staplers, punch holes in the paper 

and cut paper with a guillotine (make sure you have safety measures in place). 

Grade 4: Second year:  

Activity 1: Identify, point out or name general office equipment displayed in the 
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Grade 4: Term 2 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

class room. Participate in a discussion on how the office equipment works.  

Activity 2: Find pictures of general office equipment in catalogues and make a 

collage to put on class wall. 

 Activity 3: View videos on the internet about different types of mailing systems 

available. Class discussion to following after watching the video on what was 

learned. 

Computer 

application 

 

Keyboard skills 

Identify, point out or name the components 

on the keyboard relating to the bottom row 

alphabet keys (zxcvbnm). 

Grade 4: First year:  

Activity 1: Practical demonstration by teacher showing the bottom row on the 

keyboard. Participate in a discussion on where the row is located and what letters 

are involved.  

Activity 2: Practical demonstration by teacher showing the correct placement of 

fingers and hands to type the bottom row. Learners practice to type bottom row 

letters with correct placement of fingers and hands.  

Activity 3: Visit http://www.dancemattypingguide.com and practice typing the 

bottom row. 

Grade 4: Second year:  

Activity 1: Practical demonstration by teacher showing the correct placement of 

fingers and hands to type the bottom row. Learners practice to type top bottom 

letters with correct placement of fingers and hands.  

Activity 2: Visit http://www.dancemattypingguide.com and practice typing the 

bottom row. 

Activity 3: Use short words starting with letters from bottom row given by teacher 

and practice typing words.  

http://www.dancemattypingguide.com/
http://www.dancemattypingguide.com/
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Grade 4: Term 2 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Client services 

and communi-

cation 

 

Office first aid 

Understand basic first aid procedures for 

nose bleeds, cuts, scratches, fainting, 

bruising and sprains.  

 

 

Grade 4: First year:  

Activity 1: Participate in a discussion about possible first aid scenarios that can 

happen in an office environment and how to treat them. List key words on the board.  

Activity 2: View videos on the internet about basic first aid procedures. Class 

discussion to follow after watching the videos on what was learned.  

Activity 3: Participate in a discussion on how to clean cuts and scratches. Look for 

pictures in a magazine of material needed to treat cuts and scratches and make a 

poster to put on class wall.  

Grade 4: Second year:  

Activity 1: Participate in a discussion on what to do if a person’s nose bleeds. Role-

play first aid procedure for when you have to stop a nose bleed.   

Activity 2: View videos on the internet about treating bruising and sprains. 

Demonstrate, in groups, how to treat bruising and sprains.  

Activity 3: View videos on the internet about what to do when a person faints and 

discuss procedures to be followed in this scenario. 

7-8 Office practice 

 

Office 

equipment and 

mailing systems 

Understand the basic operation of a 

photocopying and fax machine.   

Grade 4: First year:  

Activity 1: Participate in a discussion about the function and basic operation of 

photocopying and fax machines. Use the internet to find images of photocopying and 

fax machines and paste pictures on a worksheet.  

Activity 2: Organise with the administration office for learners to observe how the 

photocopying and fax machines work.  

Activity 3: Fill in the missing words on a worksheet illustrating a photocopying 

machine.  

Grade 4: Second year:  
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Grade 4: Term 2 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Activity 1: View videos on the internet about photocopying and fax machines and 

discuss the function and basic operation of these machines.  

Activity 2: Organise with the administration office for learners to observe how the 

photocopying and fax machines work.  

Activity 3: Show and tell the class how to use the photocopying and fax machine 

correctly using the machines in the office or a broken model in the class.  

Computer 

application 

 

Keyboard skills 

Identify, point out or name the home, 

bottom and top row on the keyboard and 

understand the correct typing position. 

Grade 4: First year:  

Activity 1: Practical demonstration by teacher showing the home, top and bottom 

row on the keyboard. Participate in a discussion on where the row is located and 

what letters are involved.  

Activity 2: Practical demonstration by teacher showing the correct placement of 

fingers and hands to type the home, top and bottom row. Learners practice to type 

home, top and bottom row letters with correct placement of fingers and hands.  

Activity 3: Visit http://www.dancemattypingguide.com and practice typing the 

home, top and bottom row. 

Grade 4: Second year:  

Activity 1: Practical demonstration by teacher showing the correct placement of 

fingers and hands to type the home, top and bottom row. Learners practice to type 

top home, top and bottom letters with correct placement of fingers and hands.  

Activity 2: Visit http://www.dancemattypingguide.com and practice typing the 

home, top and bottom row. 

Activity 3: Use short words starting with letters from home, top and bottom row 

given by teacher and practice typing words.  

http://www.dancemattypingguide.com/
http://www.dancemattypingguide.com/
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Grade 4: Term 2 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Client services 

and communi-

cation 

 

Office first aid 

 

 

Identify, point out or name items needed in 

a first aid kit:first-aid manual, sterile gauze 

pads of different sizes, adhesive tape, 

aadhesive bandages in several sizes, 

elastic bandage, a splint,  

antiseptic wipes, soap, antiseptic solution , 

sharp scissors, safety pins, thermometer, 

plastic non-latex gloves, mouthpiece for 

administering CPR and list of emergency 

phone numbers. 

 

Grade 4: First year:  

Activity 1: Brainstorm ideas of what is needed to do basic first aid with and list on a 

worksheet. 

Activity 2: Find pictures on the list in advertisements, with prices included. Cut out 

and paste on a worksheet provided and add the total of item on a calculator.  

Activity 3: Complete a matching worksheet pairing the names of first aid items with 

the correct picture and paste in the workbooks.  

Grade 4: Second year:  

Activity 1: Pack a basic first aid kit in the class. Each learner picks an item for show 

and tell. 

Activity 2: Unscramble the words about a first aid kit on the worksheet provided. 

Activity 3: View videos on the internet about administering CPR. Class discussion to 

follow after watching the videos on what was learned.  

9 Fun activities Search the internet to find videos and play 

games.  

 

Grade 4: First and Second year: 

Open the web browser and explore the following websites: 

Activity 1: Starfall.com 

Activity 2: coolmath.com 

Activity 3: http://www.educationworld.com/ 

 

 

 

FORMAL ASSESSMENT TASK: GRADE 4:  

Assessment is formally recorded during four (4) practical sessions with a minimum of four (4) skills reported. Learners, regardless of abilities, shall be assessed on 

the same skill. The following serves as suggestion of skills to record and report on. 

http://www.educationworld.com/
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GRADE 4: FIRST YEAR: TERM 2  

Week 1-2:  

Identify, point out or name the different parts of the computer and electronic devices. 

Demonstrate how to clean the screen and wipe the keyboard correctly.  

Set up a code of conduct for working on the computers / in the computer laboratory. 

Participate in a discussion on where the row is located and what letters are involved.  

Practice to type home row letters with correct placement of fingers and hands.  

Visit http://www.dancemattypingguide.com and practice typing the home row. 

Brainstorm dangerous practices in the office environment and write ideas down on a poster to put on class wall.   

Discuss what to do in case of an emergency where someone gets hurt in the office. Use five fingers to learn the emergency numbers 10111 and 112. 

Role-play phoning the emergency number after someone got hurt in the office.  

Week 3-4:  

Complete a matching worksheet pairing the names of general office equipment with the correct picture and paste in the workbooks.  

Use scrap paper to try out different staplers, punch holes in the paper and cut paper with a guillotine (make sure you have safety measures in place). 

Participate in a discussion on where the row is located and what letters are involved.  

Practice to type top row letters with correct placement of fingers and hands.  

Visit http://www.dancemattypingguide.com and practice typing the top row. 

Participate in a discussion on what can cause a fire to break out and what action to take.  

Identify and list dangerous substances in an office environment. 

Unscramble the words about fire and safety on the worksheet provided. 

Week 5-6:  

Participate in a discussion about the dangers of certain office equipment and draw up a list of safety measures that must be adhered to at all times. 

Copy and paste images of general office equipment to design a pamphlet showcasing different types. 

Use scrap paper to try out different staplers, punch holes in the paper and cut paper with a guillotine (make sure you have safety measures in place). 

Participate in a discussion on where the row is located and what letters are involved.  

Practice to type bottom row letters with correct placement of fingers and hands.  

http://www.dancemattypingguide.com/
http://www.dancemattypingguide.com/
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Visit http://www.dancemattypingguide.com and practice typing the bottom row. 

Participate in a discussion about possible first aid scenarios that can happen in an office environment and how to treat them. List key words on the board.  

View videos on the internet about basic first aid procedures.  

Participate in a discussion on how to clean cuts and scratches. Look for pictures in a magazine of material needed to treat cuts and scratches and make a poster 

to put on class wall. 

Week 7-8:  

Participate in a discussion about the function and basic operation of photocopying and fax machines. Use the internet to find images of photocopying and fax 

machines and paste pictures on a worksheet.  

Organise with the administration office for learners to observe how the photocopying and fax machines work. 

Fill in the missing words on a worksheet illustrating a photocopying machine. 

Participate in a discussion on where the row is located and what letters are involved.  

Practice to type home, top and bottom row letters with correct placement of fingers and hands.  

Visit http://www.dancemattypingguide.com and practice typing the home, top and bottom row. 

Brainstorm ideas of what is needed to do basic first aid with and list on a worksheet. 

Find pictures on the list in advertisements, with prices included. Cut out and paste on a worksheet provided and add the total of item on a calculator.  

Complete a matching worksheet pairing the names of first aid items with the correct picture and paste in the workbooks. 

 

GRADE 4: SECOND YEAR: TERM 2  

Week 1-2:  

Participate in a discussion about how to use removable devices carefully and correctly.  View videos about this topic to reinforce content.  

Search the internet for new electronic devices on the market and discuss what is new. 

Set up a code of conduct for working on the computers / in the computer laboratory. 

Practice to type home row letters with correct placement of fingers and hands.  

Visit http://www.dancemattypingguide.com and practice typing the home row. 

Use short words starting with letters from home row given by teacher and practice typing words. 

Identify and list dangerous practices in the office environment.  

Match words to pictures on a worksheet showing dangerous situations in the office.  

http://www.dancemattypingguide.com/
http://www.dancemattypingguide.com/
http://www.dancemattypingguide.com/
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Design a poster showing the emergency numbers and put up around the school. 

Week 3-4:  

Put names of general office equipment in a bag and each learner draws one. Show and tell by learner on how that equipment works.  

Complete a word search worksheet about general office equipment and paste in the workbooks. 

Practice few sums on the calculator. 

Practice to type top row letters with correct placement of fingers and hands.  

Visit http://www.dancemattypingguide.com and practice typing the top row. 

Use short words starting with letters from top row given by teacher and practice typing words. 

Role- play what action you would take if a fire breaks out in the home or office. 

Use the following website to learn about fire safety: http://www.firefacts.org/. 

Visit the fire brigade and learn how to use a fire distinguisher in case of emergency.  

Week 5-6:  

Identify, point out or name general office equipment displayed in the class room.  

Find pictures of general office equipment in catalogues and make a collage to put on class wall. 

View videos on the internet about different types of mailing systems available.  

Practice to type top bottom letters with correct placement of fingers and hands. 

Visit http://www.dancemattypingguide.com and practice typing the bottom row. 

Use short words starting with letters from bottom row given by teacher and practice typing words. 

Participate in a discussion on what to do if a person’s nose bleeds. Role-play first aid procedure for when you have to stop a nose bleed.   

View videos on the internet about treating bruising and sprains. Demonstrate, in groups, how to treat bruising and sprains. 

View videos on the internet about what to do when a person faints and discuss procedures to be followed in this scenario. 

Week 7-8:  

View videos on the internet about photocopying and fax machines and discuss the function and basic operation of these machines.  

Organise with the administration office for learners to observe how the photocopying and fax machines work. 

Show and tell the class how to use the photocopying and fax machine correctly using the machines in the office or a broken model in the class. 

Practice to type top home, top and bottom letters with correct placement of fingers and hands.  

Visit http://www.dancemattypingguide.com and practice typing the home, top and bottom row. 

http://www.dancemattypingguide.com/
http://www.dancemattypingguide.com/
http://www.dancemattypingguide.com/
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Use short words starting with letters from home, top and bottom row given by teacher and practice typing words. 

Pack a basic first aid kit in the class. Each learner picks an item for show and tell. 

Unscramble the words about a first aid kit on the worksheet provided. 

View videos on the internet about administering CPR. Class discussion to follow after watching the videos on what was learned. 
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3.2.3 Grade 4: 1st and 2nd year Term 3 

 

Grade 4: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

1-2 Office practice 

Office safety 

Understand the basic principles 

of office safety i.e. things that are 

dangerous in the office for e.g. 

loose carpets, faulty electrical 

wiring, broken windows, blocked 

fire escapes, stacked filing, 

heaters and open cupboards and 

drawers.   

Grade 4: First year:  

Activity 1: Participate in a discussion about dangers in a general office  

environment and list these on a worksheet.  

Activity 2: Find pictures on the internet that illustrate dangers in the workplace 

 and save them in a folder with your name.  

Activity 3: Match words to pictures on a worksheet to understand potential dangers in the 

office. 

Grade 4: Second year:  

Activity 1: Participate in a discussion about the importance of a fire exit. If your school has a 

fire exit emergency plan walk it with the learners and explain action  

to be taken.  

Teacher’s note: Follow the link to the following free website and learn more  

about a fire plan:  

http://www.gcflearnfree.org/everydaylife/healthandsafety/fire-plan 

Activity 2: List the dangers in an office environment on a worksheet, cut up the  

sentences and let each learner draw one from a bag. Role-play a dangerous action 

 in the office and a possible solution.  

Activity 3: Work in groups to find solutions to all the dangers that were identified during the 

brainstorm.  
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Grade 4: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Computer 

application 

 

Word processing 

and editing 

Business 

documents 

 

Understand basic operations 

with tables: insert a table, 

change or delete borders, 

shading, vertical text, different 

alignment of cells and columns, 

insert or delete columns or rows, 

merge and split cells. 

 

 

 

Grade 4: First and Second year: 

Activity 1: Practical demonstration by teacher on how to insert a table in a text document, 

change borders and shading, merge cells, insert or delete rows, insert or delete columns, 

change text direction, add a fill colour and change cell alignment. 

Activity 2: Insert a table with 30 rows and 4 columns. Practice to change the borders and 

shading, insert and delete rows and columns, change the text direction, add a fill colour, 

change the cell alignment and merge and split the cells.  

Activity 3: Open a pre-typed table by teacher and edit according to instructions.  

 Teacher’s note: Follow the link to the following free 

website and learn more about tables: 

http://www.gcflearnfree.org/office2010/word2010/21 

 

A table is a grid of cells arranged in rows and columns. Tables can be customized and 

are useful for various tasks such as presenting text information and numerical data.  

In Word, tables are useful for organizing and presenting data. You can create 

a blank table, convert text to a table, and apply a variety of styles and formats to 

existing tables. 

To insert a blank table: 

Place your insertion point in the document where you want the table to appear. 

Select the Insert tab. 
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Grade 4: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Click the Table command. 

Hover your mouse over the diagram squares to 

select the number of columns and rows in the table. 

Click your mouse, and the table appears in the 

document. 

You can now place the insertion point anywhere in 

the table to add text. 

 

To convert existing text to a table: 

Select the text you want to convert. 

Select the Insert tab. 

Click the Table command. 

Select Convert Text to Table from the menu. A 

dialog box will appear. 

Choose one of the options in the Separate text at: section. This is how Word knows 

what text to put in each column. 
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Grade 4: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Click OK. The text appears in a table. 

 

To add a row above an existing row: 

Place the insertion point in a row below the location where you want to add a row. 

 

 

Right-click the mouse. A menu appears. 

Select Insert Insert Rows Above. 

A new row appears above the insertion point. 
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Grade 4: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

 

 

 

 

 

 

You can also add rows below the insertion point. Follow the same steps, but 

select Insert Rows Below from the menu. 

 

To add a column: 

Place the insertion point in a column adjacent to the location where you want the 

new column to appear. 

Right-click the mouse. A menu will appear. 
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Grade 4: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Select Insert Insert Columns to the Left or Insert Columns to the Right. A new 

column appears. 

 

 

To delete a row or column: 

Select the row or column. 

Right-click your mouse. A menu will appear. 

Select Delete Cells. 

 

Select Delete entire row or Delete entire column, 

then click OK. 

 

 

To apply a table style: 
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Grade 4: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Click anywhere on the table. The Design tab will appear on the Ribbon. 

Select the Design tab and locate the Table Styles. 

Click the More drop-down arrow to see all of the table styles. 

 

Hover the mouse over the various styles to see a live preview. 

Select the desired style. The table style will appear in the document. 

 

 

To change table style options: 

Once you've chosen a table style, you can turn various options on or off to change the 

appearance of the table. There are six options: Header Row, Total Row, Banded 

Rows, First Column, Last Column, and Banded Columns. 

Click anywhere on the table. The Design tab will appear. 

From the Design tab, check or uncheck the desired options in the Table Style 

Options group. 
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Grade 4: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

 

Depending on which table style you're using, certain table style options may have a 

somewhat different effect. You may need to experiment to get the exact look you want. 

 

To add borders to a table: 

Select the cells you want to add a border to. 

 

From the Design tab, select the desired Line Style, Line Weight, and Pen Colour. 

 

Click the Borders drop-down arrow. 

From the drop-down menu, select the desired border type. 
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Grade 4: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

 

The border will be added to the selected cells. 

 

Modifying a table using the Layout tab 

When you select a table in Word 2010, Design and Layout tabs appear under Table 

Tools on the Ribbon. Using commands on the Layout tab, you can make a variety of 

modifications to the table. 
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Grade 4: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Click the buttons in the interactive below to learn about the different ways you can 

modify a table with the Layout tab. 

Client services 

and communi-

cation 

 

Telephone 

etiquette 

Understand basic telephone 

etiquette. 

 

Grade 4: First year:  

Activity 1: Participate in a discussion about what basic telephone etiquette is and make a 

mind map with the ideas gathered on the board.  

Activity 2: Create a check list from the ideas gathered for the mind map. Organise with the 

administration office for learners to observe how the telephone is answered and check the list 

on the worksheet.  

Activity 3: Learners choose a partner to practice answering the telephone with, using the 

correct telephone etiquette, and evaluate each other on how they did.  

Grade 4: Second year:  

Activity 1: View videos on the internet about basic telephone etiquette and discuss what you 

have learned. 

Activity 2: Create a mind map illustrating the characteristics of basic telephone etiquette.  

Activity 3: Practice, in pairs,  to answer the telephone in the following manner:  

Answer the telephone promptly by the third or fourth ring 

Always use the appropriate greeting for the time of day 

Identify, point out or name the company and introduce yourself 

Speak slowly and clearly 

Speak in a pleasant tone of voice 

Be sincere and helpful 

Teacher’s note: Follow the link to the following free website and learn more about telephone 

etiquette:  

http://www.gcflearnfree.org/jobsuccess/4.3 
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Grade 4: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

3-4 Office practice 

Office safety 

Understand the basic principles 

of office safety i.e. things that 

are dangerous in the office for 

e.g. loose carpets, faulty 

electrical wiring, broken 

windows, blocked fire escapes, 

stacked filing, heaters and open 

cupboards and drawers.   

Grade 4: First year:  

Activity 1: View videos on the internet about dangers in the office and list what you have 

seen.   

Activity 2: Choose one of the dangers from the video and tell the class how to avoid and or 

fix the danger.  

Activity 3: Complete a word search worksheet finding dangers in the office environment and 

paste in the workbook.   

Grade 4: Second year:  

Activity 1: View videos on the internet about faulty electrical wiring and discuss what you 

have learned.  

Activity 2: Make a collage using pictures and words to show dangers in the office and present 

it to the class. 

Activity 3: Design a fire escape route from your classroom to a safe area and share it with the 

class. 
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Grade 4: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Computer 

application 

 

Word processing 

and editing 

Business 

documents 

 

Understand basic operations 

with headers and footers: typing 

capital letters and using the 

header / footer function. 

 

 

 

Grade 4: First year:  

Activity 1: Practical demonstration by teacher showing learners how to type capital letters 

using the Shift key or Caps lock key. Give a paragraph to learners containing no capital 

letters. Learners edit paragraph by inserting capital letters where needed.  

Activity 2:  Practical demonstration by teacher showing learners how to insert a header in 

a word processing document. Learners practice to insert their name and surname in a 

header. 

Activity 3: Practical demonstration by teacher showing learners how to insert a footer in a 

word processing document. Learners practice to insert the name of their school and the 

date in a footer.  

Grade 4: Second year:  

Activity 1; Teacher’s note: Follow the link to the following 

free website and learn more about headers and footers: 

http://www.gcflearnfree.org/office2010/word2010/19 

You can make your document look professional and 

polished by utilizing the header and footer sections. 

The header is a section of the document that appears in the top margin, while 

the footer is a section of the document that appears in the bottom margin. Headers and 

footers generally contain information such as the page number, date, and document name. 

Headers and footers can help keep longer documents organized and make them easier to 

read. Text entered in the header or footer will appear on each page of the document. 

To insert a header or footer: 

Select the Insert tab. 

Click either 

the Header or Footer command. A drop-down menu will appear. 
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Grade 4: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

From the drop-down menu, 

select Blank to insert a blank header or 

footer, or 

choose one of the built-in options. 

The Design tab will appear on the 

Ribbon, and the header or footer will 

appear in the document. 

Type the desired information into the 

header or footer. 

 

When you're finished, click Close Header and Footer in the Design tab, or hit 

the Esc key. 

After you close the header or footer, it will still be visible, but it will be locked. To edit it 

again, just double-click anywhere on the header or footer, and it will become unlocked. 

To insert the date or time into a header or footer: 

Double-click anywhere on the header or footer to unlock it. The Design tab will appear. 

From the Design tab, click the Date & Time command. 
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Grade 4: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Select a date format in the dialog box that appears. 

 

Place a check mark in the Update Automatically box if you would like it to always reflect 

the current date. Otherwise, it will not change when the document is opened at a later date. 

Click OK. The date and time now appears in the document. 

Word can automatically label each page with a page number and place it in a header, footer, 

or side margin. You can add page numbers to an existing header or footer, or you 

can insert page numbers into a new header or footer. 

 

To add page numbers to an existing header or footer: 

Select the header or footer. The Design tab will appear. 

Place the insertion point where you want the page number 

to be. You can place it anywhere except inside a content 

control field. 
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Grade 4: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

 

From the Design tab, select the Page Number command. 

Click Current Position, then select the desired style. The page number will appear in the 

document. 

 

If you've already typed information into your header or footer, it's important to place the 

page number at the Current Position to avoid losing anything. If you select a page number 

from Top of Page or Bottom of Page, it will delete anything you've already added to the 

header or footer. 

 

To insert page numbers into a new header or footer: 

From the Insert tab, click Page Number. A drop-down menu will appear. 

Select the desired page number style, and it will appear in your document. 
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Grade 4: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

 

To hide the page number on the first page: 

In some documents, you may not want the first page to 

show the page number. You can hide the first page 

number without affecting the rest of the pages. 

Select the header or footer that contains the page 

number. 

From the Design tab, place a check mark next 

to Different First Page. The header and footer will 

disappear from the first page. If you want, you can type 

something new in the header or footer, and it will only affect the first page. 

 

If you're unable to select Different First Page, it may be because an object within the 

header or footer is selected. Click in an empty area within the header or footer to make 

sure nothing is selected. 

 

To format page numbers: 
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Grade 4: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Select the header or footer that contains the 

page number. 

From the Design tab, select the Page Number 

command. 

Click Format Page Numbers. 

 

From the 

dialog box, select the desired Number format. 

 

Next to Start at, enter the 

number you want the page 

numbers to start with. 

If you've created a page 

number in the side margin, it's still considered part of the header 

or footer. You won't be able to select the page number unless 

the header or footer is selected. 

Challenge: 

Create a new Word document. 

Create a blank header. 

Add your name in the header of a document. 

Right-align the text in the header. 

Select a built-in footer. 
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Grade 4: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Client services 

and 

communication 

 

Telephone 

etiquette 

Speak professionally to clients 

over the telephone using 

general telephone etiquette. 

Grade 4: First year:  

Activity 1: Participate in a discussion about what basic telephone etiquette is and focus on 

how to answer the telephone and speak professionally.  

Activity 2: Create a check list from the class discussion to show how to answer the telephone 

and speak professionally. 

 Activity 3: Learners choose a partner to practice answering the telephone with, using the 

correct telephone etiquette, and evaluate each other on how they did.  

Grade 4: Second year:  

Activity 1: View videos on the internet about basic telephone etiquette and discuss what not 

to when speaking on the phone.  

Activity 2: Complete a worksheet by writing 5 sentences of what not to do when answering 

the telephone.  

Activity 3: Cut up the sentences written and put in a bag. Learner draws one from bag and 

does a sketch. Learners guess what the wrong telephone etiquette is for example: 

Use the caller’s name if you know who they are 

Listen attentively and do not interrupt 

Do not use slang language 

Do not eat or drink when talking on the telephone 

Do not speak to others when talking on the phone 

Do not cover the mouthpiece with your hand 

Do not put the receiver down hard on the desk 
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Grade 4: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

5-6 Office practice 

Office safety 

Identify, point out or name 

official safety signs in the office. 

 

 

 

Grade 4: First year:  

Activity 1: Identify, point out or name safety signs that can be seen in the community, for e.g. 

in the school, in the shopping centre etc.  

Activity 2: Design your own safety sign to put in the school, for e.g. no running on the 

corridor. 

Activity 3: Complete a matching worksheet pairing the names of official safety signs with the 

correct picture and paste in the workbooks.  

Grade 4: Second year:  

Activity 1: Participate in a discussion about the importance of having safety signs in the 

office. Identify signs that should be present in specific environments, for e.g., in the woodwork 

class or on a construction site.  

Activity 2: Identify one specific work environment. Use this as the caption on your text 

document. Copy and paste the official safety signs that would be expected in this 

environment.  

Activity 3: Participate in a game to identify official safety signs. Teacher uses pictures of 

official safety signs and holds up for the class to see. Choose a learner to give answer.  
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Grade 4: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Computer 

application 

 

Word processing 

and editing 

Business 

documents 

 

Understand basic formatting 

features: bold, italics and 

underline. 

 

 

 

 

Grade 4: First year:  

Activity 1: Practical demonstration by teacher on how to use the bold function. Practice typing 

words by using the bold function in a text document.   

Activity 2:  Practical demonstration by teacher on how to use the italics function. Practice 

typing words by using the italics function in a text document.   

Activity 3: Practical demonstration by teacher on how to use the underline function. Practice 

typing words by using the underline function in a text document.   

Grade 4: Second year:  

Activity 1: Learners open a text document and type words using bold, italics and underline. 

Activity 2: Give a prepared paragraph to learners. Learners edit the document by changing 

all words using bold, italics and underline. 

Activity 3: Practice using bold, italics and underline by changing words according to 

instructions on a prepared paragraph.  

Teacher’s note: Follow the link to the following free website and learn more about how to use 

the bold, italic, and underline commands: 

http://www.gcflearnfree.org/office2010/word2010/3 

Select the text you want to modify. 

Click the Bold, Italic, or Underline command in 

the Font group on the Home tab. 
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Grade 4: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Client services 

and communi-

cation 

 

Personal finance 

 

 

Understand the difference 

between “needs” and “wants” 

concerning personal finance.  

 

 

 

 

Grade 4: First year:  

Activity 1: Participate in a discussion about having “needs” and “wants” and the difference 

between them. List ideas on the board.  

Activity 2: Design a poster by using pictures to illustrate “needs” or “wants” and present it to 

the class.  

Activity 3: Complete a worksheet about “needs” and “wants” by listing “needs” in column A 

and “wants” in column B. 

Grade 4: Second year: 

Activity 1: View videos on the internet about “needs vs. wants PowerPoint Presentations”. 

Class discussion to follow after watching the presentations on what was learned. 

Activity 2: Each learner writes down the name of a “need” and a “want”. Put all the words in a 

bag and allow each learner to draw a word. Take turns to draw a word and tell the class if the 

word is a “need” or “want” and explain why.  

Activity 3: Copy and paste pictures into a text document showing the difference between 

“needs” and “wants” and show in groups.  

7-8 Office practice 

Office safety 

Understand an emergency 

evacuation drill.  

Grade 4: First year:  

Activity 1: Participate in a discussion about an emergency evacuation drill. Brainstorm ideas 

about your responsibility during an emergency evacuation drill.  

Activity 2: Complete a worksheet with statements about emergency evacuation drills 

prepared by teacher and indicate if the statement is true or false.  

Activity 3: View videos on the internet showing examples of emergency evacuation drills and 

discuss element of the emergency evacuation plan in groups.  

Grade 4: Second year:  

Activity 1: Design an emergency evacuation plan for the classroom. (Keep in mind learners 
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Grade 4: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

who are difficult walkers or in wheelchairs and how to help them). 

Activity 2: Nominate one learner and practice his or her emergency evacuation plan.  

Activity 3: Write down 5 sentences on a worksheet about your responsibility during an 

emergency evacuation drill.  
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Grade 4: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Computer 

Application 

 

Word processing 

and editing 

Business 

documents 

 

Understand basic formatting 

features: change the font type, 

size and colour.  

 

 

 

Grade 4: First year:  

Activity 1: Practical demonstration by teacher on how to change the font type and size. 

Practice typing words by changing the font size and type.    

Activity 2: Learners open a text document and type words using different font types and 

sizes.  

Activity 3: Learners cut out an advertisement in a newspaper or magazine. Learners copy the 

text of the advertisement and edit the words by changing the font type and size of words.  

Grade 4: Second year:  

Activity 1: Practical demonstration by teacher on how to change the font type and size. 

Practice typing words by changing the font size and type.    

Activity 2: Give a prepared paragraph to learners. Learners edit the document by changing 

the font type and size of certain words according to instructions.  

Activity 3: Design a flyer about yourself using different font types and font sizes describing 

your likes, friends, extracurricular activities etc.  

Teacher’s note: Follow the link to the following free website and learn more about how to 

change the font, the colour and to highlight the text: 

http://www.gcflearnfree.org/office2010/word2010/3 .2 

Select the text you want to modify. 
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Grade 4: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Click the drop-down arrow next to the Font box on the Home tab. The Font drop-

down menu appears. 

Move the mouse pointer over the various fonts. A live preview of the font will appear 

in the document. 

Select the font you want to use. The font will change in the document. 

 

To change the font colour: 

Select the text you want to modify. 

Click the Font Colour drop-down 

arrow on the Home tab. The Font 

Colour menu appears. 

Move the mouse pointer over the 

various font colours. A live preview of 

the colour will appear in the document. 

Select the font colour you want to use. 

The font colour will change in the 

document. 

Your colour choices aren't limited to the drop-down menu that appears. Select More 

Colours at the bottom of the list to access the Colours dialog box. Choose the colour 

you want, and then click OK. 

To highlight text: 

From the Home tab, click the Text Highlight Colour drop-down arrow. 

The Highlight Colour menu appears. 
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Grade 4: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Select the desired highlight colour. 

Select the text you want to modify. It will then 

be highlighted. 

To switch back to the normal cursor, click 

the Text Highlight Colour command. 

Client services 

and communi-

cation 

 

Personal finance 

Understand personal income vs. 

expenditure concerning personal 

finance. 

 

Grade 4: First year:  

Activity 1: Participate in a discussion about income vs. expenditure and understand the 

concept.  

Activity 2: Cut out pictures and price tags of basic needs from advertisements and paste on a 

poster. Show and tell the class what you think is necessities to buy every month and estimate 

the total price.  

Activity 3: Create a table in a text document and write down all the basic needs that have to 

be purchased every month. Add the total with a calculator.  

Grade 4: Second year:  

Activity 1: View videos on the internet about income vs. expenditure and discuss what you 

have learned. Write key words on the board.  

Activity 2: Practical demonstration by teacher of a spreadsheet document. Show rows and 

columns and AutoSum.  

Activity 3: Learners practice AutoSum in a spreadsheet by listing basic needs in column A 

and the price in column B. Use AutoSum to get the total.  

Teacher’s note: Follow the link to the following free website and learn more about 

spreadsheets: 
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Grade 4: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

http://www.gcflearnfree.org/office2010/excel2010 

Excel is a spreadsheet program that allows you to store, organize, and analyze information.  

The Excel interface: 

 

 

You will need to know the basic ways you can work with cells and cell content in Excel to 

be able to use it to calculate, analyze, and organize data. In this lesson, you will learn 

how to select cells, insert content, and delete cells and cell content. You will also 

learn how to cut, copy, and paste cells; drag and 

drop cells; and fill cells using the fill handle. 

Cells are the basic building blocks of a worksheet. 

They can contain a variety of content such 

as text, formatting attributes, formulas, 

and functions. To work with cells, you'll need to know 

how to select them, insert content, and delete 

cells and cell content. 

The cell: 

Each rectangle in a worksheet is called a cell. A cell is the intersection of a row and 

a column. 
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Grade 4: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

 

Each cell has a name, or a cell address based on 

which column and row it intersects. The cell 

address of a selected cell appears in the name box. 

Here, you can see that C5 is selected. 

 

You can also select multiple cells at the same time. A 

group of cells is known as a cell range. Rather than a 

single cell address, you will refer to a cell range using 

the cell addresses of the first and last cells in the cell 

range, separated by a colon. For example, a cell range 

that included cells A1, A2, A3, A4, and A5 would be written as A1:A5. 

If the columns in your spreadsheet are labelled with numbers instead of letters, you'll 

need to change the default reference style for Excel.  

 

To select a cell: 
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Grade 4: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Click a cell to select it. When a cell is selected, you will notice that the borders of 

the cell appear bold  and the column heading and row heading of the 

cell are highlighted. 

Release your mouse. The cell will stay selected until you click another cell in the 

worksheet. 

You can also navigate your worksheet and select a cell by using the arrow keys on 

your keyboard. 

 

To select multiple cells: 

Click and drag your mouse until all of the adjoining 

cells you want are highlighted. 

Release your mouse. The cells will stay selected until 

you click another cell in the worksheet. 

Cell content: 

Each cell can contain its own text, formatting, comments, formulas, and functions. 

 Text 

Cells can contain letters, numbers, and dates. 

 Formatting attributes 

Cells can contain formatting attributes that change the way letters, numbers, and 

dates are displayed. For example, dates can be formatted as MM/DD/YYYY or 

M/D/YYYY. 

 Comments 

Cells can contain comments from multiple reviewers. 
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Grade 4: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

 Formulas and functions 

Cells can contain formulas and functions that calculate cell values. For 

example, SUM (cell 1, cell 2...) is a formula that can add the values in multiple cells. 

To insert content: 

Click a cell to select it. 

Enter content into the selected cell using your 

keyboard. The content appears in the cell and 

in the formula bar. You can also enter or edit 

cell content from the formula bar. 

 

 

To delete content within cells: 

Select the cells containing content you want to 

delete. 

Click the Clear command on the Ribbon. 

A dialog box will appear. 

Select Clear Contents. 

You can also use your 

keyboard's Backspace key to delete content from a single cell or the Delete key to 

delete content from multiple cells. 

 

To delete cells: 

Select the cells you want to delete. 

Choose the Delete command from the Ribbon. 
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Grade 4: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

There's an important difference between deleting the 

content of a cell and deleting the cell itself. If you 

delete the cell, by default the cells underneath it will 

shift up and replace the deleted cell. 

 

To copy and paste cell content: 

Select the cells you want to copy. 

Click the Copy command. The border of the 

selected cells will change appearance. 

Select the cell or cells where you want to 

paste the content. 

Click the Paste command. The copied 

content will be entered into the highlighted 

cells. 

 

 

To cut and paste cell content: 

Select the cells you want to cut. 

Click the Cut command. The border of the selected cells will change appearance. 
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Grade 4: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Select the cells where you want to paste the content. 

Click the Paste command. The cut content will be removed from the original cells 

and entered into the highlighted cells. 

 

 

To access formatting commands by right-clicking: 

Select the cells you want to format. 

Right-click the selected cells. 

A dialog box will appear where 

you can easily access many 

commands on the Ribbon. 

 

To drag and drop cells: 

Select the cells you want to move. Position 

your mouse on one of the outside edges of 
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Grade 4: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

the selected cells. The mouse changes from a white cross  to a black cross 

with 4 arrows. 

Click and drag the cells to the new location. 

Release your mouse, and the cells will be dropped there. 

 

To use the fill handle to fill cells: 

Select the cell or cells containing the 

content you want to use. You can fill cell 

content either vertically or horizontally. 

Position your mouse over the fill 

handle so the white cross  becomes 

a black cross . 

 

Click and drag the fill handle until all of the cells you want to fill are highlighted. 

Release the mouse, and your cells will be filled. 
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Grade 4: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Using AutoSum to select common functions: 

The AutoSum command allows you to 

automatically return the results for a range of 

cells for common functions like SUM and 

AVERAGE. 

Select the cell where the answer will appear 

(E24, for example). 

Click the Home tab. 

In the Editing group, click the AutoSum drop-down arrow and select the function 

you want (Average, for example). 

 

A formula will appear in E24, the 

selected cell. If logically placed, 

AutoSum will select your cells for you. 

Otherwise, you will need to click the 

cells to choose the argument you want. 

Press Enter and the result will appear. 

 

The AutoSum command can also be accessed from the Formulas tab. 

9 Fun activities Search the internet to find videos 

and play games.  

 

Grade 4: First and Second year: 

Open the web browser and explore the following websites: 

Activity 1: MakeMeGenius.com 

Activity 2: timeforkids.com 

Activity 3: www.girlsgames.com ,www.hotwheels.com 
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 FORMAL ASSESSMENT TASK: GRADE 4:  

Assessment is formally recorded during four (4) practical sessions with a minimum of four (4) skills reported. Learners, regardless of abilities, shall be assessed on 

the same skill. The following serves as suggestion of skills to record and report on. 

 

GRADE 4: FIRST YEAR: TERM 3  

Week 1-2:  

Participate in a discussion about dangers in a general office environment and list these on a worksheet.  

Find pictures on the internet that illustrate dangers in the workplace and save them in a folder with your name. 

Match words to pictures on a worksheet to Understand potential dangers in the office. 

Insert a table with 30 rows and 4 columns. Practice to change the borders and shading, insert and delete rows and columns, change the text direction, add a fill 

colour, change the cell alignment and merge and split the cells.  

Open a pre-typed table by teacher and edit according to instructions.  

Participate in a discussion about what basic telephone etiquette is and make a mind map with the ideas gathered on the board.  

Create a check list from the ideas gathered for the mind map. Organise with the administration office for learners to observe how the telephone is answered and 

check the list on the worksheet. 

Choose a partner to practice answering the telephone with, using the correct telephone etiquette, and evaluate each other on how they did.  

Week 3-4:  

View videos on the internet about dangers in the office and list what you have seen.   

Choose one of the dangers from the video and tell the class how to avoid and or fix the danger. 

Complete a word search worksheet finding dangers in the office environment and paste in the workbook.   

Edit a paragraph by inserting capital letters. 

Practice to insert name and surname in a header. 

Practice to insert the name of the school and the date in a footer.  

Participate in a discussion about what basic telephone etiquette is and focus on how to answer the telephone and speak professionally.  

Create a check list from the class discussion to show how to answer the telephone and speak professionally. 

Choose a partner to practice answering the telephone with, using the correct telephone etiquette, and evaluate each other on how they did.  
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Week 5-6: 

Identify, point out or name safety signs that can be seen in the community, for e.g. in the school, in the shopping centre etc. 

Design your own safety sign to put in the school, for e.g. no running on the corridor. 

Complete a matching worksheet pairing the names of official safety signs with the correct picture and paste in the workbooks.  

Practice typing words by using the bold function in a text document.   

Practice typing words by using the italics function in a text document.   

Practice typing words by using the underline function in a text document. 

Participate in a discussion about having “needs” and “wants” and the difference between them. List ideas on the board.  

Design a poster by using pictures to illustrate “needs” or “wants” and present it to the class.  

Complete a worksheet about “needs” and “wants” by listing “needs” in column A and “wants” in column B.  

Week 7-8:  

Participate in a discussion about an emergency evacuation drill. Brainstorm ideas about your responsibility during an emergency evacuation drill. 

Complete a worksheet with statements about emergency evacuation drills prepared by teacher and indicate if the statement is true or false.  

View videos on the internet showing examples of emergency evacuation drills and discuss element of the emergency evacuation plan in groups. 

Practice typing words by changing the font size and type.    

Open a text document and type words using different font types and sizes.  

Cut out an advertisement in a newspaper or magazine.  

Copy the text of the advertisement and edit the words by changing the font type and size of words.  

Participate in a discussion about income vs. expenditure and Understand the concept.  

Cut out pictures and price tags of basic needs from advertisements and paste on a poster. Show and tell the class what you think is necessities to buy every 

month and estimate the total price.  

Create a table in a text document and write down all the basic needs that have to be purchased every month. Add the total with a calculator.  

 

GRADE 4: SECOND YEAR: TERM 3  

Week 1-2:  

Participate in a discussion about the importance of a fire exit. If your school has a fire exit emergency plan walk it with the learners and explain action to be taken.  

List the dangers in an office environment on a worksheet, cut up the sentences and let each learner draw one from a bag.  
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Role-play a dangerous action in the office and a possible solution. 

Work in groups to find solutions to all the dangers that were identified during the brainstorm. 

Insert a table with 30 rows and 4 columns. Practice to change the borders and shading, insert and delete rows and columns, change the text direction, add a fill 

colour, change the cell alignment and merge and split the cells.  

Open a pre-typed table by teacher and edit according to instructions.  

View videos on the internet about basic telephone etiquette and discuss what you have learned. 

Create a mind map illustrating the characteristics of basic telephone etiquette.  

Practice, in pairs, to answer the telephone correctly. 

Week 3-4:  

View videos on the internet about faulty electrical wiring and discuss what you have learned.  

Make a collage using pictures and words to show dangers in the office and present it to the class. 

Design a fire escape route from your classroom to a safe area and share it with the class. 

Follow the link to the following free website and learn more about headers and footers: http://www.gcflearnfree.org/office2010/word2010/19. 

View videos on the internet about basic telephone etiquette and discuss what not to when speaking on the phone.  

Complete a worksheet by writing 5 sentences of what not to do when answering the telephone. 

Cut up the sentences written and put in a bag. Learner draws one from bag and does a sketch. Learners guess what the wrong telephone etiquette is. 

Week 5-6:  

Participate in a discussion about the importance of having safety signs in the office. Identify signs that should be present in specific environments, for e.g., in the 

woodwork class or on a construction site.  

Identify one specific work environment. Use this as the caption on your text document. Copy and paste the official safety signs that would be expected in this 

environment.  

Participate in a game to identify official safety signs. Teacher uses pictures of official safety signs and holds up for the class to see. Choose a learner to give the 

answer. 

Open a text document and type words using bold, italics and underline. 

Edit a document by changing all words using bold, italics and underline. 

Practice using bold, italics and underline by changing words according to instructions on a prepared paragraph.  

View videos on the internet about “needs vs. wants PowerPoint Presentations”.  
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Each learner writes down the name of a “need” and a “want”. Put all the words in a bag and allow each learner to draw a word. Take turns to draw a word and tell 

the class if the word is a “need” or “want” and explain why.  

Copy and paste pictures into a text document showing the difference between “needs” and “wants” and show in groups. 

 

Week 7-8:  

Design an emergency evacuation plan for the classroom. (Keep in mind learners who are difficult walkers or in wheelchairs and how to help them). 

Nominate one learner and practice his or her emergency evacuation plan.  

Write down 5 sentences on a worksheet about your responsibility during an emergency evacuation drill. 

Practical demonstration by teacher on how to change the font type and size. Practice typing words by changing the font size and type.    

Edit a document by changing the font type and size of certain words according to instructions.  

Design a flyer about yourself using different font types and font sizes describing your likes, friends, extracurricular activities etc.  

View videos on the internet about income vs. expenditure and discuss what you have learned. Write key words on the board.  

Practice AutoSum in a spreadsheet by listing basic needs in column A and the price in column B. Use AutoSum to get the total.  
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3.2.4 Grade 4: 1st and 2nd year Term 4 

 

Grade 4: Term 4 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

1-2 Office practice 

 

Reception area 

Understand the requirements for a 

successful reception area:  

verbal communication 

non-verbal communication 

 

 

 

Teacher’s note: Game activities taken from the following link: 

http://www.sdcda.org/office/girlsonlytoolkit/toolkit/got-05- 

http://healthfitness.ideafit.com/fitness-library/tools-for-teaching-effective-

communicationcommunication.pdf 

Grade 4: First year:  

Activity 1: Participate in a game “Telephone”. Have learners sit in a circle. Ask one 

learner to think of a phrase or sentence. Direct them to whisper it in the ear of the 

person sitting next to them. Each learner whispers what they think they heard to the 

next learner next to them. The last learner says the phrase or sentence out loud. Repeat 

the exercise a few times. Ask the first learner if that was their phrase. Did anything 

change? Did the message get lost or changed in translation? This is an example of 

verbal communication. List key words on the board about verbal communication.    

Activity 2: Participate in the game “Charades.” Have learners get up one at a time to 

act out a phrase or sentence without using any words or sounds while the others guess 

the phrase or sentence. Ask learners to explain what they did to communicate their 

message when they were unable to use words (facial expressions, body language, 

gestures). Were others able to guess the phrase or sentence? Was the message 

delivered effectively? This is an example of non-verbal communication. Explain that we 

all communicate all day long, whether or not we are using words. Explain that others 

pick up messages from our facial expressions, body language, gestures, and general 

demeanour.  

Activity 3: Design a poster in a text document using pictures and words to illustrate 
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Grade 4: Term 4 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

verbal and non-verbal communication. Present your poster to the class.  

Grade 4: Second year:  

Activity 1: This game demonstrates the necessity of good listening skills as a crucial 

component of effective communication and illustrates how working with a team involves 

listening and leading. Pair all the learners in the class. Have the partners tell one 

another their birthdays; the team member whose birthday falls earlier in the year will be 

the “coach” and the other the “learner.” While everyone is comparing birthdays, scatter 

various objects, such as books or shoes, throughout the room. Next, position your 

teams in different areas throughout the room. Have the learners don blindfolds, and tell 

the coaches to direct their learners to pick up as many of the scattered items as they 

can through verbal cuing only. Limit the time to 5 minutes, and reward the winning team 

that gathers the most objects before the time runs out. Then, switch coaches and 

learners, and move the teams to different areas in the room while you scatter the 

objects again. It will be interesting to see who the best coaches are. Discuss why in 

daily interactions if people are “half-listening” to each other or their customers they 

might miss the bigger picture. Write down key words explaining how to be a good 

listener.  

Activity 2: View PowerPoint Presentations on the internet about verbal and non-verbal 

communication by using the following as key words: verbal and nonverbal 

communication ppt. Open a text document and choose either verbal or non-verbal 

communication as a heading. Illustrate the form of communication by using pictures 

and key words.  

Activity 3: Design a diagram by using SmartArt and use the key words from activity 2 

to type in the diagram. Present your diagram to the class.  
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Teacher’s note: Follow the link to the following free website and learn more about 

SmartArt graphics: http://www.gcflearnfree.org/office2010/word2010/22 

Word has a variety of SmartArt graphics you can use to illustrate and organize 

many different types of ideas. To get the most out of SmartArt, you'll need to know 

how to insert a SmartArt graphic, modify the colour and effects, and change 

the organization of the graphic. 

 

To insert a SmartArt illustration: 

Place the insertion point in the document 

where you want the graphic to appear. 

Select the Insert tab. 

Select the SmartArt command in the 

Illustrations group. A dialog box appears. 

 

Select a category to the left of the dialog 

box, and review the SmartArt graphics that 

appear in the center. 

Select the desired SmartArt graphic, then click OK. 

 

To see more details about a graphic, click any image and a larger preview of the 

graphic with additional text details will appear on the right side of the dialog box. 

 

To add text to a SmartArt graphic: 

Select the graphic. A border will appear around it with an arrow on the left side. 

Click the arrow on the left side of the graphic to open the task pane. 
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Enter text next to each bullet in the task pane. The 

information will appear in the graphic and will resize 

to fit inside of the shape. 

 

 

To add a new shape, press Enter. A new bullet will appear in the task pane, and a 

new shape will appear in the graphic. 

You can also add text by clicking the desired shape and typing your text. This works 

well if you only need to add text to a few shapes. However, for more complex 

SmartArt graphics working in the task pane is often faster. 

You can change the layout of a SmartArt graphic even after you've added text. 

However, if the new layout is different from the old one, some of your text may not 

show up. Experiment with different layouts to see how they display your text 

differently. 

Computer 

Application 

 

Word 

processing and 

editing 

Understand basic formatting features: 

change alignment (left, center, right, and 

justify) and the line spacing of the text.  

Teacher’s note: Activities and screenshots taken from the free website:  

http://www.gcflearnfree.org/office2010/word2010/3.3 

http://www.gcflearnfree.org/word2010/9.2 

Grade 4: First year: 

Activity 1: To change text alignment: 

Select the text you want to modify. 
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documents 

 

 

 

 

Select one of the four alignment options from the Paragraph group on 

the Home tab. 

-Align Text Left: Aligns all selected text to the left margin 

-Center: Aligns text an equal distance from the left and right margins 

-Align Text Right: Aligns all selected text to the right margin 

-Justify: Aligns text equally on both sides and lines up equally to the right and left 

margins; used by many newspapers and magazines 

Activity 2: Learners change the alignment to left and then type their name. Press 

enter and change the alignment to center, and type your name. Press enter, 

change the alignment to right and type your name. Press enter, change the 

alignment to justify and type your name. Continue until page is full. Repeat activity 

using other words.  

Activity 3:  Learners type 16 spelling words 

and change the alignment of each word to 

either left, middle, right or full. 

Grade 4: Second year:  

Activity 1: Adjusting the line spacing will 

affect how easily your document can be 

read. You can increase spacing to improve 

readability, or reduce it to fit more text on the page. Line spacing can either be 

measured in lines or points. For example, when text is double spaced, the line 

spacing is two lines high. On the other hand, you might set 12-point text with 

something like 15-point spacing, which gives enough height for the text plus a little 

extra space. You can reduce the line spacing to fit more lines on the page, or you 
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can increase it to improve readability. 

 

To format line spacing: 

Select the text you want to format. 

Click the Line and Paragraph Spacing command in the Paragraph group 

on the Home tab. 

Select the desired spacing option from 

the drop-down menu. 

From the drop-down menu, you can 

also select Line Spacing Options to 

open the Paragraph dialog box. From 

here, you can adjust the line spacing 

with even more precision. 

 

If you select At least or Exactly in the Paragraph dialog box, the line 

spacing will be measured in points. Otherwise, it will be measured in lines. 

Activity 2: To change paragraph spacing:  

Just as you can format spacing between lines in your document, you can 

choose spacing options between each paragraph. Typically, extra spaces 

are added between paragraphs, headings, or subheadings. Extra spacing 

between paragraphs can make a document easier to read. 

 

To format paragraph spacing: 

Click the Line and Paragraph Spacing command on the Home tab. 
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Select Add Space Before 

Paragraph or Remove Space After 

Paragraph from the drop-down menu. 

 

 

From 

the 

drop-

down 

menu, you can also select Line 

Spacing Options to open the 

Paragraph dialog box. From here, 

you can control exactly how much 

space there is before and after the paragraph. 

 

You can use Word's convenient Set as Default feature to save all of 

the formatting changes you've made and automatically apply them to new 

documents.  

Activity 3: Open an existing Word document: 

Change the line spacing of a paragraph of text. 

Change the paragraph spacing between body text and a heading. 

If you are using the example, change the line and paragraph spacing so 

the entire resume fits on one page. 
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 Client services 

and 

communication 

 

Work ethics 

 

Show an understanding about the need 

for ethics in the workplace.  

 

 

 

Grade 4: First year:  

Activity 1: Participate in a discussion about ethics in the workplace. Brainstorm ideas 

and write key words on the board. View videos on the internet about ethics in the 

workplace and add key words to the board. 

Activity 2: Copy and paste pictures from the internet into a text document illustrating 

ethics in the workplace. Present your document to the class.  

Activity 3:  Design a diagram by using SmartArt and use the ethics identified in 

activity 1 to type in the diagram. Present your diagram to a friend.  

Grade 4: Second year:  

Activity 1: Participate in a discussion about ethics in the workplace. Brainstorm ideas 

and write key words on the board. View videos on the internet about ethics in the 

workplace and add key words to the board. 

Activity 2: Complete a worksheet by stating if the given statements about ethics in 

the workplace are true or false. Use the internet to search for answers if unsure. 

Change the font type and size of all the sentences when activity is completed.  

Activity 3: Design a diagram by using SmartArt and use the ethics identified in 

activity 1 to type in the diagram. Present your diagram to a friend.  

3-4 Office practice 

Reception area 

Understand the requirements for a 

successful reception area: characteristics 

of the office worker.  

Grade 4: First and Second year:  

Activity 1: Brainstorm, in groups, ideas about the characteristics of the office worker. 

Create a mind map and present ideas to the class.  

Activity 2: Search the internet for examples of PowerPoint Presentations about office 

etiquette or workplace manners etc. Visit http://www.slideshare.net/ as a starting 

point. List key words from presentations viewed describing characteristics of the 

office worker in a text document.  
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Activity 3: Practical demonstration by teacher on how to use Microsoft PowerPoint. 

Navigate the toolbar. Open a new PowerPoint Presentation and add new slides with 

titles listing characteristics of the office worker. Add a picture to the slide.  

Teacher’s note: Follow the link to the following free website and learn more about 

PowerPoint basics: http://www.gcflearnfree.org/office2010/powerpoint2010 

PowerPoint 2010 is a presentation software that allows you to create dynamic 

slide presentations that can include animation, 

narration, images, and videos  

Navigating PowerPoint to create a slide 

presentation:  

PowerPoint uses slides to build a presentation. 

To create an engaging presentation, PowerPoint allows you to add text, bulleted 

lists, images, charts, and video to your slides. You can add as many slides as 

you want to a presentation, and at any time you can view or play back your 

presentation by selecting one of the slide show play options. 

Creating and opening presentations:  

PowerPoint files are called presentations. When you start a new project in 

PowerPoint, you'll need to create a new presentation. You'll also need to know 

how to open an existing presentation. 

 

To create a new blank presentation: 

Click the File tab. This takes you to Backstage view. 

Select New. 
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Select Blank presentation under Available 

Templates and Themes. It will be 

highlighted by default. 

Click Create. A new blank presentation 

appears in the PowerPoint window. 

To save time, you can create your 

presentation from an Office.com template, 

which you can also select under Available 

Templates and Themes. 

 

To open an existing presentation: 

Click the File tab. This takes you 

to Backstage view. 

Select Open. The Open dialog box 

appears. 

 

Select your desired presentation, and 

then click Open. 

If you have opened the existing 

presentation recently, it may be easier to choose Recent from the File tab 

instead of Open to search for your presentation. 
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PowerPoint slides:  

When you create a PowerPoint Presentation, it is 

made up of a series of slides. The slides contain 

the information you want to communicate with 

your audience. This information can include text, 

pictures, charts, video, and sound.  

Before you begin adding information to 

slides, you'll need to know the basics of 

working with slides.  

 

 

To insert a new slide: 

From the Home tab, click the bottom half of the New Slide command to 

open the menu of slide layout options. 

 

Select the slide you want to insert. 
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A new slide will be added your presentation. 

To instantly add a slide that uses the same layout as the one you have 

selected, click the top half of the New Slide command. 

 

To delete a slide: 

Select the slide you want to delete. 

Press the Delete or Backspace key on your keyboard. 

 

To move a slide: 

Select the slide you want to move. 

Click, hold, and drag your mouse to a new location. A 

horizontal insertion point will mark the location. 

Release the mouse button. The slide will appear in the 

new location. 

Managing slides and presentations:  
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As you add slides to your presentation, PowerPoint offers a variety of views 

and tools to help you organize and prepare your slide show. 

About slide views: 

It's important to be able to access the 

different slide views and use them for 

various tasks. The slide view 

commands are located on the 

bottom-right of the PowerPoint 

window in Normal view. 

 

Normal view: This is the default view where you create and edit your slides. You 

can also move slides in the Slides tab in the pane on the left. 

 

Slide Sorter view: In this view, miniature slides are arranged on the screen. You 

can drag and drop slides to easily reorder them and to see more slides at one 

time. This is a good view to use to confirm that you have all the needed slides 

and that none have been deleted. 
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Reading view: This view fills most of the computer screen with a preview of your 

presentation. Unlike Slide Show view, it includes easily accessible buttons for 

navigation, located at the bottom-right. 

 

Slide Show view: This view completely fills the 

computer screen and is what the audience will 

see when they view the presentation. Slide 

Show view has an additional menu that appears when you hover over it, allowing 

you to navigate slides and access other features you can use during a 

presentation. 

 

Use the keys on your keyboard—

including the arrow keys, Page Up and 

Page Down keys, spacebar, and Enter 

key—to move through the slides in Slide 

Show view. Press the Esc key to end 

the slide show. 
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Adding images to your presentations makes them more interesting and 

engaging. Pictures, clip art, and screenshots can be inserted into PowerPoint to 

help you effectively communicate your ideas to your audience.  

Working with images:  

Adding clip art and pictures to your presentation can be a great way 

to illustrate important information or add decorative accents to existing text. 

You can insert images from your computer, search Microsoft's large selection of 

clip art to find the image you need, or add a screenshot of your own. Once an 

image has been inserted, you can resize and move it to the location you want. 

 

To insert an image from a file: 

Select the Insert tab. 

Click the Picture command in 

the Images group. The Insert Picture dialog 

box appears. 

Select the desired image file, and then 

click Insert. 

 

The picture will appear in your slide. 

 

 

 

 

 

 



 

2018   CAPS GRADE R-5 FOR LEARNERS WITH SEVERE INTELLECTUAL DISABILITY                                                             Page 95 

Grade 4: Term 4 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

 

You can also select the Insert Picture 

from File command in 

a placeholder to insert images. 

 

 

To locate clip art: 

Select the Insert tab. 

Click the Clip Art command in 

the Images group. 

The clip art options appear in the task pane to 

the right of the document. 

Enter keywords in the Search for: field that are 

related to the image you want to insert. 

Click the drop-down arrow in the Results should be: field. 

Deselect any types of media you do not want to see. 
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If you want to also search for clip art on Office.com, place a check mark next 

to Include Office.com content. Otherwise, it will just search for clip art on 

your computer. 

Click Go. 

 

To insert clip art: 

Review the results from a clip art search in the Clip Art pane. 

Select the desired image. 

 

The clip art will appear in your slide. 
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You can 

also select 

the Insert 

Clip Art 

from 

File command in 

a placeholder to insert clip art. 

 

 

To resize an image:  

Click the image. 

Position your mouse over any one of the corner sizing handles. The cursor 

will become a pair of directional arrows . 

Click, hold, and drag your mouse until the image is the desired size. 

Release the mouse. The image will be resized. 

The side sizing handles change the image's size but do not keep the same 

proportions. If you want to keep the image's proportions, always use the 

corner handles. 
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To move an image: 

Click the image. The cursor will turn into a cross with arrows . 

While holding down the mouse button, drag the 

image to the desired location. 

 

Release the mouse button. The box will be moved. 

To rotate the image, click and drag on the green 

circle located at the top of the image. 

Computer 

Application 

 

Word 

processing and 

editing 

Business 

documents 

 

Understand special characters on the 

computer: type special characters, 

symbols and punctuation marks available 

on the keyboard (!@#$%^&*?<>.,) 

 

 

Grade 4: First year:  

Activity 1: Practical demonstration by teacher on how to type other characters, 

symbols and punctuation marks by using the Shift key and the Insert symbol function. 

Learners identify and name the characters. 

Activity 2: Cut out pictures of special characters, symbols and punctuation marks 

and design a collage. Show and tell the class.  

Activity 3: Give a prepared paragraph to learners consisting of 20 sentences.  

Learners edit the paragraph by inserting punctuation marks, in the colour red, where 

necessary.  

Grade 4: Second year: 

Activity 1: Complete a worksheet by matching the given symbol in column A with the 

same symbol in column B. Ensure that Column A is in a specific colour to see if 

learners copy and paste instead of inserting the symbol independently.  

Activity 2: Insert a table with 10 rows and 10 columns. Insert your own choice of 
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special characters, symbols and punctuation marks in the blocks.  

Activity 3: Give a prepared paragraph to learners consisting of 20 sentences.  

Learners edit the paragraph by inserting punctuation marks, in the colour red, where 

necessary.  

Client services 

and 

communication 

 

Rights and 

responsibilities 

in the workplace 

 

 

Understand the basic rights and 

responsibilities of the office worker.  

 

Grade 4: First year:  

Activity 1: Participate in a discussion about the basic rights and responsibilities of the 

office worker. Write key words on the board.  

Activity 2: Give the learners an example of an employment contract. Read together 

and discuss the basic rights and responsibilities of the office worker. Create a 

PowerPoint Presentation by only inserting title slides and a picture illustrating the 

topic of the contract.  

Activity 3: Complete a worksheet by stating if the given statements about the basic 

rights and responsibilities of the office worker are true or false. Use the internet to 

search for answers if unsure. Change the font type and size of all the sentences when 

activity is completed.  

Grade 4: Second year:  

Activity 1:  Participate in a discussion about the basic rights and responsibilities of 

the office worker. Insert a table in a text document and type key words of the 

discussion. 

Activity 2: Give the learners an example of an employment contract. Read together 

and discuss the basic rights and responsibilities of the office worker. Create a 

PowerPoint Presentation by only inserting title slides and a picture illustrating the 

topic of the contract.  

Activity 3: Create a PowerPoint Presentation about the rights and responsibilities of 
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the office worker. Insert a title slide and a sentence to illustrate the right or the 

responsibility of the office worker. Present it to the class. 

5-6 Office practice 

Reception area 

Understand the requirements for a 

successful reception area: effective 

communication. 

 

 

 

 

 

Grade 4: First year:  

Activity 1: Participate in a discussion about the importance of using a pleasant tone 

of voice when working in the reception area. Practice this skill by using role-play in 

pairs.  

Activity 2: Unscramble the words about effective communication on the worksheet 

provided. 

Activity 3: Participate in a discussion about the importance of effective 

communication and what the basic principles are. Design a poster using words and 

pictures illustrating effective communication.  

Grade 4: Second year:  

Activity 1: Participate in a discussion about how to be helpful to customers and what 

it means to be tactful. View videos on the internet on the subject. Use role-play to 

illustrate receiving customers by being friendly and tactful in difficult situations.   

Activity 2: Participate in a discussion about the different ways in which we 

communicate. Name and list ways in which to communicate effectively when writing, 

reading, talking and listening. 

Activity 3: Participate in a discussion about the importance of effective 

communication and what the basic principles are. Open a new PowerPoint 

Presentation and add new slides with titles listing principles of effective 

communication.  Add a picture to each slide.  

Teacher’s note: Follow the link to the following free website and learn more about 
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workplace communication:  

http://www.gcflearnfree.org/jobsuccess/6 

Computer 

application 

 

Word 

processing and 

editing 

Business 

documents 

 

Demonstrate the basic page layout 

features: to change the A4 orientation to 

landscape or portrait, change the paper 

size and page margins.  

 

 

 

 

 

 

Grade 4: First year:  

Teacher’s note: Activities and screenshots taken from the free website: 

http://www.gcflearnfree.org/office2010/word2010/15 

Activity 1: Page layout and formatting:  

Word offers a variety of page layout and formatting options that affect how content 

appears on the page. You can customize the page orientation, paper size, 

and page margins depending on how you want your document to appear. 

 

To change page orientation: 

Select the Page Layout tab. 

Click the Orientation command in the Page 

Setup group. 

Click either Portrait or Landscape to change the 

page orientation. 

Landscape format means the page is 

oriented horizontally, while portrait format means it is oriented vertically. 

To change page size: 

Select the Page Layout tab. 

Click the Size command, and a drop-down menu will appear. The cur page 

size is highlighted. 
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Click the size option you 

want. The page size of the 

document changes. 

Grade 4: Second year:  

Activity 1: To format page margins: 

Select the Page Layout tab. 

Click the Margins command. A menu of options appears. Normal is 

selected by default. 

Click the predefined margin size you want. 

 

To use custom margins: 

From the Page Layout tab, click Margins. 

Select Custom Margins. This will take you 

to the Page Setup dialog box. 

Adjust the margin sizes for each side of 

the page, then click OK. 

 

You can use Word's convenient Set as 

Default feature to save all of 

the formatting changes you've made and automatically apply them to new 
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documents.  

The Page Setup dialog box: 

Click the Page Layout tab. 

Click the small arrow in the bottom-right corner of the Page Setup group. 

The Page 

Setup dialog box will appear. 

 

Challenge: 

Change the page orientation. 

Change the paper size. 

Change the margins to narrow. 

Adjust the margins using custom margins. 

Client services 

and 

communication  

 

Customer 

services 

Understand the types of customers one 

can expect to come across in the work 

environment. 

 

Grade 4: First year:  

Activity 1: Participate in a discussion about types of customers in the work 

environment. List ideas on a mind map.  

Activity 2: View videos on the internet about the characteristics of the office worker 

when dealing with customers. Participate in a discussion to tell what characteristics 

were identified in the videos.   

 Activity 3: Role-play different scenarios where the teacher is a friendly / rude /blind 

etc. customer to see how learners respond. 

Grade 4: Second year:  

Activity 1: Identify and name the types of customers in the work environment.  

Activity 2: Participate in a discussion about how to deal with different types of 

customers. Identify the qualities of the office worker for dealing with different types of 
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customers and list on a worksheet.  

Activity 3: Learners to tell the class about their experience in the community, for e.g. 

working in the open labour market. 

 -Have they come across different types of customers? 

-Talk about the way in which you handle the different types of customers. 

7-8 Office practice 

Reception area 

Understand the requirements for a 

successful reception area: human 

relations. 

 

Grade 4: First year:  

Activity 1: Brainstorm, in groups, ideas about the necessity of having an impartial 

personality when working with customers. Create a mind map and present ideas to 

the class.  

Activity 2: Search the internet for examples of PowerPoint Presentations about 

human relations in the office environment. Insert a table in a text document and list 

key words from presentations viewed describing characteristics of human relations in 

the office environment.  

Activity 3: List characteristics of human relations in a PowerPoint Presentation. Add 

words pictures to the slides.  

Grade 4: Second year:  

Activity 1: Participate in a discussion about the requirements for a successful 

reception area. Insert a table with 12 rows and 2 columns. Type words to summarize 

the requirements for a successful reception area in the blocks. 

Activity 2: Design a diagram by using SmartArt and use the requirements identified 

in identified in activity 1 to type in the diagram. Present your diagram to a friend.  

Activity 3: Complete a worksheet with statements about requirements for a 

successful reception area prepared by teacher and indicate if the statement is true or 

false.  
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Computer 

Application 

 

Word 

processing and 

editing 

Business 

documents 

 

Demonstrate basic operations of the 

computer: how to print a document.  

 

Teacher’s note: Activities and screenshots taken from the free website: 

http://www.gcflearnfree.org/office2010/word2010/7 

Grade 4: First year:  

Activity 1: To view the Print pane: 

Click the File tab to go to Backstage view. 

Select Print. The Print pane appears, with the print settings on the left and 

the Preview on the right. 

 

To print: 

Go to the Print pane. 

If you only want to print 

certain pages, you can 

type a range of pages. 

Otherwise, select Print 

All Pages. 

Select the number of 

copies. 
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Check the Collate box if you are printing multiple copies of a multi-page 

document. 

Select a printer from the drop-down list. 

Click the Print button. 

Grade 4: Second year:  

Activity 1:  

Open an existing Word document.  

Preview the document in the Print pane. 

Print two copies of the document. 

Client services 

and 

communication 

 

Customer 

services 

 

Understand how to greet a customer 

correctly.  

Grade 4: First year:  

Activity 1: Participate in a discussion about how to greet a customer correctly. Write 

key words on the board.  

Activity 2: Practice how you would greet a customer face-to face using role-play. 

Give feedback to the learner who practiced greeting the customer.  

Activity 3: Create a mind map illustrating the correct way to greet a customer.  

Grade 4: Second year:  

Activity 1: View videos on the internet about how to greet a customer. Participate in a 

discussion to tell what characteristics were identified in the videos. Use 

http://www.andrewjensen.net/5-ways-to-properly-greet-a-customer/as an 

example.   

Activity 2: Practice how you would greet a customer over the telephone using role-

play. Give feedback to the learner who practiced greeting the customer.  

Activity 3: Complete a worksheet with statements about how to greet a customer 

prepared by teacher and indicate if the statement is true or false. 
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Grade 4: Term 4 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

 

9 Fun activities Search the internet to find videos and play 

games.  

 

 

Grade 4: First and Second year: 

Open the web browser and explore the following websites: 

Activity 1: kids.nationalgeographic.com 

Activity 2: howstuffworks.com 

Activity 3: www.funbrain.com ,www.kidshealth.org 

 

 FORMAL ASSESSMENT TASK: GRADE 4:  

Assessment is formally recorded during four (4) practical sessions with a minimum of four (4) skills reported. Learners, regardless of abilities, shall be assessed 

on the same skill. The following serves as suggestion of skills to record and report on. 

GRADE 4: FIRST YEAR: TERM 4 

Week 1-2:  

Participate in a game “Telephone”. 

Participate in the game “Charades.” 

Design a poster in a text document using pictures and words to illustrate verbal and non-verbal communication. Present your poster to the class.  

Change text alignment. 

Change the alignment to left and then type their name. Press enter and change the alignment to center, and type your name. 

Type 16 spelling words and change the alignment of each word to either left, middle, right or full. 

Participate in a discussion about ethics in the workplace. Brainstorm ideas and write key words on the board. View videos on the internet about ethics in the 

workplace and add key words to the board. 

Copy and paste pictures from the internet into a text document illustrating ethics in the workplace. Present your document to the class.  

Design a diagram by using SmartArt and use the ethics identified in activity 1 to type in the diagram. Present your diagram to a friend.  

Week 3-4:  

Brainstorm, in groups, ideas about the characteristics of the office worker. Create a mind map and present ideas to the class.  
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Search the internet for examples of PowerPoint Presentations about office etiquette or workplace manners etc. Visit http://www.slideshare.net/ as a starting point. 

List key words from presentations viewed describing characteristics of the office worker in a text document.  

Open a new PowerPoint Presentation and add new slides with titles listing characteristics of the office worker. Add a picture to the slide.  

Practical demonstration by teacher on how to type other characters, symbols and punctuation marks by using the Shift key and the Insert symbol function.  

Identify and name special characters. 

Cut out pictures of special characters, symbols and punctuation marks and design a collage. Show and tell the class. 

Edit a paragraph by inserting punctuation marks, in the colour red, where necessary.  

Participate in a discussion about the basic rights and responsibilities of the office worker. Write key words on the board. 

Read an employment contract and discuss the basic rights and responsibilities of the office worker.  

Create a PowerPoint Presentation by only inserting title slides and a picture illustrating the topic of the contract.  

Complete a worksheet by stating if the given statements about the basic rights and responsibilities of the office worker are true or false. Use the internet to search 

for answers if unsure. Change the font type and size of all the sentences when activity is completed.  

Week 5-6:  

Participate in a discussion about the importance of using a pleasant tone of voice when working in the reception area. Practice this skill by using role-play in pairs.  

Unscramble the words about effective communication on the worksheet provided. 

Participate in a discussion about the importance of effective communication and what the basic principles are. Design a poster using words and pictures 

illustrating effective communication. 

Change page orientation. 

Change page size. 

Participate in a discussion about types of customers in the work environment. List ideas on a mind map.  

View videos on the internet about the characteristics of the office worker when dealing with customers. Participate in a discussion to tell what characteristics were 

identified in the videos.   

Role-play different scenarios where the teacher is a friendly / rude /blind etc. customer to see how learners respond. 

Week 7-8: 

Brainstorm, in groups, ideas about the necessity of having an impartial personality when working with customers. Create a mind map and present ideas to the 

class.  

Search the internet for examples of PowerPoint Presentations about human relations in the office environment. Insert a table in a text document and list key words 
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from presentations viewed describing characteristics of human relations in the office environment. 

List characteristics of human relations in a PowerPoint Presentation. Add words pictures to the slides.  

View the Print pane. 

Print a document.  

Participate in a discussion about how to greet a customer correctly. Write key words on the board.  

Practice how you would greet a customer face-to face using role-play. Give feedback to the learner who practiced greeting the customer.  

Create a mind map illustrating the correct way to greet a customer. 

GRADE 4: SECOND YEAR: TERM 4  

Week 1-2: 

Participate in a blindfold game. Write down key words explaining how to be a good listener.  

View PowerPoint Presentations on the internet about verbal and non-verbal communication by using the following as key words: verbal and nonverbal 

communication ppt. Open a text document and choose either verbal or non-verbal communication as a heading. Illustrate the form of communication by using 

pictures and key words.  

Design a diagram by using SmartArt and use the key words from activity 2 to type in the diagram. Present your diagram to the class.  

Change line spacing. 

Change paragraph spacing. 

Participate in a discussion about ethics in the workplace. Brainstorm ideas and write key words on the board. View videos on the internet about ethics in the 

workplace and add key words to the board. 

Complete a worksheet by stating if the given statements about ethics in the workplace are true or false. Use the internet to search for answers if unsure. Change 

the font type and size of all the sentences when activity is completed.  

Design a diagram by using SmartArt and use the ethics identified in activity 1 to type in the diagram. Present your diagram to a friend. 

Week 3-4:  

Brainstorm, in groups, ideas about the characteristics of the office worker. Create a mind map and present ideas to the class.  

Search the internet for examples of PowerPoint Presentations about office etiquette or workplace manners etc. Visit http://www.slideshare.net/ as a starting point. 

List key words from presentations viewed describing characteristics of the office worker in a text document.  

Open a new PowerPoint Presentation and add new slides with titles listing characteristics of the office worker. Add a picture to the slide.  

Complete a worksheet by matching the given symbol in column A with the same symbol in column B. Ensure that Column A is in a specific colour to see if 
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learners copy and paste instead of inserting the symbol independently. 

Insert a table with 10 rows and 10 columns. Insert your own choice of special characters, symbols and punctuation marks in the blocks.  

Edit a paragraph by inserting punctuation marks, in the colour red, where necessary. 

Participate in a discussion about the basic rights and responsibilities of the office worker. Insert a table in a text document and type key words of the discussion. 

Read an employment contract and discuss the basic rights and responsibilities of the office worker. Create a PowerPoint Presentation by only inserting title slides 

and a picture illustrating the topic of the contract.  

Create a PowerPoint Presentation about the rights and responsibilities of the office worker. Insert a title slide and a sentence to illustrate the right or the 

responsibility of the office worker. Present it to the class. 

Week 5-6:  

Participate in a discussion about how to be helpful to customers and what it means to be tactful. View videos on the internet on the subject. Use role-play to 

illustrate receiving customers by being friendly and tactful in difficult situations.   

Participate in a discussion about the different ways in which we communicate. Name and list ways in which to communicate effectively when writing, reading, 

talking and listening. 

Participate in a discussion about the importance of effective communication and what the basic principles are. Open a new PowerPoint Presentation and add new 

slides with titles listing principles of effective communication.  Add a picture to each slide.  

Change page margins. 

Identify and name the types of customers in the work environment 

Participate in a discussion about how to deal with different types of customers. Identify the qualities of the office worker for dealing with different types of 

customers and list on a worksheet.  

Tell the class about experience in the community, for e.g. working in the open labour market. 

Week 7-8: 

Participate in a discussion about the requirements for a successful reception area. Insert a table with 12 rows and 2 columns. Type words to summarize the 

requirements for a successful reception area in the blocks. 

Design a diagram by using SmartArt and use the requirements identified in identified in activity 1 to type in the diagram. Present your diagram to a friend.  

Complete a worksheet with statements about requirements for a successful reception area prepared by teacher and indicate if the statement is true or false. 

Print a document.  

View videos on the internet about how to greet a customer. Participate in a discussion to tell what characteristics were identified in the videos. 
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Practice how you would greet a customer over the telephone using role-play. Give feedback to the learner who practiced greeting the customer. 

Complete a worksheet with statements about how to greet a customer prepared by teacher and indicate if the statement is true or false. 
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3.2.5  Grade 5 TERM 1 

 

A learner in Grade 5 will be in the grade for 3 years (16, 17 &18 years old). The teaching plan includes three suggested activities to be taught over the three years. 

Activity 1 is suggested for the first year the learner is in the grade, activity 2 for the Second year the learner is in the grade and activity 3 for the third year the learner 

is in the grade. Activities should be chosen depending on resources, time available and level of understanding of learners.  

Grade 5: Term 1 

WEEK
K
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

1-2  Office practice  

 

Office 

equipment 

 

Identify, point out or name the different parts of the 

computer: 

Hardware: 

A. The tower case, 

CD/DVD drive and USB 

ports. 

 

B. Input devices such as the keyboard, mouse, 

touchpad, scanner, digital camera and graphics 

tablet. 

Grade 5: First year: 

Activity 1: Identify, point out or name the tower case components and its 

function: 

Components: 

CD  and DVD drive to insert disks 

USB ports to insert devices 

Activity 2: Identify, point out or name the input devices and its functions: 

Keyboard  

Mouse  

Touchpad  

Scanner  

Digital camera  

Graphics tablet 

Activity 3:  Identify, point out or name the output devices and its functions: 

The monitor  

The speaker/headset  

The printer 

Grade 5: Second year:  

Activity 1: Make a collage or poster that illustrates the components, input and 
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Grade 5: Term 1 

WEEK
K
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

 

 

C. Output devices such as the monitor, speaker 

and printer. 

 

output devices of a computer. 

Activity 2: Participate in a discussion of the functions of input and output 

devices of a computer.   

Activity 3: Complete a word search worksheet about components, input and 

output devices of a computer and paste in the workbooks.  

Grade 5: Third year:  

Activity 1: Use sticky notes to label a computer’s parts. Discuss what each part 

does together. Write down rules or tips that learners should follow or use. For 

example, the sticky note on a keyboard might mention its function but also how it 

should be used gently and how people should wash their hands before using the 

keyboard. A note on the printer would advise on printing only what is needed to 

conserve paper and ink. 

Activity 2: Search the internet for online games and activities about the 

components, hardware and software of a computer, for e.g. the "Click-N-Learn" 

tool at Kids-Online.net 

Activity 3: Bring some advertisements (e.g. newspaper inserts) for computers 

and peripherals, and have the learners analyze them. Which computers would 

best suit their needs? Which ones are good deals? Discuss in groups.  

Teacher’s note: Follow the link to the following free website and learn more 

about computer basics:  

http://www.gcflearnfree.org/windowsbasics 

http://www.gcflearnfree.org/computerbasics/1 

http://www.gcflearnfree.org/computerbasics/5 

http://www.gcflearnfree.org/computerbasics/6 

http://www.gcflearnfree.org/computerbasics/6
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Grade 5: Term 1 

WEEK
K
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

 

Computer 

application  

 

Keyboard 

techniques  

 

 

Demonstrate knowledge of the parts of the 

keyboard and use the correct typing position: the 

function, typing, numeric, control, windows, shift, 

alt, enter and cursor keys. 

 

Grade 5: First year:  

Activity 1: Participate in a discussion about the different components on the 

keyboard. Write key words on the board.  

Activity 2: Participate in a discussion about the correct posture in front of the 

computer and brain storm ideas on how to place body, hands and fingers. 

Activity 3: Complete a matching worksheet pairing the names of the 

components on the keyboard with the correct picture and paste in the 

workbooks.  

Grade 5: Second year:  

Activity 1:  Practical demonstration by teacher showing learners the parts of a 

keyboard (alphabet keys, numeric pad, function keys, special control keys and 

cursor keys. 

Activity 2:  Find pictures that show the appropriate ergonomic sitting position. 

Work in groups and make a collage to put on class wall. Groups’ show and tell 

about their collage to the class. 

Activity 3: Identify, point out or name the different components on the keyboard, 

namely the function, typing, numeric, control, windows, shift, alt, enter and 

cursor keys. 

Grade 5: Third year:  

Activity 1: Make a collage or poster using pictures or words about the parts of 

the keyboard. 

Activity 2: View videos about ergonomics and discuss the basic principles of 

ergonomics. List key words in a text document. 



 

2018   CAPS GRADE R-5 FOR LEARNERS WITH SEVERE INTELLECTUAL DISABILITY                                                             Page 115 

Grade 5: Term 1 

WEEK
K
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Activity 3: Complete a matching worksheet pairing the names of the 

components on the keyboard with the correct picture and paste in the 

workbooks.  

Client 

services and 

communicatio

n  

 

Hygiene and 

healthy habits 

 

Understand healthy personal habits and basic 

hygiene for e.g. brush your teeth twice daily, 

shower or bath once a day, wash your hair 

regularly, wash your hands often, shave regularly, 

brush your hair often, cut your hair when 

necessary, clip nails frequently, take care of any 

injuries until they are healed, use personal hygiene 

products correctly, wear clean clothes and change 

underclothing daily. 

 

 

Grade 5: First year:  

Activity 1: Participate in a discussion about healthy personal habits and write 

key words on the board.  

Activity 2: Complete a word search worksheet about healthy personal habits 

and hygiene products and paste in the workbooks.  

Activity 3: Cut and paste pictures of hygiene products from advertisements and 

magazines. Add the total price of the products on a calculator. 

Grade 5: Second year:  

Activity 1: Participate in a discussion about healthy personal habits. Insert a 

table of 12 rows and 2 columns in a text document and type healthy habits in the 

blocks.  

Activity 2: Unscramble the words about personal hygiene on the worksheet 

provided. 

Activity 3: Practical demonstration by teacher to show learners a spreadsheet 

document. Show rows and columns and where to fill in with colour. Learners’ 

type names of hygiene products in rows and fill each block with a different 

colour.  

Grade 5: Third year:  

Activity 1: Participate in a discussion about healthy personal habits. Create a 

PowerPoint Presentation and make slides illustrating healthy personal habits. 

Present to the class.  
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Grade 5: Term 1 

WEEK
K
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Activity 2: Complete a worksheet with statements about personal hygiene 

prepared by teacher and indicate if the statement is true or false. 

Activity 3: Practical demonstration by teacher to show learners a spreadsheet 

document. Show rows and columns and AutoSum. Learners practice AutoSum 

in a spreadsheet by listing hygiene products in column A and the price in column 

B. Use AutoSum to get the total. 

3-4 Office practice  

 

Computer care 

Demonstrate how to take care of a computer by 

cleaning the peripherals and using removable 

devices carefully and correctly.  

 

 

Grade 5: First year:  

Activity 1: Practical demonstration by teacher on how to take care of a 

computer by cleaning the hardware.  

Activity 2: View videos about using removable devices carefully and correctly. 

Class discussion to follow after watching the video on what was learned.  

Activity 3: Set up a code of conduct for working on the computers / in the 

computer laboratory. 

Grade 5: Second year:  

Activity 1: Demonstrate, in groups, how to clean the screen and wipe the 

keyboard correctly.  

Activity 2: Show and tell the class how to use removable devices carefully and 

correctly. 

Activity 3: Set up a code of conduct for working on the computers / in the 

computer laboratory. 

Grade 5: Third year:  

Activity 1: Compile a checklist of what peripheral should be cleaned and what 

equipment used to do so. 

Activity 2: Practice cleaning the computer and using removable devices 



 

2018   CAPS GRADE R-5 FOR LEARNERS WITH SEVERE INTELLECTUAL DISABILITY                                                             Page 117 

Grade 5: Term 1 

WEEK
K
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

carefully and correctly. 

Activity 3: Set up a code of conduct for working on the computers / in the 

computer laboratory.  

Teacher’s note: Follow the link to the following free website and learn more 

about flash drives: http://www.gcflearnfree.org/windowsbasics/working-

with-flash-drives 

A flash drive is a small, removable storage drive that plugs into a USB port on 

your computer. You can purchase a flash drive for less than R100 at just about 

any retail store with an electronics department, and even at some grocery stores 

and pharmacies. Flash drives are a convenient way to bring your files with 

you and open them on a different computer. You could also use a flash drive 

to back up important documents and other files. In this lesson, we'll show you 

how to use a flash drive with your computer. 

 

To connect a flash drive: 

Insert the flash drive into 

a USB port on your 

computer. You should find a 

USB port on the front, back, 

or side of your computer (the 

location may vary depending 

on whether you have a 

desktop or a laptop). 
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Grade 5: Term 1 

WEEK
K
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Depending on how your computer is set up, a dialog box may appear. If 

it does, select Open folder to view files. 

If a dialog box does not appear, open Windows Explorer and locate 

and select the flash drive on the left side of the window. Note that 

the name of the flash drive may vary. 

 

Working with a flash drive: 

Once you've connected a flash drive, you can work with it just like any other 

folder on your computer, including moving and deleting files. 

If you want to copy a file from your computer to the flash drive, click 

and drag the file from your computer to this window. 
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Grade 5: Term 1 

WEEK
K
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

The file will be duplicated, and this new version will be saved to the 

flash drive. The original version of the file will still be saved to your 

computer. 

 

If you want to copy a file from your flash drive to your computer, 

click and drag the file from this window to your computer. 

 

If you want to remove a file from your flash drive, click and drag the 

file to the Recycle Bin. A dialog box will appear. Click Yes to confirm 

that you want to permanently delete the file. 
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Grade 5: Term 1 

WEEK
K
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

 

To safely remove a flash drive: 

When you're done using a flash drive, don't remove it from the USB port 

just yet! You'll need to make sure to disconnect it properly to avoid 

damaging files on the drive. 

Right-click the flash drive and select Disconnect (or Eject). 

 

You can now safely remove the flash drive from the USB port. 

Computer 

application  

 

Word 

processing and 

editing 

Business 

Use the keyboard skilfully and accurately by typing 

the home row (asdfgh;lkj), top row (qwertyuiop) 

and bottom row (zxcvbnm), inserting a capital 

letter, using bold, italics and  underline, change the 

font type and size and punctuation and  special 

characters.  

Grade 5: First year:  

Activity 1: Practical demonstration by teacher showing learners the correct 

placement of fingers and hands to type the home, top and bottom row. Learners 

practice to type top home, top and bottom letters with correct placement of 

fingers and hands.  

Activity 2: Learners open a text document and type words using bold, italics 

and underline. Change the font type and size of certain words. 
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Grade 5: Term 1 

WEEK
K
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

documents 

 

 

 

 

 

 

 

Activity 3: Practical demonstration by teachers showing learners how to type 

capitals, other characters, symbols and punctuation marks by using the Shift key 

and the Insert symbol function. Learners identify and name the characters. 

Grade 5: Second year:  

Activity 1: Visit http://www.dancemattypingguide.com and practice typing the 

home, top and bottom row. 

Activity 2: Practice using bold, italics, underline, font type and size by typing 

key words about yourself in a new document.  

Activity 3: Give a prepared paragraph to learners consisting of 20 sentences.  

Learners edit the paragraph by inserting capitals and punctuation marks, in the 

colour red, where necessary.  

Grade 5: Third year:  

Activity 1: Use short words starting with letters from home, top and bottom row 

given by teacher and practice typing words. 

Activity 2: Practice using bold, italics, underline, font type and size by changing 

words according to instructions on a prepared paragraph. 

Activity 3: Search the internet for ASCII codes and copy them to a text 

document.  

 

Client 

services and 

communicatio

n  

 

Understand unhealthy personal habits and bad 

basic hygiene and the basic principles of sick 

leave. 

Grade 5: First year:  

Activity 1: Make a list of different first impressions, good and bad, that you have 

had with people. Consider the people’s personal hygiene, grooming and dress in 

your response: your friend, new classmates, your teachers and the office ladies.  

Activity 2:  Create a PowerPoint Presentation and use pictures and words to 

http://www.dancemattypingguide.com/
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Grade 5: Term 1 

WEEK
K
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Hygiene and 

healthy habits 

illustrate bad hygiene and unhealthy habits. Present it to the class.  

Activity 3: Participate in a discussion about going to school/work when you 

have a cold or flu. How do you react when you are well and have close contact 

with a person who has a cold or flu? Will you keep your distance or do you hope 

that you will not catch whatever he has? What influence would your actions have 

on the interaction between the two of you? Create a mind map with ideas from 

discussion.  

Grade 5: Second year:  

Activity 1: Make a checklist of personal grooming habits and allow learners to 

rate each other for e.g. hair, clothes, nails, teeth, sweat etc.  

Activity 2: Some workplaces require strict dress codes because of safety, 

cleanliness and hygiene. Discuss examples of such workplaces. Cut out pictures 

from magazines to illustrate safety, cleanliness and hygiene on different 

workplaces and make a poster.  

Activity 3: What procedures must office workers follow to report ill and take sick 

leave? Search the internet to find appropriate answers and discuss in the class.  

Grade 5: Third year:  

Activity 1: Participate in a discussion about services that we use every day. List 

these services on the board.  How did the personal hygiene, grooming and 

dress of the service provider affect your opinion of the service quality? 

Activity 2: Some workplaces require strict dress codes because of safety, 

cleanliness and hygiene. Participate in a discussion how a nurse and a baker 

would compare regarding their hygiene and cleanliness.   
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Grade 5: Term 1 

WEEK
K
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Activity 3: Set up a code of conduct for school or work regarding having a cold 

or flu.   

5-6 Office practice  

 

Operates a 

personal 

computer 

system 

Demonstrate basic operations on the computer: 

switch the computer on and off, move and click the 

mouse correctly, identify, point out or name the 

basic keys on the keyboard, the names and icons 

of the programmes on the computer and how to 

exit the programmes. 

 

 

 

 

Grade 5: First year:  

Activity 1: Practical demonstration by teacher showing learners how to switch 

the computer on and off, moving and clicking the mouse correctly, identifying the 

basic keys on the keyboard, identifying the icons of the programmes on the 

computer and exiting the programmes. 

Activity 2: View videos about how to move and click the mouse correctly and 

discuss, in groups, techniques learned. Class discussion to follow after watching 

the video on what was learned. 

Activity 3: Show and tell the class about the basic keys on the keyboard and 

their functions.  

Grade 5: Second year: 

Activity 1: Demonstrate how to switch the computer on and off by following 

correct procedure. 

Activity 2: Complete a matching worksheet pairing the icons of the programmes 

with the correct name of the programme and paste in the workbooks. 

Activity 3: Practice to open and close specific programmes on the computer. 

Grade 5: Third year:  

Activity 1:  Teacher’s note: Follow the link to the following free website and 

learn more about parts of a keyboard: 

http://www.gcflearnfree.org/computerbasics/5.3 

Activity 2: Illustrate to a partner how to move and click the mouse correctly. 

View videos about how to move and click the mouse correctly and discuss, in 
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Grade 5: Term 1 

WEEK
K
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

groups, techniques learned. 

Activity 3: Name and list the programs on your computer and illustrate how to 

open and close a few of them.  

Computer 

application 

  

Word 

processing and 

editing 

Business 

documents 

 

 

 

Demonstrate basic editing features in a paragraph 

and tables: text selection, copy, paste, insert letters 

or words, delete letters or words, change order of 

words, insert or delete rows and columns, change 

borders and shadings, change cell alignment, 

change text direction, save with a new name.  

 

Grade 5: First year:  

Activity 1:Practical demonstration by teacher, on a prepared document,  on how 

to select certain text, copy, paste, insert letters or words, delete letters or words, 

change order of words, insert or delete rows and columns, change borders and 

shadings, change cell alignment, change text direction, save with a new name.  

Activity 2: Give a prepared paragraph to learners in electronic and hard copy.  

Learners edit the paragraph electronically according to the hard copy by 

selecting certain text, copying and pasting certain words or pictures and 

inserting missing letters and words.  

Activity 3: Practical demonstration by teacher on how to use the Save as 

function. Learners practice by opening new documents and saving them under a 

specific name.  

Grade 5: Second year:  

Activity 1: Practical demonstration by teacher, on a prepared document, on 

how to select certain text, copy, paste, insert letters or words, delete letters or 

words, change order of words, insert or delete rows and columns, change 

borders and shadings, change cell alignment, change text direction, save with a 

new name.  

Activity 2: Give a prepared paragraph to learners in electronic and hard copy.  

Learners edit the paragraph electronically according to hard copy by changing 

the order of words, inserting or deleting rows and columns and changing borders 
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and shadings. 

Activity 3: Practical demonstration by teacher on how to use the Save as 

function. Learners practice by opening new documents and saving them under a 

specific name. 

Grade 5: Third year:  

Activity 1: Practical demonstration by teacher, on a prepared document,  on 

how to select certain text, copy, paste, insert letters or words, delete letters or 

words, change order of words, insert or delete rows and columns, change 

borders and shadings, change cell alignment, change text direction, save with a 

new name.  

Activity 2: Give a prepared paragraph to learners in electronic and hard copy.  

Learners edit the paragraph electronically according to hard copy by changing 

the cell alignment and the text direction in a table.   

Activity 3: Practical demonstration by teacher on how to use the Save as 

function. Learners practice by opening new documents and saving them under a 

specific name.  

Teacher’s note: Follow the link to the following free website and learn more 

about cut, copy, paste, finding and replacing text: 

http://www.gcflearnfree.org/word2010/21 

To convert existing text to a table: 

Select the text you want to convert. 

Select the Insert tab. 

Click the Table command. 

Select Convert Text to Table from the menu. A dialog box will appear. 
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Choose one of the options in the Separate text at: section. This is how 

Word knows what text to put in each column. 

 

Click OK. The text appears in a table. 
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To add a row above an existing row: 

Place the insertion point in a row below the location where you want to 

add a row. 

 

Right-click the mouse. A menu appears. 

Select Insert Insert Rows Above. 
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A new row appears above the insertion point. 

 

You can also add rows below the insertion point. Follow the same 

steps, but select Insert Rows Below from the menu. 
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To add a column: 

Place the insertion point in 

a column adjacent to the location where 

you want the new column to appear. 

Right-click the mouse. A menu will appear. 

Select Insert Insert Columns to the 

Left or Insert Columns to the Right. A new 

column appears. 
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To delete a row 

or column: 

Select the row 

or column. 

Right-click your 

mouse. A menu will appear. 

Select Delete Cells. 

 

 

 

 

Select Delete entire row or Delete 

entire column, then click OK. 

 

Apply a table style: 

Click anywhere on the table. 

The Design tab will appear on the Ribbon. 

Select the Design tab and locate the Table Styles. 

Click the More drop-down arrow to see all of the table styles. 
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Hover the mouse over the various styles to see a live preview. 

Select the desired style. The table style will appear in the document. 

 

To change table style options: 

Once you've chosen a table style, you can turn various options on or off to 

change the appearance of the table. There are six options: Header 

Row, Total Row, Banded Rows, First Column, Last Column, 

and Banded Columns. 

Click anywhere on the table. The Design tab will appear. 

From the Design tab, check or uncheck the desired options in 

the Table Style Options group. 
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Depending on which table style you're using, certain table style 

options may have a somewhat different effect. You may need 

to experiment to get the exact look you want. 

To add borders to a table: 

Select the cells you want to add a border to. 

 

From the Design tab, select the desired Line Style, Line Weight, 

and Pen Colour. 

 

Click the Borders drop-down arrow. 

From the drop-down menu, select the desired border type. 
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The border will be added to the selected cells. 

 

Modifying a table using the Layout tab: 

When you select a table in Word 2010, Design and Layout tabs appear 

under Table Tools on the Ribbon. Using commands on the Layout tab, 

you can make a variety of modifications to the table. 
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Challenge: 

Open an existing Word document. If you want, you 

can use this example. 

Convert some text into a table. If you are using the 

example, convert the text below By Client. 

Apply a table style, and experiment with the table 

style options. If you are using the example, see if 

you can make the table match the By 

Salesperson table above it. 

Delete a row from the table. 

Insert a blank table with five rows and four columns. Add borders to 

the blank table. 

Teacher’s note: Follow the link to the following free website and learn 

more about how to save a document: 

http://www.gcflearnfree.org/word2010/4 

 

http://content.gcflearnfree.org/topics/174/Word2010_Tables_Practice.docx
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It's important to know how to save the documents you are working with. 

Frequently saving your documents prevents you from losing your work, 

and using Save As allows you to edit a document while leaving the 

original copy unchanged. 

There are several ways to share and receive documents, which will 

affect how you need to save the file. Are you downloading the document? 

Saving it for the first time? Saving it as another name? Sharing it with 

someone who doesn't have Word 2010? All of these factors will affect how 

you save your Word documents. In this lesson, you'll learn how to use 

the Save and Save As commands, how to save as a Word 97-

2003 compatible document, and how to save as a PDF. 

How to save documents:  

When you create a new document in Word, you'll need to know how 

to save it in order to access and edit it later. Word allows you to save your 

documents in several ways. 

To use the Save As command:  

Save As allows you to choose a name and location for your document. It's 

useful if you've first created a document or if you want to save a different 

version of a document while keeping the original. 

Click the File tab. 

Select Save As. 
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The Save As dialog box will appear. Select the 

location where you want to save the document. 

Enter a name for the document, then 

click Save. 

 

 

If you're using Windows 7, you'll usually want to save files to 

your Documents library, while in other versions of Windows you'll 

save them to the My Documents folder. For more information, check 

out our lessons on Windows 7 and Windows XP. 

To use the Save command: 

Click the Save command on the Quick Access to 

toolbar. 

 

The document will be saved in its current location with 

the same file name. 

http://www.gcflearnfree.org/windows7
http://www.gcflearnfree.org/windowsxp
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If you are saving for the first time and select Save, the Save As dialog 

box will appear. 

AutoRecover:  

Word automatically saves your documents to a temporary folder while 

you're working on them. If you forget to save your changes or if Word 

crashes, you can recover the autosaved file. 

Open a document that was previously closed 

without saving. 

In Backstage view, click Info. 

 If there are autosaved versions of your file, 

they will appear under Versions. Click on the 

file to open it. 
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To save 

changes, 

click Restore, then click OK. 

 

 

By default, Word autosaves every 10 minutes. If you are editing a 

document for less than 10 minutes, Word may not create an autosaved 

version. 

 

Challenge: 

Open an existing Word document. If you want, you can use 

this example. 

Using Save As, save the document with the file name trial. 

http://content.gcflearnfree.org/topics/174/Word2010_Saving_Practice.docx


 

2018   CAPS GRADE R-5 FOR LEARNERS WITH SEVERE INTELLECTUAL DISABILITY                                                             Page 139 

Grade 5: Term 1 

WEEK
K
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Save the same document as a PDF file. 

Close the document. 

Open another existing Word document. 

Save the document so it is compatible with Word 2003. 

Close the document. 

Client 

services and 

communicatio

n  

 

Customer 

service  

 

Interpret body language in a business environment. Grade 5: First year:  

Activity 1: Use your working environment to give examples of positive and 

negative body language. 

Activity 2: Create a PowerPoint Presentation and use words and pictures to 

illustrate positive and negative body language. Present to the class.  

Activity 3: “Body movements and gestures show people’s feelings”. List 

examples of the statement in a document using words and pictures.  

Grade 5: Second year:  

Activity 1: Explain the reasons why good posture and eye contact are important 

in the workplace by using examples from a selected business context. 

Activity 2: Create a mind map illustrating the reasons for eye contact.  

Activity 3: “Body movements and gestures show people’s feelings”. List 

examples of the statement in a document using words and pictures.  

Grade 5: Third year:  

Activity 1: Give reasons why it is important to interpret body language correctly 

in the workplace by using examples from a selected business context (your 

school).  

Activity 2: Learners interpret the body language of people in photos given. 

Discuss in groups and give feedback to the class.  
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Activity 3: “Body movements and gestures show people’s feelings”. List 

examples of the statement in a document using words and pictures.  

7-8 Office practice  

 

Office 

equipment and 

mailing 

systems 

 

Use general office equipment and understand the 

basic operation of a photocopying, fax and 

shredding machine.   

 

 

Grade 5: First year:  

Activity 1: Use scrap paper to try out different staplers, punch holes in the 

paper and cut paper with a guillotine (make sure you have safety measures in 

place). 

Activity 2: Use office equipment brochures or copy and paste pictures from the 

internet to illustrate different office equipment and make a collage to put on the 

wall.  

Activity 3: Set up a code of conduct that explains safety measures when 

working with office equipment. 

Grade 5: Second year:  

Activity 1: Organise with the administration office for learners to observe how 

the photocopying, fax and shredder machines work.  

Activity 2: Insert a table in a new document with 2 columns. List the names of 

office equipment in column 1 and copy and paste pictures from the internet to 

illustrate the equipment in column 2. 

Activity 3: Display office equipment in the classroom and learners each show 

and tell about the equipment and how it is used.  

Grade 5: Third year:  

Activity 1: Organise with the office block for learners to practice to replace the 

photocopying machine paper and how to make photocopies.   

Activity 2: Organise with the office block for learners to practice to shred paper 

and understand why this machine is used.   
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Activity 3: Organise with the office block for learners to practice to replace the 

fax paper and how to send a fax. 

Computer 

application  

 

Word 

processing and 

editing  

Business 

documents 

 

 

Demonstrate basic file management.  

 

 

Teacher’s note: Activities and screenshots taken from the free website: 

http://www.gcflearnfree.org/windowsbasics/3Grade 5: First year:  

Activity 1: What is a file?:  

There are many different types of files you can use. For example, 

Microsoft Word documents, digital photos, digital music, and digital videos 

are all types of files. You might even think of a file as a digital version of 

a real-world thing you can interact with on your computer. When you use 

different applications, you'll often be viewing, creating, or editing files. 

Files are usually represented by an icon. In the image below, you can see 

a few different types of files below the Recycle Bin on the desktop. 

 

What is a folder?: 

Windows uses folders to help 

you organize files. You can put 

files inside a folder, just like you 
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would put documents inside a real folder. In the image below, you can see some 

folders on the desktop. 

 

Windows Explorer:  

You can view and organize files 

and folders using a built-in 

application known as Windows 

Explorer (called File Explorer in 

Windows 8). 

To open Windows Explorer, click 

the Windows Explorer icon on 

the taskbar, or double-click any 

folder on your desktop. A new Windows Explorer window will appear. Now 

you're ready to start working with your files and folders. 

 

From Windows Explorer, double-click a folder to open it. You can then 

see all of the files stored in that folder. 
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Notice that you can also see the location of a folder in the address 

bar near the top of the 

window. 

 

Activity 2: To open a file:  

Find the file on your computer, and double-click it. This will open the file in 

its default application. In our example, we'll open a Microsoft Word document 

(Chicago Trip Details.docx), which will open in Microsoft Word. 

 

Open the application, and then use the application to open the 

file. Once the application is 

open, you can go to 

the File menu at the top of 

the window and 

select Open. 
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Activity 3: Moving and deleting files:  

As you begin using your computer, you will start to collect more and more 

files, which can make it more difficult to find the files you need. Fortunately, 

Windows allows you to move files to different folders and delete files you 

longer use. 

To move a file:  

It's easy to move a file 

from one location to 

another. For example, 

you might have a file on 

the desktop that you 

want to move to 

your Documents folder: 

-Click and drag the file to 

the desired location. 

 

-Release the mouse. The file will appear in the new location. In this 

example, we have opened the folder to see the file in its new location.  
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You can use this same technique to move an entire folder. Note that 

moving a folder will also move all of the files within that folder. 

Grade 5: Second year:  

Activity 1: To create a new folder: 

-Within Windows Explorer, locate and select the New folder button. 

 

-The new folder will appear. Type the desired name for the folder and 

press Enter. In our example, we'll call it School Documents. 
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-The new folder will be created. You can now move files into this folder. 

Activity 2: To rename a file or folder: 

You can change the name 

of any file or folder. A 

unique name will make it 

easier to remember what 

type of information is 

saved in the file or folder. 

-Click the file or 

folder, wait about one 

second, and click again. An editable text field will appear. 

-Type the desired name on your keyboard and press Enter. The name will 

be changed. 
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Alternatively, you can right-

click it and 

select Rename from the 

menu that appears.  

 

Activity 3: To delete a file or folder:  

If you no longer need to use a file, you 

can delete it. When you delete a file, it is 

moved to the Recycle Bin. If you change 

your mind, you can move the file from the 

Recycle Bin back to its original location. If 

you're sure you want to permanently delete the file, you will need to empty the 

Recycle Bin. 

-Click and drag the file to the Recycle Bin icon on the desktop. Alternatively, 

you can click the file to select it and press the Delete key on your keyboard. 

 

-To permanently delete the file, right-click the Recycle Bin icon and 

select Empty Recycle Bin. All files in the Recycle Bin will be 

permanently deleted. 
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Note that deleting a folder will also delete all of the files within that 

folder. 

Grade 5: Third year:  

Activity 1: Selecting multiple files:  

There are a few different ways to select more than one file at a time: 

-If you're viewing your files as icons, you can click and drag the 

mouse to draw a box around the files you want to select. When you're 

done, release the mouse; the files will be selected. You can now move, 

copy, or delete all of these files at the same time. 

 

-To select specific files from a folder, press and hold the Control key 

on your keyboard, then click the files you want to select. 
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-To select a group of files from a folder, click the first file, press and 

hold the Shift key on your keyboard, then click the last file. All of the 

files between the first and last ones will be selected. 

 

-If you want to select all files in a folder at the same time, open the folder 

in Windows Explorer and press Ctrl+A (press and hold the Control key on 

your keyboard and then press A). All of the files in the folder will be 

selected. 
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Activity 2: If you have a file or folder you use frequently, you can save time 

by creating a shortcut on the desktop. Instead of navigating to the file or 

folder each time you want to use it, you can simply double-click the shortcut 

to open it. A shortcut will have a small arrow in the lower-left corner of the 

icon. 

Note that creating a shortcut does not create a duplicate copy of the 

folder—it's simply a way to access it more quickly. If you delete a shortcut, 

it will not delete the actual folder or the files it contains. Also note that 

copying a shortcut onto a flash drive will not work; if you want to bring a file 

with you, you'll need to navigate to the actual location of the file and copy it 

to the flash drive. 

To create a shortcut: 

-Locate and right-click the desired folder, then select Send to Desktop 

(create shortcut). 
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-A shortcut to the folder will appear on the desktop. Notice the arrow in 

the lower-left corner of the icon. You can now double-click the shortcut 

to open the folder at any time. 

 

Alternatively, you can hold the Alt key on your keyboard and then click 

and drag the folder to the desktop to create a shortcut. 

Activity 3: To copy and paste files:  

You can use the cut, copy, and paste commands for a variety of tasks 

on your computer. For example, if you wanted to create 

a duplicate copy of a file, you could copy it from one folder to another. 
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-Right-click the file and select Copy from the menu that appears. 

Alternatively, you can press Ctrl+C on your keyboard. 

 

-Locate and right-click the new location, then select Paste. 

Alternatively, you can press Ctrl+V on your keyboard. In our example, 

we'll paste the file to the desktop. 

 

-The duplicate file will appear. Notice how the original file has not been 

moved or changed. Note that if you make a change to the original file, it 

will not update any copies of that file.  
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Client 

services and 

communicatio

n  

 

Customer 

service  

 

Understand different methods of handshakes and 

the importance of personal space. 

 

Grade 5: First year:  

Activity 1: Search the internet about different types of handshakes and the 

correct use thereof. Copy and paste pictures to illustrate different types of 

handshakes.  

Activity 2: Use role-play to practice different types of handshakes and look for 

pictures on the internet to make a collage of such examples.  

Activity 3: Explain to the learners why it is important to respect other people’s 

personal space. Let the learners use role-play to practice the appropriate 

personal space to give someone when you are talking to them.  

Grade 5: Second year:  

Activity 1: Search the internet about different types of handshakes and the 

correct use thereof. Copy and paste pictures to illustrate different types of 

handshakes.  

Activity 2: South Africa has different handshakes. Compare the meaning of 

different handshakes used in South Africa. Give examples of when it is 
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appropriate to use each handshake. 

Activity 3: Explain why it is important to respect other people’s space and why 

it is inappropriate to touch other people in a business environment. Write key 

words on the board.  

Grade 5: Third year:  

Activity 1: Search the internet about different types of handshakes and the 

correct use thereof. Copy and paste pictures to illustrate different types of 

handshakes.  

Activity 2: Explain the proper use of a handshake as a greeting in a business 

setting. Illustrate your ideas on a page using words and pictures.  

Activity 3: Give examples of the consequences if one ignores business 

etiquette about personal space. Set up a code of conduct regarding personal 

space in your school.  

9 Fun activities Search the internet to find videos and play games.  

 

Grade 5: First, Second and Third year:  

Open the web browser and explore the following websites:  

Activity 1: alphabet-soup, LearningGamesforKids.com. 

Activity 2: kidsmath.com, http://www.e-learningforkids.org 

Activity 3:  BBC school, http://www.technokids.com 

 

FORMAL ASSESSMENT TASK: GRADE 5:  

Assessment is formally recorded during four (4) practical sessions with a minimum of four (4) skills reported. Learners, regardless of abilities, shall 

be assessed on the same skill. The following serves as suggestion of skills to record and report on. 
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Week 1-2:  

Identify, point out or name the tower case components and its function. 

Identify, point out or name the input devices and its functions. 

Identify, point out or name the output devices and its functions. 

Participate in a discussion about the different components on the keyboard. Write key words on the board.  

Participate in a discussion about the correct posture in front of the computer and brain storm ideas on how to place body, hands and fingers. 

Complete a matching worksheet pairing the names of the components on the keyboard with the correct picture and paste in the workbooks.  

Participate in a discussion about healthy personal habits and write key words on the board.  

Complete a word search worksheet about healthy personal habits and hygiene products and paste in the workbooks.  

Cut and paste pictures of hygiene products from advertisements and magazines. Add the total price of the products on a calculator. 

Week 3-4:  

View videos about using removable devices carefully and correctly. Class discussion to follow after watching the video on what was learned.  

Set up a code of conduct for working on the computers / in the computer laboratory. 

Practice to type top home, top and bottom letters with correct placement of fingers and hands.  

Open a text document and type words using bold, italics and underline. Change the font type and size of certain words. 

Identify and name the special characters. 

Make a list of different first impressions, good and bad, that you have had with people. Consider the people’s personal hygiene, grooming and dress in your 

response: your friend, new classmates, your teachers and the office ladies.  

Create a PowerPoint Presentation and use pictures and words to illustrate bad hygiene and unhealthy habits. Present it to the class.  

Participate in a discussion about going to school/work when you have a cold or flu. How do you react when you are well and have close contact with a person 

who has a cold or flu? Will you keep your distance or do you hope that you will not catch whatever he has? What influence would your actions have on the 

interaction between the two of you? Create a mind map with ideas from discussion.  

Week 5-6: 

View videos about how to move and click the mouse correctly and discuss, in groups, techniques learned.  

Show and tell the class about the basic keys on the keyboard and their functions.  

Edit a paragraph electronically according to hard copy by selecting certain text, copying and pasting certain words or pictures and inserting missing letters and 
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words.  

Practice to open new documents and saving it under a specific name. 

Use your working environment to give examples of positive and negative body language. 

Create a PowerPoint Presentation and use words and pictures to illustrate positive and negative body language. Present to the class.  

Body movements and gestures show people’s feelings”. List examples of the statement in a document using words and pictures. 

Week 7-8:  

Use scrap paper to try out different staplers, punch holes in the paper and cut paper with a guillotine (make sure you have safety measures in place). 

Use office equipment brochures or copy and paste pictures from the internet to illustrate different office equipment and make a collage to put on the wall. 

Set up a code of conduct that explains safety measures when working with office equipment. 

Understanding files and folders. 

Open a file. 

Move and delete files.   

Search the internet about different types of handshakes and the correct use thereof. Copy and paste pictures to illustrate different types of handshakes.  

Use role-play to practice different types of handshakes and look for pictures on the internet to make a collage of such examples 

Use role-play to practice the appropriate personal space to give someone when you are talking to them.  

 

GRADE 5: SECOND YEAR: TERM 1  

Week 1-2: 

Make a collage or poster that illustrates the components, input and output devices of a computer. 

Participate in a discussion of the functions of input and output devices of a computer.   

Complete a word search worksheet about components, input and output devices of a computer and paste in the workbooks.  

Find pictures that show the appropriate ergonomic sitting position. Work in groups and make a collage to put on class wall. Groups’ show and tell about their 

collage to the class. 

Identify, point out or name the different components on the keyboard, namely the function, typing, numeric, control, windows, shift, alt, enter and cursor keys. 

Participate in a discussion about healthy personal habits. Insert a table of 12 rows and 2 columns in a text document and type healthy habits in the blocks.  

Unscramble the words about personal hygiene on the worksheet provided. 

Type names of hygiene products in rows in Microsoft Excel and fill each block with a different colour.  
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Week 3-4: 

Demonstrate, in groups, how to clean the screen and wipe the keyboard correctly. 

Show and tell the class how to use removable devices carefully and correctly. 

Set up a code of conduct for working on the computers / in the computer laboratory. 

Visit http://www.dancemattypingguide.com and practice typing the home, top and bottom row. 

Practice using bold, italics, underline, font type and size by typing key words about yourself in a new document. 

Edit a paragraph by inserting capitals and punctuation marks, in the colour red, where necessary.  

Make a checklist of personal grooming habits and allow learners to rate each other for e.g. hair, clothes, nails, teeth, sweat etc. 

Discuss examples of such workplaces. Cut out pictures from magazines to illustrate safety, cleanliness and hygiene on different workplaces and make a poster.  

What procedures must office workers follow to report ill and take sick leave? Search the internet to find appropriate answers and discuss in the class.  

Week 5-6: 

Demonstrate how to switch the computer on and off by following correct procedure. 

Complete a matching worksheet pairing the icons of the programmes with the correct name of the programme and paste in the workbooks. 

Practice to open and close specific programmes on the computer. 

Edit a paragraph electronically according to hard copy by changing the order of words, inserting or deleting rows and columns and changing borders and 

shadings. 

Practice to open a new documents and saving it under a specific name. 

Explain the reasons why good posture and eye contact are important in the workplace by using examples from a selected business context. 

Create a mind map illustrating the reasons for eye contact.  

List examples of the statement “Body movements and gestures show people’s feelings” in a document using words and pictures 

Week 7-8: 

Organise with the administration office for learners to observe how the photocopying, fax and shredder machines work.  

Insert a table in a new document with 2 columns. List the names of office equipment in column 1 and copy and paste pictures from the internet to illustrate the 

equipment in column 2. 

Display office equipment in the classroom and learners each show and tell about the equipment and how it is used.  

Create a new folder. 

Rename a file or folder 

http://www.dancemattypingguide.com/
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Delete a file or folder. 

Search the internet about different types of handshakes and the correct use thereof. Copy and paste pictures to illustrate different types of handshakes.  

Compare the meaning of different handshakes used in South Africa. Give examples of when it is appropriate to use each handshake. 

Explain why it is important to respect other people’s space and why it is inappropriate to touch other people in a business environment. Write key words on the 

board.  

 

GRADE 5:  

THIRD  YEAR: TERM 1  

Week 1-2: 

Search the internet for online games and activities about the components, hardware and software of a computer, for e.g. the "Click-N-Learn" tool at Kids-

Online.net.  

Bring some advertisements (e.g. newspaper inserts) for computers and peripherals, and have the learners analyze them. Which computers would best suit their 

needs? Which ones are good deals? 

Make a collage or poster using pictures or words about the parts of the keyboard. 

View videos about ergonomics and discuss the basic principles of ergonomics. List key words in a text document. 

Complete a matching worksheet pairing the names of the components on the keyboard with the correct picture and paste in the workbooks. 

Participate in a discussion about healthy personal habits. Create a PowerPoint Presentation and make slides illustrating healthy personal habits. Present to the 

class.  

Complete a worksheet with statements about personal hygiene prepared by teacher and indicate if the statement is true or false. 

Practice AutoSum in a spreadsheet by listing hygiene products in column A and the price in column B. Use AutoSum to get the total. 

Week 3-4: 

Compile a checklist of what peripheral should be cleaned and what equipment used to do so. 

Practice cleaning the computer and using removable devices carefully and correctly 

Set up a code of conduct for working on the computers / in the computer laboratory.  

Use short words starting with letters from home, top and bottom row given by teacher and practice typing words. 

Practice using bold, italics, underline, font type and size by changing words according to instructions on a prepared paragraph. 

Search the internet for ASCII codes and copy them to a text document. 
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Participate in a discussion about services that we use every day. List these services on the board.  How did the personal hygiene, grooming and dress of the 

service provider affect your opinion of the service quality? 

Some workplaces require strict dress codes because of safety, cleanliness and hygiene. Participate in a discussion how a nurse and a baker would compare 

regarding their hygiene and cleanliness.   

Set up a code of conduct for school or work regarding having a cold or flu.   

Week 5-6:  

Follow the link to the following free website and learn more about parts of a keyboard: http://www.gcflearnfree.org/computerbasics/5.3 

Illustrate to a partner how to move and click the mouse correctly. View videos about how to move and click the mouse correctly and discuss, in groups, 

techniques learned. 

Name and list the programs on your computer and illustrate how to open and close a few of them. 

Edit a paragraph electronically according to hard copy by changing the cell alignment and the text direction in a table.   

Practice to open a new document and saving it under a specific name.  

Give reasons why it is important to interpret body language correctly in the workplace by using examples from a selected business context (your school).  

List examples of the statement “Body movements and gestures show people’s feelings” in a document using words and pictures 

Week 7-8: 

Organise with the office block for learners to practice to replace the photocopying machine paper and how to make photocopies.   

Organise with the office block for learners to practice to shred paper and understand why this machine is used.   

Organise with the office block for learners to practice to replace the fax paper and how to send a fax. 

Select multiple files. 

Create a shortcut on the desktop. 

Copy and paste files. 

Search the internet about different types of handshakes and the correct use thereof. Copy and paste pictures to illustrate different types of handshakes.  

Explain the proper use of a handshake as a greeting in a business setting. Illustrate your ideas on a page using words and pictures.  

Give examples of the consequences if one ignores business etiquette about personal space. Set up a code of conduct regarding personal space in your school. 
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3.2.6 Grade 5: 1st, 2nd and 3rd year Term 2 

 

Grade 5: Term 2 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

1-2 Office practice  

 

Reception area 

 

Understand different types of office layouts: 

open plan, cubicle, corridor or panoramic 

layouts.  

 

 

Grade 5: First year:  

Activity 1: Search the internet for different types of office layouts. Class discussion 

to follow after watching videos on what was learned.   

Activity 2: Choose one type of office layout and design it using SmartArt.  

Activity 3: Choose one of the office layouts and design your own office on paper 

using pencil and ruler. 

Grade 5: Second year:  

Activity 1: Search the internet for different types of office layouts. Write key words 

on the board.    

Activity 2: Choose one type of office layout and design it using SmartArt. 

Activity 3: Copy and paste pictures from the internet in a text document to illustrate 

different office layouts.  

Grade 5: Third year:  

Activity 1: Search the internet for different types of office layouts. Create a table in a 

text document and list key words. 

Activity 2: Choose one type of office layout and design the layout using SmartArt. 

Activity 3: Create a PowerPoint Presentation and use pictures and words to 

illustrate one type of office layout. 

Computer 

application  

 

Word processing 

Demonstrate basic operations with shapes: 

insert and edit a shape. 

 

3.2.6.1 Teacher’s note: Activities and screenshots taken from the free website:  

http://www.gcflearnfree.org/office2010/word2010/14 

Grade 5: First year:  
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Grade 5: Term 2 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

and editing 

Business 

documents 

 

 

 

 

 

 

Activity 1: Insert a shape and format it by changing its fill colour, outline 

colour, shape style, and shadow effects: 

3.2.6.2 Select the Insert tab. 

Click the Shapes command. 

 

Select a shape from the drop-down menu. 

Click and drag the mouse until the shape 

is the desired size. 

 

Release the mouse button. 

Activity 2: Practice to resize a shape: 

Click the shape to select it. 

Click and drag one of the sizing handles on the corners and sides of the 

shape until it is the desired size. 

 

To rotate the shape, drag the green handle. 
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Grade 5: Term 2 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

 

Some shapes also have one or more yellow handles that can be used to 

modify the shape. For example, with star shapes you can 

adjust the length of the points. 

 

If you drag the sizing handles on any of the four corners, you 

will be able to change the height and width at the same time. 

The sizing handles on the top or bottom of the shape will only 

allow you to resize vertically, while the handles on the left and 

right sides will resize the shape horizontally. 

Activity 3: Change the order of shapes:  

If one shape overlaps another, you may need to change 

the ordering so the correct shape appears in front. You can 

bring a shape to the front or send it to the back. If you have multiple images, 

you can use Bring Forward or Send Backward to fine tune the ordering. You 

can also move a shape in front of or behind text. 
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Grade 5: Term 2 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Right-click the shape you want 

to move. 

In the menu that appears, 

hover over Bring to 

Front or Send to Back. 

Several ordering options will 

appear. 

 

Select the desired ordering option. The shapes will reorder themselves. 
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Grade 5: Term 2 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

In some cases, the ordering option you select will not affect the ordering of the 

shapes. If this happens, select the same option again or try a different option. 

 

Grade 5: Second year:  

Activity 1: Practice to change a shape’s appearance: To change to a different 

shape: 

Select the shape. A new Format tab appears with Drawing Tools. 

 

Click the Format tab. 

Click the Edit Shape command. 

 

Click Change 

Shape to 

display a drop-

down list. 
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Grade 5: Term 2 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Select the desired shape from the list. 

3.2.6.3  

3.2.6.4  

3.2.6.5 Activity 2: Practice to change a shape’s 

appearance: To change the shape style: 

Select the shape. The Format tab 

appears. 

 

Click the More drop-down arrow in the Shape Styles group to display more 

style options. 

 

Move your cursor over the styles to see a live preview of the style in your 

document. 
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Grade 5: Term 2 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

 

Select the desired style. 

Activity 3: Practice to change a shape’s 

appearance: To change the shapes fill 

colour: 

Select the shape. The Format tab 

appears. 

Select the Format tab. 

Click the Shape Fill command to 

display a drop-down list. 

 

Select the desired colour from the list, 

choose No Fill, or choose More Fill 

Colours to choose a custom colour. 

 

 

Grade 5: Third year:  

Activity 1: Practice to change a shape’s 

appearance: To change the shape 

outline: 
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Grade 5: Term 2 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Select the shape. The Format tab appears. 

Click the Format tab. 

Click the Shape Outline command to display a drop-down menu. 

From the drop-down menu, you can change the 

outline colour, weight (thickness), and whether it is a dashed line. 

 

Activity 2: Practice to change a shape’s appearance: To change shadow effects: 

Select the Format tab. 

Click the Shape Effects command. A drop-down 

menu will appear. 

Hover your mouse over Shadow. You will see a 

list of shadow presets. 

Move your mouse over the menu options to see a 

live preview of the shadow effect in your 

document. 
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Grade 5: Term 2 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Click the desired shadow effect to add it to your 

shape. 

You can select Shadow Options from the drop-down 

menu and click the Colour button to select a different 

shadow colour for your shape. 

 

Activity 3: Practice to change a shape’s appearance: 3D effects:  

There are two types of effects you can apply to your shapes to give them a 3D 

appearance: 3-D Rotation and Bevel.3-D Rotation gives the appearance that 

you are viewing the object from a different angle, and it can be applied to any 

shape. Bevel adds thickness and a rounded edge to shapes, but it doesn't work 

with every type of shape. 

To use 3-D Rotation: 

Select the shape. 

Click the Format tab. 

Click Shape Effects from the Shape Styles group. 

Hover the mouse over 3-D Rotation. A drop-down menu will appear. 

Select the desired rotation preset from the drop-down menu. You can also 

click 3-D Rotation Options if you would prefer to type custom values. 
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Grade 5: Term 2 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

To use bevel: 

Select the shape. 

Click the Format tab. 

Click Shape Effects from the Shape 

Styles group. 

Hover your mouse over Bevel. A drop-down 

menu will appear. 

Select the desired bevel preset from the drop-down menu. You can also click 3-

D Options if you would prefer to type custom values. 

If you click 3-D Options, you'll also be able to change the shape's material to give 

it a metal, plastic, or translucent appearance, and you can choose the lighting type 

to change how the shape is illuminated. 

Client services 

and 

communication  

Understand basic first aid procedures for 

nose bleeds, cuts, scratches, fainting, 

bruising and sprains.  

Grade 5: First year:  

Activity 1: Participate in a discussion about possible first aid scenarios that can 

happen in an office environment and how to treat them. View videos on the internet 
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Grade 5: Term 2 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

 

Office first aid 

 

 

 

 

about basic first aid procedures. Class discussion to follow after watching the videos 

on what was learned.  

Activity 2: Identify, name and list equipment needed to clean cuts and scratches. 

Demonstrate how to clean cuts and scratches in pairs. 

Activity 3: Create a PowerPoint Presentation using pictures and words to illustrate 

basic first aid procedure for an injury of your choice. Present it to the class. 

Grade 5: Second year:  

Activity 1: Participate in a discussion on what to do if a person’s nose bleeds. Role-

play first aid procedure for when you have to stop a nose bleed.   

Activity 2: View videos on the internet about treating bruising and sprains. 

Demonstrate, in groups, how to treat bruising and sprains.  

Activity 3: View videos on the internet about what to do when a person faints and 

role-play procedures to be followed in this scenario. 

Grade 5: Third year:  

Activity 1: Invite the school nurse, a paramedic, fire fighter, emergency room doctor 

or nurse to speak briefly and explain his or her first aid supplies. If emergency 

personnel such as paramedics and fire fighters can’t come to you, arrange a field trip 

to the local fire station, hospital ER room or emergency dispatch centre. 

Activity 2: Create skits using the accident situations. If desired, use poster board to 

create signs to introduce each skit topic: “Cuts,” “Burns,” or “Shock.” Each 

emergency situation will take three to five minutes. Let learners work together to 

voice the accident and steps to be taken to administer basic first aid.  

Activity 3: Copy and paste images from the internet in a new document that 

illustrate what to do in specific first aid scenarios such as fever, chocking or vomiting 

and print them to make a collage.  
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Grade 5: Term 2 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

3-4 Office practice  

 

Reception area 

 

Interpret a basic office floor plan. Grade 5: First year:  

Activity 1: Show an example of a basic floor plan of the classroom including the 

chairs, tables, doors, filing cabinets, printer, computers etc. and help the learner to 

interpret the floor plan. View videos on the internet about how to read a floor plan.  

Activity 2: Match words and pictures of items that make up a floor plan. 

Activity 3: Insert shapes in a new document to create a floor plan of the classroom.  

Grade 5: Second year:  

Activity 1: Show an example of a basic floor plan of the classroom including the 

chairs, tables, doors, filing cabinets, printer, computers etc. and help the learner to 

interpret the floor plan. View videos on the internet about how to read a floor plan.  

Activity 2: Insert a table with 10 rows and 2 columns in a new document. Copy and 

paste images of floor plans from the internet into the table.  

Activity 3: Draw a floor plan with pencil and paper of you room at home, including 

windows, doors and furniture. 

Grade 5: Third year:  

Activity 1: Show an example of a basic floor plan of the classroom including the 

chairs, tables, doors, filing cabinets, printer, computers etc. and help the learner to 

interpret the floor plan. View videos on the internet about how to read a floor plan.  

Activity 2: Design a floor plan of your room using shapes cut out from cardboard 

and different materials. Show and tell your floor plan to the class.  

Activity 3: Insert shapes in a new document to create a floor plan of the school.  
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Grade 5: Term 2 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Computer 

application  

 

Word processing 

and editing 

Business 

documents 

 

 

 

Demonstrate how to insert a picture or clip 

art.  

 

 

Teacher’s note: Activities and screenshots taken from the free website: 

http://www.gcflearnfree.org/word2010/16 

Grade 5: First and Second year:  

Activity 1: Inserting clip art and picture:  

To locate clip art: 

Select the Insert tab. 

Click the Clip Art command in 

the Illustrations group. 

The clip art options appear in the task 

pane to the right of the document. 

Enter keywords in the Search for: field 

that are related to the image you want to 

insert. 

Click the drop-down arrow in the Results 

should be: field. 

Deselect any types of media you do not 

want to see. 

 

If you also want to search for clip art on Office.com, place a check mark 

next to Include Office.com content. Otherwise, it will just search for clip art 

on your computer. 



 

2018   CAPS GRADE R-5 FOR LEARNERS WITH SEVERE INTELLECTUAL DISABILITY                                                             Page 173 

Grade 5: Term 2 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Click Go. 

 

To insert clip art: 

Review the results from a clip art search. 

Place your insertion point in the document 

where you want to insert the clip art. 

Click an image in the Clip Art pane. It will 

appear in the document. 

You can also click the drop-down arrow next 

to the image in the Clip Art pane to view more 

options. 

 

 

Activity 2: Insert a picture from a file: 

Place your insertion point where you want the 

image to appear. 

Select the Insert tab. 

Click the Picture command in the Illustrations group. The Insert Picture 

dialog box appears. 
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Grade 5: Term 2 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

 

Select the desired image file, and then click Insert to add it to your 

document. 

 

To resize an image, click and drag one of 

the corner sizing handles. The image 

will change size while keeping the same 

proportions. If you want to stretch it 

horizontally or vertically, you can use 

the side sizing handles. 

 

Activity 3:  Change the text wrapping 

setting: When you insert clip art or a picture from a file, you may notice that it's 

difficult to move it exactly where you want. This is because the text wrapping for 

the image is set to In Line with Text. You'll need to change the text wrapping 

setting if you want to move the image freely, or if you just want the text to wrap 

around the image in a more natural way. 

To wrap text around an image: 
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Grade 5: Term 2 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Select the image. 

The Format tab will appear. 

Click the Format tab. 

Click the Wrap Text command in 

the Arrange group. 

Select the desired menu option. 

The text will adjust based on the 

option you have selected. 

Move the image around to see 

how the text wraps for each 

setting. 

 

 

Grade 5: Third year: 

Activity 1:  

Create a new Word document. 

Insert a clip art image. 

Insert a picture from a file into the document. 

Resize the picture. 

Change the text wrapping setting to In Front of Text. 

Client services 

and 

communication  

 

Identify, point out or name potential hazards 

in the office environment.  

 

Grade 5: First year:  

Activity 1: Participate in a discussion about potential hazards in the workplace. 

Create a PowerPoint Presentation illustrating one potential hazard and how it can 

be removed or reduced.  
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Grade 5: Term 2 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Office first aid 

 

 

Activity 2: Search the internet for companies that work with dangerous 

substances. Discuss what procedures and policies they follow when working with 

these dangerous substances. List key words on the board.  

Activity 3: Create a PowerPoint Presentation using pictures and words 

illustrating protective clothing to be worn in certain jobs.   

Grade 5: Second year:  

Activity 1: Identify any potential hazards by inspecting your working area, for e.g. 

in the office or the reception area. Write a brief report on your findings. The report 

must include the potential hazards and how the hazards can be removed or 

reduced. 

Activity 2: Create a PowerPoint Presentation using pictures and words 

illustrating dangerous substances in certain working environments.   

Activity 3: Insert a table with 5 rows and 5 columns in a new document. Choose 

5 jobs where people wear protective clothing and write the names in the first 

column. Insert a picture to illustrate the job in the second column. Write a word to 

describe the type of protective clothing required by each job in fourth column. 

Write one word to describe why this clothing is required in the last column. 

Grade 5: Third year:  

Activity 1: Open a new spreadsheet document. List potential hazards in column 

A and pictures of the hazards in column B.  

Activity 2: Set up a code of conduct for working with dangerous substances. 

Activity 3: Search the internet for videos about safety, health and environmental 

instructions regarding lifting and handling of materials to avoid injuries. Illustrate 

how to lift heavy equipment by inserting a flow chart or SmartArt.  
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Grade 5: Term 2 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

5-6 Office practice  

 

Reception area 

 

Understand what furniture is used in an 

office environment. 

Grade 5: First year:  

Activity 1: Participate in a discussion about the types of furniture used in an office. 

Cut and paste images from brochures to illustrate office furniture on a worksheet.  

Activity 2: Insert a table with 3 rows 3 columns in a new document. Copy and paste 

images of office furniture from the internet to make a display.  

Activity 3: View videos on the internet about ergonomically designed furniture. 

Participate in a discussion about what was learned.  

Grade 5: Second year:  

Activity 1: Use office furniture brochures to identify, point out or name different types 

of furniture. Cut and paste pictures from the brochures to make a collage about office 

furniture.  

Activity 2: Insert a table with 6 rows 3 columns in a new document. Copy and paste 

images of office furniture from the internet to make a display.  

Activity 3: Participate in a discussion about ergonomically designed furniture. Copy 

and paste images to illustrate ergonomically designed furniture from the internet in a 

new document.  

 

Grade 5: Third year:  

Activity 1: Create a check list of types of furniture that can be found in an office. Go 

to the administration office and check what furniture is used there. 

Activity 2: Design a pamphlet in a new document using different fonts and colours to 

advertise a piece of office furniture.  

Activity 3: Choose one piece of ergonomically designed furniture and copy a picture 

of it in a new document. Write a few sentences to explain how and why it works. 

Present it to the class.  
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Grade 5: Term 2 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Computer 

application  

 

Word processing 

and editing 

Business 

documents 

 

 

 

Demonstrate the use of text boxes and 

WordArt and their effects. 

 

 

Teacher’s note: Activities and screenshots taken from the free 

website: 

http://www.gcflearnfree.org/office2010/word2010/15 

Grade 5: First year: 

Activity 1: Insert a text box: 

Select the Insert tab on the Ribbon. 

Click the Text Box command in the Text group. A drop-down menu will 

appear. 

Select Draw Text Box. 

Click and drag on the document to create the text box. 

 

You can now start typing to create text inside the text 

box. 

From the drop-down menu, you can also select one of 

the built-in text boxes that have predefined colours, 

fonts, positions, and sizes. If you choose this option, the 

text box will appear automatically so you will not need to 

click and drag to draw it. 
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Grade 5: Term 2 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

  

To move a text box: 

Click the text box. 

Hover the mouse over one of the 

edges of the text box. The mouse 

pointer becomes a cross with 

arrows on each end . 

Click and drag the text box to the 

desired location on the page. 

 

To resize a text box: 

Click the text box. 

Click and drag one of the sizing handles on the 

corners or sides of the text box until it is the 

desired size. 

If you drag the sizing handles on any of the four 

corners, you will be able to change 
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Grade 5: Term 2 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

the height andwidth at the same time. The sizing handles on the top or bottom 

of the text box will only allow you to resize vertically, while the handles on the 

left and right sides will resize the text box horizontally. 

 

Activity 2: Changing a text box's shape: 

Select the text box. A new Format tab appears with Drawing Tools. 

Go to the Format tab. 

Click the Edit Shape command. 

 

Click Change Shape to display a drop-down list. 
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Grade 5: Term 2 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Select the desired shape from the list. 

To choose a shape style: 

Choosing a shape style allows you to apply a preset fill and outline 

colour, and in some cases other effects such as bevelling and shadow. 

You don't have to pick a style for your text box, but it can help you save 

time or experiment with different appearances. 

Select the text box. The Format tab appears. 

Select the Format tab. 

Click the More drop-down arrow in 

the Shape Styles group to display 

more style options. 

 

Hover your mouse over the styles 

to see a live preview. 

Select the desired style. 

 

To change shape fill: 

Select the text box. The Format tab 

appears. 

Click the Format tab. 

Click the Shape Fill command to display 

a drop-down menu. 

From the drop-down menu, you can 

select a colour from the list, choose No 

Fill, or select More Fill   Colours to use 
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Grade 5: Term 2 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

a colour that's not on the list. 

 

Activity 3: To change the shape outline: 

Select the text box. The Format tab appears. 

Click the Shape Outline command to 

display a drop-down list. 

Select a colour from the list, 

choose No Outline, or select More 

Outline Colours to use a colour that's 

not on the list. 

From the drop-down menu, you can 

change the 

outline colour, weight (thickness), and 

whether it is a dashed line. 

 

To change shadow effects: 

Select the text box. The Format tab 

appears. 

Select the Format tab. 

Click the Shape Effects command. 

Click Shadow. 

Move your mouse over the menu 

options to see a live preview in your 

document. 
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Grade 5: Term 2 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Click the desired option to select the shadow effect. 

To choose a different shadow colour for your shape, select Shadow 

Options from the drop-down menu, then click the Colour button. 

 

Grade 5: Second year:  

Activity 1: 3D effects: To use 3-D Rotation: 

Select the text box. 

Select the Format tab. 

Click Shape Effects from the Shape Styles group. 

Hover your mouse over 3-D Rotation. A drop-down menu will appear. 

 

Select the desired rotation preset from the drop-down menu. You can 

also click 3-D Rotation Options if you would prefer to type custom 

values. 



 

2018   CAPS GRADE R-5 FOR LEARNERS WITH SEVERE INTELLECTUAL DISABILITY                                                             Page 184 

Grade 5: Term 2 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

 

Activity 2: To use bevel: 

Select the text box. 

Select the Format tab. 

Click Shape Effects from the Shape Styles group. 

Hover your mouse over Bevel. A drop-down menu will appear. 

 

Select the desired bevel preset from the drop-down menu. You can also click 3-

D Options if you would prefer to type custom values. 

Activity 3: If you click 3-D Options, you'll also be able to change the 
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Grade 5: Term 2 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

shape's Material to give it a metal, plastic, or translucent appearance, and you 

can choose the Lighting type to change how the shape is illuminated. 

 

 

Grade 5: Third year: 

Activity 1: Creating WordArt: 

In addition to adding effects to a text box, you can add effects to the text inside 

the text box, which is known as WordArt. For the most part, the types of 

effects you can add are the same as the ones you can add to shapes or text 

boxes (shadow, bevel, etc.). 

However, you can 

also Transform the text to give it a 

wavy, slanted, or inflated look. 

To apply a quick style to text: 

A quick style will automatically apply 

several effects to your text at once. 

You can then refine the look of your 

text by adding or modifying text 

effects. 
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Grade 5: Term 2 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Select the text box, or select some text inside of the text box. 

The Format tab will appear. 

Click the Format tab. 

Click the Quick Styles command in the WordArt Styles group. A drop-

down menu will appear. 

Select the desired style preset to apply the style to your text. 

After you have applied a quick style, you can still modify the font or font 

colour from the Home tab if you want. 

 

Activity 2: To convert regular text into WordArt:  

For text to be formatted as WordArt, it needs to be inside of a text box. However, 

there's a shortcut that allows you to convert text into WordArt even if it's not in a 

text box. 

Select the text you want to convert. 

Click the Insert tab. 

Click the WordArt command. The Quick Styles drop-down menu will 

appear. 

 

Select the desired quick style. 

Word will automatically create a text box for your text and apply the style 

to the text. 
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Grade 5: Term 2 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

 

Some effects, such as shadows, can be 

added from the Text Effects menu in 

the Home tab. When you add effects in this 

way, it will not place the text in a text box. 

 

Activity 3: To add or modify text effects: 

Select the text box, or select some text inside of the text box. 

The Format tab will appear. 

Click the Format tab. 

Click the Text Effects command in the WordArt Styles group. A drop-

down menu will appear, showing the different effect categories. 

 

Hover over an effect category. A drop-down menu will appear. You can 

hover the mouse over the different presets to see a live preview. 
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Grade 5: Term 2 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

 

Select the desired effect preset. The effect will be applied to your text. If 

you want, you can combine several effects. 

 

 

Challenge 

Create a new document. 

Insert a text box. 

Enter some text into the text box. 

Move the text box to the desired location. 

Change the outline of the text box to a different colour. 

Change the fill colour of the text box. 

Add some WordArt effects to the text. 

Client services 

and 

communication  

 

Understand the need to be punctual at 

work, the smoking policy and good listening 

skills.  

   

Grade 5: First year:  

Activity 1: Participate in a discussion about the importance of being punctual for 

work or school. Explain the reasons why it is important to be on time for school or 

work. What effect does it have on the business or the classroom if you are late? 
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Grade 5: Term 2 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Workplace 

etiquette 

Write key words on the board.  

Activity 2: Search the internet for facts and figures regarding smoking. Share the 

information you researched in groups.  

Activity 3: Participate in a discussion about the importance of having good listening 

skills in an office or school environment. Write key words on the board.  

Teacher’s note: Follow the link to the following free website and learn more about 

listening skills:  

http://www.gcflearnfree.org/jobsuccess/8  

Grade 5: Second year:  

Activity 1: Brainstorm ideas about why people are often late or absent. Are these 

reasons valid? Write 5 sentences in a new document describing the reasons for 

being late or absent.  

Activity 2: Search the internet for facts and figures regarding smoking. Copy and 

paste words and pictures from the internet in a new document to illustrate the facts 

about smoking 

Activity 3: List examples of bad listening habits in a new document and discuss the 

negative influence these habits can have on a work environment.  

Grade 5: Third year:  

Activity 1: How can you change your personal habits to ensure that you are 

punctual for work or school? Create a PowerPoint Presentation using pictures and 

words to illustrate your answer.  

Activity 2: Describe the regulations regarding smoking in a workplace from the 

smoking policy example handed out by the teacher. 

Activity 3: Illustrate good listening habits in a new PowerPoint Presentation using 

words and pictures. Search the internet to find ideas of good listening habits.  
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Grade 5: Term 2 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

 

7-8 Office practice  

 

Reception area 

 

Understand why office cleanliness is 

important. 

Grade 5: First year:  

Activity 1: Participate in a discussion about the importance of a clean and tidy 

appearance in an office or reception area. Write key words on the board.  

Activity 2: List equipment needed for keeping the office clean and tidy in a new 

document. Cut and paste pictures from magazines of the equipment on a worksheet.  

Activity 3: Compile a check list regarding office cleanliness and inspect the school 

office area’s cleanliness.  

Grade 5: Second year:  

Activity 1: Participate in a discussion about the importance of a clean and tidy 

appearance in an office or reception area. Insert a table in a text document and write 

key words using different font types and sizes.  

Activity 2: Show an example of a duty roster to learners and discuss the importance 

of this in order to maintain a neat and tidy office or reception area. Design a duty 

roster for cleaning the classroom using a table in a new document.  

Activity 3: Brainstorm ideas about basic housekeeping requirements of a reception 

area and write 10 sentences to read to the class.  

Grade 5: Third year:  

Activity 1: Participate in a discussion about basic housekeeping requirements of a 

reception area. Create a PowerPoint Presentation using pictures and sentences to 

describe basic housekeeping requirements.  

Activity 2: List equipment needed for keeping the office clean and tidy in a new 

document. Cut and paste pictures from the internet of the equipment in a new 

document.  
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Grade 5: Term 2 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Activity 3: Design a duty roster for cleaning an office or reception area. Role-play 

being the manager of the office and explaining to staff how the roster works.  

Computer 

application  

 

Word processing 

and editing 

Business 

documents 

 

 

 

 

 

Demonstrate basic operations with pictures: 

edit a picture. 

 

 

 

Teacher’s note: Activities and screenshots taken from the free website:  

http://www.gcflearnfree.org/office2010/word2010/17 

Grade 5: First year:  

Activity 1: Once you've added pictures to 

your documents, you can format them in 

various ways. To crop an image: 

Select an image. The Format tab will 

appear. 

Select the Format tab. 

Click the Crop command. Black cropping handles appear. 

Click and drag a handle to crop an image. 

Click the Crop command to deselect the crop tool. 

Corner handles will allow you to simultaneously crop the image horizontally 

and vertically. 

Activity 2:To crop an image to a 

shape: 

Select the image. The Format tab 

will appear. 

Select the Format tab. 



 

2018   CAPS GRADE R-5 FOR LEARNERS WITH SEVERE INTELLECTUAL DISABILITY                                                             Page 192 

Grade 5: Term 2 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Click the Crop drop-down arrow (below the Crop command). A drop-down 

menu will appear. 

Select a shape from the drop-down menu. 

The image will take the shape you have selected. 
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Grade 5: Term 2 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

You may want to crop the image to the desired size before cropping it to a 

shape. 

  

Activity 3: To make image corrections: 

Select the image. The Format tab will 

appear. 

Click the Format tab. 

Click the Corrections command. A 

drop-down menu will appear. 

To sharpen or soften the image, hover 

over the Sharpen and Soften presets. 

You'll see a live preview of the preset in 

the document. 

When you've found a preset you like, click it to select it. 

Click the Corrections command again. 

Hover over the Brightness and Contrast presets to see a live preview. 

When you've found one you like, click it to select it. 

You can also select Picture Corrections Options from the drop-down 

menu to refine the settings. 
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Grade 5: Term 2 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Grade 5: Second year: 

Activity 1: To adjust the colour 

in an image: 

Select the image. 

The Format tab will appear. 

Click the Format tab. 

Click the Colour command. A 

drop-down menu will appear. 

From the drop-down menu, you 

can choose a preset from each of the following three categories: 

Colour Saturation: This controls how vivid the colours are in the image. 

Colour Tone: This controls the temperature of the colour, 

from cool to warm. 

Recolour: This controls the overall colour of the image. Use this option to 

make the image black and white or gray scale, or to colourize it with a 

different colour. 

You can also select Picture Colour Options from the drop-down menu to 

refine the settings. 

Activity 2: Artistic effects and 

styles: 

Select the picture. The Format tab 

will appear. 

Click the Format tab. 
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Grade 5: Term 2 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Click the Artistic Effects command. A drop-down menu will appear. 

Hover over the different presets to see a live preview of each one. 

When you've found a preset you like, click it to select it. 

To adjust the settings for the effect, click Artistic Effects again, and then 

select Artistic Effect Options. 

Many clip art images do not allow you apply artistic effects. Generally 

speaking, the ones that look hand-drawn or painted do not work, while 

photographs do. 

Activity 3: To apply a picture style: 

Select the picture. The Format tab will appear. 

Select the Format tab. 

Click the More drop-down arrow to display all of the picture styles. 

 

Hover over a picture style to display a live preview of the style in the 

document. 

Select the desired style. 

 

To refine the picture style, click the Picture Effects command 

to see the Effects drop-down menu.  
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Grade 5: Term 2 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

 

 

Grade 5: Third year:  

Activity 1: Removing the background from an image:  

Removing the background from an image can give your images a cleaner appearance. 

If you're printing your document, it can also save ink. 

 

 



 

2018   CAPS GRADE R-5 FOR LEARNERS WITH SEVERE INTELLECTUAL DISABILITY                                                             Page 197 

Grade 5: Term 2 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Click the image. The Format tab will appear. 

Click the Format tab. 

Click the Remove Background command. 

 

Word will try to guess which part of the image is the 

background, and it will mark the area with a magenta fill. It 

will also place a box around the image with selection 

handles. 

 

Drag the selection handles until the entire foreground is 

inside the box. After you do this, Word may readjust the background. 
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Grade 5: Term 2 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

At this point, you may need to help Word decide which parts of the 

image are foreground and which parts are background. You can do 

this by using the Mark Areas to Keep and Mark Areas to 

Remove commands. 

If Word has marked part of the foreground magenta, 

click Mark Areas to Keep and draw a line in that region of 

the image. 

If part of the background has not been marked with 

magenta, click Mark Areas to Remove and draw a line in that region of 

the image. 

 

After you add your marks, Word will readjust the image. 

 

When you're satisfied with the image, click Keep 

Changes. All of the magenta areas will be removed from 

the image. 

 

You can adjust the image at any time by clicking 

the Remove Background command again. 

As with artistic effects, Background Removal will not work 

with some clip art images. 

 

Create a new document. 

Insert an image from a file. 

Resize the image. 
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Grade 5: Term 2 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Crop the image. 

Remove the background from the image. 

Experiment with different image corrections and colour settings. 

Add an artistic effect to the image. 

Compress the image. Save the document. 

Client services 

and 

communication 

 

Workplace 

etiquette 

Understand the need for a positive attitude 

to work, to keep your colleagues informed 

about work activities and code of conduct in 

the workplace.  

 

Grade 5: First year:  

Activity 1: Participate in a discussion about the meaning of a positive attitude to 

work or school. What qualities can you see in a person who has a positive attitude? 

List key words on the board.  

Activity 2: Participate in a discussion about the importance of keeping your 

colleagues informed about your work activities and progress. Is it important? List 

reasons on the board. 

Activity 3: Participate in a discussion about why institutions have a code of conduct. 

Give examples of the principles contained in a code of conduct. List key words on 

the board.  

Grade 5: Second year:  

Activity 1: Describe the effect of positive and negative behaviour on people in the 

workplace. Write sentences in a new document to illustrate your answer.  

Activity 2: Use role-play to illustrate how you would give your colleague feedback on 

how your work is progressing and what you plan to do the following week for e.g. do 

you have a day’s leave, you are going for an operation etc.  

Activity 3: : Does your school have a code of conduct? Give each learner a copy 

and discuss in pairs. 

Grade 5: Third year:  
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Grade 5: Term 2 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Activity 1: Discuss in groups if you think it is possible that a person with a negative 

attitude can change? Give examples of how this can be done and present it to the 

class.  

Activity 2: Discuss the impact of the following examples on your work or school 

environment: 

-You have to hand in a project, but one group member is absent and your project is 

incomplete.  

-You have to make a speech in front of the staff/ learners, but the person who was 

supposed to help is late. 

- The class is writing an exam, but the teacher locked the door and learners cannot 

start on time.  

Activity 3: Set up a code of conduct for your imaginary work place. Use a new 

document and write 10 sentences to illustrate important principles for staff conduct.  

9 Fun activities Search the internet to find videos and play 

games.  

 

Grade 5: First, Second and Third year:  

Open the web browser and explore the following websites:  

Activity 1: www.colgate.com 

Activity 2: literacycenter.net 

Activity 3: top 10 preschool websites 

 

FORMAL ASSESSMENT TASK: GRADE 5:  

Assessment is formally recorded during four (4) practical sessions with a minimum of four (4) skills reported. Learners, regardless of abilities, shall be assessed 

on the same skill. The following serves as suggestion of skills to record and report on. 

 

GRADE 5: FIRST YEAR: TERM 2  
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Week 1-2: 

Search the internet for different types of office layouts.  

Choose one type of office layout and design it using SmartArt. 

Choose one of the office layouts and design your own office on paper using pencil and ruler. 

Insert a shape and format it by changing its fill colour, outline colour, shape style, and shadow effects. 

Practice to resize a shape. 

Change the order of shapes. 

Participate in a discussion about possible first aid scenarios that can happen in an office environment and how to treat them. View videos on the internet 

about basic first aid procedures.  

Identify, name and list equipment needed to clean cuts and scratches. Demonstrate how to clean cuts and scratches in pairs. 

Create a PowerPoint Presentation using pictures and words to illustrate basic first aid procedure for an injury of your choice. Present it to the class. 

Week 3-4: 

Show an example of a basic floor plan of the classroom including the chairs, tables, doors, filing cabinets, printer, computers etc. and help the learner to 

interpret the floor plan. View videos on the internet about how to read a floor plan. 

Match words and pictures of items that make up a floor plan. 

Insert shapes in a new document to create a floor plan of the classroom. 

Insert clip art and a picture. 

Insert a picture from a file. 

Change the text wrapping setting. 

Participate in a discussion about potential hazards in the workplace. Create a PowerPoint Presentation illustrating one potential hazard and how it can be 

removed or reduced.  

Search the internet for companies that work with dangerous substances. Discuss what procedures and policies they follow when working with these 

dangerous substances. List key words on the board.  

Create a PowerPoint Presentation using pictures and words illustrating protective clothing to be worn in certain jobs.   

Identify any potential hazards by inspecting your working area, for e.g. in the office or the reception area. Write a brief report on your findings. The report 

must include the potential hazards and how the hazards can be removed or reduced. 

Create a PowerPoint Presentation using pictures and words illustrating dangerous substances in certain working environments.   
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Insert a table with 5 rows and 5 columns in a new document. Choose 5 jobs where people wear protective clothing and write the names in the first column. 

Insert a picture to illustrate the job in the second column. Write a word to describe the type of protective clothing required by each job in fourth column. Write 

one word to describe why this clothing is required in the last column. 

Week 5-6:  

Participate in a discussion about the types of furniture used in an office. Cut and paste images from brochures to illustrate office furniture on a worksheet. 

Insert a table with 3 rows 3 columns in a new document. Copy and paste images of office furniture from the internet to make a display.  

View videos on the internet about ergonomically designed furniture.  

Insert a text box. 

Change a text box's shape. 

Change the shape outline. 

Participate in a discussion about the importance of being punctual for work or school. Explain the reasons why it is important to be on time for school or work. 

What effect does it have on the business or the classroom if you are late? Write key words on the board.  

Search the internet for facts and figures regarding smoking. Share the information you researched in groups.  

Participate in a discussion about the importance of having good listening skills in an office or school environment. Write key words on the board.  

Week 7-8: 

Participate in a discussion about the importance of a clean and tidy appearance in an office or reception area. Write key words on the board.  

List equipment needed for keeping the office clean and tidy in a new document. Cut and paste pictures from magazines of the equipment on a worksheet. 

Compile a check list regarding office cleanliness and inspect the school office area’s cleanliness.  

Crop an image. 

Crop an image to a shape. 

Make image corrections. 

Participate in a discussion about the meaning of a positive attitude to work or school. What qualities can you see in a person who has a positive attitude? List 

key words on the board.  

Participate in a discussion about the importance of keeping your colleagues informed about your work activities and progress. Is it important? List reasons on 

the board. 

Participate in a discussion about why institutions have a code of conduct. Give examples of the principles contained in a code of conduct. List key words on 

the board.  
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GRADE 5: SECOND YEAR: TERM 2  

Week 1-2: 

Search the internet for different types of office layouts. Write key words on the board.    

Choose one type of office layout and design it using SmartArt. 

Copy and paste pictures from the internet in a text document to illustrate different office layouts.  

Change to a different shape. 

Change the shape style. 

Change the shapes fill colour. 

Participate in a discussion on what to do if a person’s nose bleeds. Role-play first aid procedure for when you have to stop a nose bleed.   

View videos on the internet about treating bruising and sprains. Demonstrate, in groups, how to treat bruising and sprains.  

View videos on the internet about what to do when a person faints and role-play procedures to be followed in this scenario. 

Week 3-4: 

Show an example of a basic floor plan of the classroom including the chairs, tables, doors, filing cabinets, printer, computers etc. and help the learner to interpret 

the floor plan. View videos on the internet about how to read a floor plan. 

Insert a table with 10 rows and 2 columns in a new document. Copy and paste images of floor plans from the internet into the table.  

Draw a floor plan with pencil and paper of you room at home, including windows, doors and furniture 

Insert clip art and a picture. 

Insert a picture from a file. 

Change the text wrapping setting. 

Open a new spreadsheet document. List potential hazards in column A and pictures of the hazards in column B.  

Set up a code of conduct for working with dangerous substances. 

Search the internet for videos about safety, health and environmental instructions regarding lifting and handling of materials to avoid injuries. Illustrate how to lift 

heavy equipment by inserting a flow chart or SmartArt. 

Week 5-6: 

Use office furniture brochures to identify, point out or name different types of furniture. Cut and paste pictures from the brochures to make a collage about office 

furniture.  
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Insert a table with 6 rows 3 columns in a new document. Copy and paste images of office furniture from the internet to make a display.  

Participate in a discussion about ergonomically designed furniture. Copy and paste images to illustrate ergonomically designed furniture from the internet in a new 

document.  

Use 3D rotation. 

Use bevel. 

Change shape material. 

Brainstorm ideas about why people are often late or absent. Are these reasons valid? Write 5 sentences in a new document describing the reasons for being late 

or absent.  

Search the internet for facts and figures regarding smoking. Copy and paste words and pictures from the internet in a new document to illustrate the facts about 

smoking. 

List examples of bad listening habits in a new document and discuss the negative influence these habits can have on a work environment.  

Week 7-8: 

Participate in a discussion about the importance of a clean and tidy appearance in an office or reception area. Insert a table in a text document and write key 

words using different font types and sizes.  

Show an example of a duty roster to learners and discuss the importance of this in order to maintain a neat and tidy office or reception area. Design a duty roster 

for cleaning the classroom using a table in a new document.  

Brainstorm ideas about basic housekeeping requirements of a reception area and write 10 sentences to read to the class.  

Adjust the colour in an image. 

Use artistic effects and styles. 

Apply a picture style. 

Describe the effect of positive and negative behaviour on people in the workplace. Write sentences in a new document to illustrate your answer.  

Use role-play to illustrate how you would give your colleague feedback on how your work is progressing and what you plan to do the following week for e.g. do 

you have a day’s leave, you are going for an operation etc.  

Does your school have a code of conduct? Give each learner a copy and discuss in pairs. 

GRADE 5: THIRD  YEAR: TERM 2  

Week 1-2: 

Search the internet for different types of office layouts. Create a table in a text document and list key words. 
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Choose one type of office layout and design the layout using SmartArt. 

Create a PowerPoint Presentation and use pictures and words to illustrate one type of office layout. 

Change the shape outline. 

Change shadow effects. 

Use 3D effects. 

Invite the school nurse, a paramedic, fire fighter, emergency room doctor or nurse to speak briefly and explain his or her first aid supplies. If emergency personnel 

such as paramedics and fire fighters can’t come to you, arrange a field trip to the local fire station, hospital ER room or emergency dispatch centre. 

Create skits using the accident situations. If desired, use poster board to create signs to introduce each skit topic: “Cuts,” “Burns,” or “Shock.” Each emergency 

situation will take three to five minutes. Let learners work together to voice the accident and steps to be taken to administer basic first aid.  

Copy and paste images from the internet in a new document that illustrate what to do in specific first aid scenarios such as fever, chocking or vomiting and print 

them to make a collage. 

Week 3-4: 

Show an example of a basic floor plan of the classroom including the chairs, tables, doors, filing cabinets, printer, computers etc. and help the learner to interpret 

the floor plan. View videos on the internet about how to read a floor plan. 

Design a floor plan of your room using shapes cut out from cardboard and different materials. Show and tell your floor plan to the class.  

Insert shapes in a new document to create a floor plan of the school. 

Insert clip art challenge. 

Week 5-6: 

Create a check list of types of furniture that can be found in an office. Go to the administration office and check what furniture is used there. 

Design a pamphlet in a new document using different fonts and colours to advertise a piece of office furniture.  

Choose one piece of ergonomically designed furniture and copy a picture of it in a new document. Write a few sentences to explain how and why it works. Present 

it to the class. 

Create WordArt. 

Convert regular text into WordArt. 

Add or modify text effects. 

Create a PowerPoint Presentation using pictures and words to illustrate how your personal habits ensure that you are punctual for work or school. 

Describe the regulations regarding smoking in a workplace from the smoking policy example handed out by the teacher. 
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Illustrate good listening habits in a new PowerPoint Presentation using words and pictures. Search the internet to find ideas of good listening habits. 

Week 7-8:  

Participate in a discussion about basic housekeeping requirements of a reception area. Create a PowerPoint Presentation using pictures and sentences to 

describe basic housekeeping requirements.  

List equipment needed for keeping the office clean and tidy in a new document. Cut and paste pictures from the internet of the equipment in a new document.  

Design a duty roster for cleaning an office or reception area. Role-play being the manager of the office and explaining to staff how the roster works. 

Remove the background from an image. 

Format picture challenge. 

Discuss in groups if you think it is possible that a person with a negative attitude can change? Give examples of how this can be done and present it to the class.  

Discuss the impact of the following examples on your work or school environment. 

Set up a code of conduct for your imaginary work place. Use a new document and write 10 sentences to illustrate important principles for staff conduct. 
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3.2.7 Grade 5: 1st, 2nd and 3rd year Term 3 

 

Grade 5: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

1-2 Office practice  

 

Office 

equipment and 

mailing systems 

Understand basic principles of mailing 

systems.  

Grade 5: First year:  

Activity 1: Participate in a discussion about the postal service and what they are 

used for and why. Can you think of other agencies that are used for this purpose? 

Write key words on the board.  

Activity 2: Visit the local post office to learn about receiving, distributing, sorting 

and dispatching mail. 

Activity 3: Find out what equipment is used in a mailroom. Copy and paste pictures 

of the equipment in a new document. 

Grade 5: Second year:  

Activity 1: Organise a visit to the office block and find out how the school deals with 

incoming mail. Is it stamped and registered? List the procedures for incoming mail in 

a new document.  

Activity 2: Visit the SA Post office website. Work in groups and discuss what it 

means when mail is marked as follows: 

-fastmail 

-personal 

-high priority 

-promotional material 

Give feedback to the class after discussion.  

Activity 3: Search the internet and list procedures for sorting and opening incoming 

mail in a new document using sentences.  

Grade 5: Third year:  



 

2018   CAPS GRADE R-5 FOR LEARNERS WITH SEVERE INTELLECTUAL DISABILITY                                                             Page 208 

Grade 5: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Activity 1: Identify and name safety procedures for handling mail.  

Activity 2: Participate in a discussion about suspect letters or parcels. List the 

possible features of suspicious mail on the board. 

Activity 3: Use role-play to illustrate what to do or not to do when faced with a 

suspect letter or parcel.  

Computer 

application  

 

Word processing 

and editing 

Business 

documents 

 

 

 

Demonstrate basic formatting features on 

the computer: type a paragraph using 

bullets and numbering. 

 

. 

 

Grade 5: First year:  

Activity 1: Show learners a variety of paragraphs available, without and with 

headings. Search the internet for more examples.  

Activity 2: Use exercises from workbooks or prepared examples and copy 2 

paragraphs correctly using capitol letters and punctuation marks. 

Activity 3: Practice typing 5 paragraphs without headings and 5 paragraphs with 

headings from text books.  

Grade 5: Second year:  

Activity 1: Practical demonstration by teacher on how to insert bullets and 

numbering before a word / sentence / paragraph. Practice typing words by inserting 

different types of bullets or numbering.  

Activity 2: Open a new document and type personal information for e.g. name and 

surname, age, teacher, address etc. and then add different types of bullets to the 

text. 

Activity 3: Use exercises from workbooks or prepared examples to type sentences 

and inserting bullets or numbering. 

Grade 5: Third year:  

Activity 1: Practical demonstration by teacher on how to insert bullets and 

numbering before a word / sentence / paragraph. Practice typing words by inserting 
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Grade 5: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

different types of bullets or numbering.  

Activity 2: Use exercises from workbooks or prepared examples to type sentences 

and inserting bullets or numbering. 

Activity 3: Give a prepared page to learners in hard copy.  Learners copy the page 

in a new document and practice to use different bullets and numbering. View the 

document on completion. 

Client services 

and 

communication  

 

Personal 

finance 

Differentiate between “needs” and wants” 

concerning personal finance.  

   

Grade 5: First year:  

Activity 1: Participate in a discussion about having “needs” and “wants” and the 

difference between them. List ideas on the board. 

Activity 2: The teacher makes index cards with different “needs” and “wants” 

written on them. Each learner draws a card and explains in what category his card 

falls and why.   

Activity 3: Copy and paste pictures from the internet in a new document to illustrate 

“needs” or “wants” and present it to the class.  

Grade 5: Second year:  

Activity 1: Participate in a discussion about having “needs” and “wants” and the 

difference between them. List ideas on the board. 

Activity 2: Each learner writes down the name of a “need” and a “want”. Put all the 

words in a bag and allow each learner to draw a word. Take turns to draw a word 

and tell the class if the word is a “need” or “want” and explain why. 

Activity 3: Learners practice AutoSum in a spreadsheet by listing basic needs in 

column A and the price in column B. Use AutoSum to get the total. 

Grade 5: Third year:  

Activity 1: View videos on the internet about “needs vs. wants PowerPoint 
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Grade 5: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Presentations”. Class discussion to follow after watching the presentations on what 

was learned. 

Activity 2: Create a PowerPoint Presentation and use pictures and words to 

illustrate “needs” and “wants”.  

Activity 3: Give the learner a “salary” of R 1000 (play money). Ask him to “buy” 

needs and wants out of advertisements that do not exceed the R1000. Help 

learners who struggle to count to add the amount on a calculator or use a 

spreadsheet to add the total.  

3-4 Office practice  

 

Office 

equipment and 

mailing systems 

Understand basic principles of mailing 

systems. 

Grade 5: First year:  

Activity 1: Participate in a discussion about the causes of delays in distributing 

incoming mail. What effect does this have on the office? 

Activity 2: Find out what equipment is required for outgoing mail. Copy and paste 

pictures of the equipment in a new document. 

Activity 3: Search the internet and list procedures for handling outgoing mail in a 

new document using sentences.  

Grade 5: Second year:  

Activity 1: Show learners an example of how an envelope is addressed. 

Activity 2: Collect a brochure from a PostNet outlet and discuss the services they 

offer.  

Activity 3: Display the following items in the class: a 5kg parcel containing clothes 

and toiletries, a letter to a friend overseas, an expensive piece of jewellery, a book 

etc. Learners each get a turn to tell the class the best way of sending these parcels 

or mail.  

Grade 5: Third year:  
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Grade 5: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Activity 1: Can you name courier services in South Africa? Search the internet and 

find out what services courier companies offer. List key words in a new document.  

Activity 2: What goods are usually sent through couriers? What are the timeframes 

for these couriers? How does it compare to the timeframes of the South African 

postal service? Use brochures or the internet to find answers.   

Activity 3: How do you track a parcel sent trough a postal service? Search the 

internet to find answers and discuss in pairs. Give feedback to the class on how you 

would track your parcel.  

Computer 

application  

 

Word processing 

and editing 

Business 

documents 

 

 

 

Demonstrate basic formatting features on 

the computer: indents and tabs. 

 

 

Teacher’s note: Activities and screenshots taken from the free 

website:  

http://www.gcflearnfree.org/office2010/word2010/8 

Grade 5: First year:  

Indents and tabs are useful tools for making your text more readable. 

Indenting text adds structure to your document by allowing you to 

separate information. Depending on your needs, you can use tabs 

and indents to move a single line or an entire paragraph. 

Activity 1: Indenting text: 

In many types of documents, you may want to indent only the first 

line of each paragraph. This helps to visually separate paragraphs 

from one another. It's also possible to indent every line except the 

first line, which is known as a hanging indent. 
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Grade 5: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

 

 

To indent using the Tab key: 

A quick way to indent is to use 

the Tab key. This will create a first-

line indent of 1/2 inch. 

Place the insertion point at the very 

beginning of the paragraph you want to indent. 

 

Press the Tab key. On the ruler, you should see the first-line indent 

marker move to the right by 1/2 inch. 
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Grade 5: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

If you can't see the ruler, click the View Ruler icon over the scrollbar to 

display it. 

 

Activity 2: To create or adjust a first-line indent or hanging indent: 

Place the insertion point anywhere in the paragraph you want to indent, 

or select one or more paragraphs. 

To adjust the first-line indent, drag the first-line indent marker on the 

ruler 

To adjust the hanging indent, drag the hanging indent marker. 

To move both markers at the same time, drag the left indent marker. 

This will indent all lines in the paragraph. 
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Grade 5: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Activity 3: To use the Indent commands:  

If you want to indent all lines in a 

paragraph, you can use the Indent 

commands on the Home tab. 

Select the text you want to indent. 

Make sure you are on 

the Home tab. 

Click the Increase Indent command to increase the indent by 

increments of 1/2 inch. 

Click the Decrease Indent command to decrease the indent by 

increments of 1/2 inch. 

If you would prefer to type your indent 

amounts, you can use the Indent 

fields on the Page Layout tab. 

 

Grade 5: Second year:  

Activity 1: Tabs are often the best way to control exactly where text is placed. By 

default, each time you press the Tab key, the insertion point will move 1/2 inch to 

the right. By adding tab stops to the ruler, you can change the size of the tabs, and 

you can even have more than one type of alignment in a single line. For example, 

you could left-align the beginning of the line and right-align the end of the line by 

adding a right tab. 
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Grade 5: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

 

Pressing the Tab key can either add a tab or create a first-line indent, 

depending on where the insertion point is. Generally, if the insertion point 

is at the beginning of an existing paragraph it will 

create a first-line indent; otherwise, it will create a tab. 

The tab selector:  

The tab selector is above the vertical ruler on the 

left. Hover over the tab selector to see the name of 

the type of tab stop that is active. 

 

Types of tab stops include: 

Left Tab : Left-aligns the text at the tab stop 

Center Tab : Centers the text around the tab stop 

Right Tab : Right-aligns the text at the tab stop 

Decimal Tab : Aligns decimal numbers using the decimal point 

Bar Tab : Draws a vertical line on the document 

First Line Indent : Inserts the indent marker on the ruler and indents 

the first line of text in a paragraph 
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Grade 5: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Hanging Indent : Inserts the hanging indent marker and indents all 

lines other than the first line 

Although Bar Tab, First Line Indent, and Hanging Indent appear on 

the tab selector, they're not technically tabs. 

Activity 2: To add tab stops: 

Select the paragraph or paragraphs you want to add tab stops to. If you don't 

select any paragraphs, the tab stops will apply to the current paragraph and 

any new paragraphs you type below it. 

Click the tab selector until the tab stop you want to use appears. 

Click the location on the horizontal ruler where you want your text to 

appear (it helps to click the bottom edge of the ruler). You can add as 

many tab stops as you want. 

 

Place the insertion point where you want to add the tab, and then press 

the Tab key. The text will jump to the next tab stop. 
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Grade 5: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

 

To remove a tab stop, drag it off of the Ruler. 

Click the Show/Hide ¶ command 

on the Home tab in 

the Paragraph group. This will 

allow you to see nonprinting 

characters such as the spacebar, 

paragraph (¶), and Tab key 

markings. 



 

2018   CAPS GRADE R-5 FOR LEARNERS WITH SEVERE INTELLECTUAL DISABILITY                                                             Page 218 

Grade 5: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

 

Grade 5: Third year: 

Activity 1: Challenge: 

Open an existing Word document. If you want, you can use 

this example. 

Practice using the Tab key to indent the first line of a paragraph. 

Select some text, and use the Increase Indent and Decrease 

Indent commands to see how they change the text. 

Explore the tab selector and all of the tab stops. Practice using each 

one. 

If you're using the example, add tab stops and tabs in the Work 

History section so all of the jobs line up with the most recent one. 

Client services 

and 

communication  

 

Personal 

finance 

Understand the basic personal financial 

principals of income vs. expenditure for 

example food, shelter, water air, bicycle, 

toys, sweets, bread or clothing. 

 

Grade 5: First year:  

Activity 1: Participate in a discussion about income vs. expenditure. Explain that if 

your income is greater than your expenses, you will have money left over to save, 

spend and share. If your expenses are greater than your income, however, you will 

have to make some changes in order to avoid getting into debt. 

Activity 2: Brainstorm ideas of how to earn extra pocket money as a teenager. List 

http://content.gcflearnfree.org/topics/174/Word2010_IndentsTabs_Practice.docx
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Grade 5: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

ideas in a new document.  

Activity 3: Pretend you want to buy a big item for e.g. a cell phone. Do research to 

find the best deal if you have R500 to spend. Make a presentation showing your 

income and what you will receive for this purchase. 

Grade 5: Second year:  

Activity 1: Participate in a discussion about ways to reduce spending. Write key 

words on the board. Keep track of your expenses for one week by writing it down.  

Activity 2: Play the Grocery Game. Give a fixed amount of money and challenge 

them to purchase as much food as they can at the grocery store. For example, you 

can give them R500 each and a list of food needs. Learners will have to put their 

comparative shopping skills to the test to be able to purchase as much food as they 

can with the limited amount of money. 

Activity 3: View videos on the internet about what a budget is. Create a mind map 

to show what you have learned and present it to the class.  

Grade 5: Third year:  

Activity 1: Participate in a discussion about income vs. expenditure. Explain that if 

your income is greater than your expenses, you will have money left over to save, 

spend and share. If your expenses are greater than your income, however, you will 

have to make some changes in order to avoid getting into debt. 

Activity 2: Play the Grocery Game. Give learners a grocery list and have them 

calculate in a spreadsheet how much everything will cost. Identify places where you 

could save money by buying alternative cheaper items. 

Activity 3: Participate in a discussion about how much money a teenager needs to 

"live" each month. Write responses on the board. Ask learners to identify how they 

spend money (answers may include clothing, entertainment, savings, etc.). Ask 



 

2018   CAPS GRADE R-5 FOR LEARNERS WITH SEVERE INTELLECTUAL DISABILITY                                                             Page 220 

Grade 5: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

learners how they obtain the money they spend. Answers may include allowance 

from parents, chores, jobs, gifts, etc. Rewrite the income and expense items in the 

form of a monthly budget: 

Income  Expenses  

Allowance R200 Entertainment R20 

Dog walking R10 Music R20 

  Snacks R30 

Total income R210 Total 

expenses 

R70 

 

5-6 Office practice  

 

Safety, health 

and 

environmental 

requirements in 

the office 

 

Understand and name unsafe practices, 

hazards and dangerous substances and 

how to reduce or remove them.  

Grade 5: First year:  

Activity 1: Match words and pictures to illustrate unsafe practices in a general 

office environment. 

Activity 2: Participate in a discussion about general safety regulations. Write key 

words on the board.  

Activity 3: Inspect your working area and identify any potential hazards. Discuss 

how these hazards can be removed or reduced.  

Grade 5: Second year:  

Activity 1: Copy and paste pictures in a text document to illustrate unsafe practices 

in a general office environment. 

Activity 2: Search the Internet for a company that deals with dangerous substances 

and find out what its policies and procedures are regarding the handling of 

dangerous substances.  Discuss this in groups. 

Activity 3: Search the internet about instructions relating to exposure to dangerous 

substances and hazards. Write down key words in a text document.  



 

2018   CAPS GRADE R-5 FOR LEARNERS WITH SEVERE INTELLECTUAL DISABILITY                                                             Page 221 

Grade 5: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Grade 5: Third year:  

Activity 1: Create a PowerPoint Presentation and use words and pictures to 

illustrate unsafe practices in a general office environment. 

Activity 2: Do a survey in the office block (use a checklist) and see if it complies 

with general safety regulations.  

Activity 3: Identify potential hazards in the office or reception area of the school.  

Write a brief report on your findings. The report must include the potential hazards 

and how the hazards can be removed or reduced. 

Computer 

application 

 

Word processing 

and editing 

 

 

 Understand the calculator utility.  

 

 

Teacher’s note: Activities and screenshots taken from the website: 

Acthttp://windows.microsoft.com/en-za/windows7/using-calculator-in-

windows-7  

Grade 5: First, Second and Third year:  

Activity 1: Practical demonstration by teacher showing learners where to find the 

calculator functions. (May depend on operating system used). Open Calculator by 

clicking the Start button . In the search box, type Calculator, and then, in the 

list of results, click Calculator. Click the View menu, and then click the mode that 

you want. When you switch modes, the current calculation is cleared. Calculation 

history and numbers stored by the memory keys are retained. Click the calculator 

keys to perform the calculation you want. Show learners basic calculations for 

addition, subtraction, multiplication and division.  

Activity 2: Complete the worksheet by using the calculator to fill in the answers of 

20 basic calculation sums.  

Activity 3: View videos about tricks to learn on the calculator and attempt one. 

Show and tell the class about your trick.  
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Grade 5: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Client services 

and 

communication  

 

 

Personal finance 

 

Demonstrate knowledge of banking 

services regarding accounts, credit card 

facilities and ATM use.  

 

 

Grade 5: First year:  

Activity 1: Participate in a discussion about banks in South Africa. Discuss the 

service that banks provide and list key words on the board.  

Activity 2: List banks in South Africa in a new document using different font and 

sizes and visit their websites.  

Activity 3: Complete the worksheet by identifying parts of the ATM.  

Grade 5: Second year:  

Activity 1: Use brochures from different and discuss the service that banks provide.  

Activity 2: What documentation is needed when one wants to open an account at 

the bank? List the documentation in a new document.  

Activity 3: Once you have opened an account you will receive a bank card. Discuss 

how this card is used and how to withdraw money safely.  

Grade 5: Third year:  

Activity 1: Display examples of deposit slips and cheques in the class and explain 

to learners what these are and how they are used.  

Activity 2: Practice to fill in a deposit slip using examples from various banks.  

Activity 3: Use a worksheet to practice writing a cheque.  

Teacher’s note: Follow the link to the following free website and learn more about 

an ATM:  

http://www.gcflearnfree.org/everydaylife/edlmoney/atm 

7-8 Office practice  

Safety, health 

and 

environmental 

Understand the need for and use of fire 

fighting equipment in the workplace.  

Grade 5: First year:  

Activity 1: Participate in a discussion about fire hazards in the workplace or at 

home. List hazards in a new document using pictures and words. 

Activity 2: Participate in a discussion about why fire equipment should be checked 
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Grade 5: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

requirements in 

the office 

 

and maintained on a regular basis. Create a check list that can be used when 

checking the fire equipment.  

Activity 3: Search the internet to find out about the different types of fire 

extinguishers. Illustrate the different types and where they are used in a new 

document using pictures and words.  

Grade 5: Second year:  

Activity 1: Visit the fire brigade to find out how to use a fire extinguisher in different 

circumstances.  

Activity 2: There are 4 basic steps to follow when using a fire extinguisher. 

Illustrate these in a new document using pictures and words.  

Activity 3: Design a poster to show what steps should be taken once a fire breaks 

out in the office. Work in pairs and explain the steps to your classmate.  

Grade 5: Third year:  

Activity 1: Draw a floor plan of the school indicating where fire extinguishers, fire 

hoses and alarms are located.  

Activity 2: Use role-play to illustrate how you would use a fire extinguisher in case 

of a fire break out.  

Activity 3: Design a fire exit emergency plan for your classroom and discuss how it 

should be followed.  
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Grade 5: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Computer 

application  

 

Word processing 

and editing 

Business 

documents 

 

 

 

Demonstrate the use of the spelling and 

grammar tool. 

 

 

Teacher’s note: Activities and screenshots taken from the free website: 

http://www.gcflearnfree.org/word2010/6  

Grade 5: First year:  

Activity 1: To make your document appear professional, you'll want to make sure it 

is free from spelling and grammar errors. Word has several options for checking 

your spelling. You can run a spelling and grammar check, or you can allow Word to 

check your spelling automatically as you type. 

To run a spelling and grammar check: 

Go to the Review tab. 

Click on the Spelling & Grammar command. 

The Spelling and Grammar dialog box will open. For 

each error in your document, Word will try to offer one 

or more suggestions. You can select a suggestion 

and click Change to correct the error. 

 

If no suggestions are given, you can manually type the correct spelling. 
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Grade 5: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

 

Activity 2: Ignoring "errors": 

  

The spelling and grammar check is not always correct. Particularly with grammar, 

there are many errors Word will not notice. There are also times when the spelling 

and grammar check will say something's an error when it's actually not. This often 

happens with people's names, which may not be in the dictionary. 

If Word says something is an error, you can choose not to change it. Depending on 

whether it's a spelling or grammar error, you can choose from several options:  

For spelling "errors": 

Ignore Once: This will skip the word without changing it. 

Ignore All: This will skip the word without changing it, and it will also skip 

all other instances of this word in the document. 

Add to Dictionary: This adds the word to the dictionary so it will never 

come up as an error. Make sure the word is spelled correctly before 

choosing this option. 
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Grade 5: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

For grammar "errors": 

-Ignore Once: This will skip the "error" without changing it. 

-Ignore Rule: This will skip this "error" and all other instances that relate to 

this grammar rule. 

-Next Sentence: This skips the sentence without changing it and leaves it marked 

as an error. This means it will still show up if you do another spelling and grammar 

check later on. 

If you're not sure about a grammar error, you can click Explain to see why Word 

thinks it's an error. This can help you determine whether you want to change it. 

Activity 3: Automatic spelling and grammar checking:  

By default, Word automatically checks your document for spelling and 

grammar errors, so you may not even need to run a separate spelling and 

grammar check. These errors are indicated by coloured wavy lines. 

The red line indicates a misspelled word. 

The green line indicates a grammatical 

error. 

The blue line indicates a contextual 

spelling error. This feature is turned off by 

default. 

 

A contextual spelling error occurs when the wrong word is used but the 

word is spelled correctly. For example, if you write Deer Mr. Theodore at 

the beginning of a letter, deer is a contextual spelling error 

because dear should have been used. Deer is spelled correctly, but it is 
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Grade 5: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

used incorrectly in this letter. 

To use the spelling check feature: 

Right-click the underlined word. A menu will appear. 

Click the correct spelling of the word from the listed suggestions. 

The corrected word will appear in the document. 

 

You can choose to Ignore an underlined word, add it to the dictionary, or go to 

the Spelling dialog box for more options. 

Grade 5: Second year:  

Activity 1: To use the grammar check feature: 

Right-click the underlined word or phrase. A 

menu will appear. 

Click the correct phrase from the listed 

suggestions. 

The corrected phrase will appear in the 

document. 
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Grade 5: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

 

You can also choose to Ignore an underlined phrase, go to 

the Grammar dialog box, or click About This Sentence for information on 

the grammar rule. 

Activity 2: To change the automatic spelling and grammar check settings: 

From Backstage view, click Options. 

 

Select Proofing. The dialog box gives you several options to choose 

from. 
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Grade 5: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

If you don't want Word to automatically check spelling, 

uncheck Check spelling as you type. 

If you don't want grammar errors to be marked, uncheck Mark 

grammar errors as you type. 

To check for contextual spelling errors, check Use contextual 

spelling. 

 

If you've turned off the automatic spelling and/or grammar checks, you can still 

run a check by going to the Review tab and clicking the Spelling & 

Grammar button. 

Activity 3: To hide spelling and grammar errors in a document:  

If you're sharing a document like a resume with someone, you might not want 

that person to see those annoying red, green, and blue lines. Turning off the 

automatic spelling and grammar checks only applies to your computer, so the 

lines may still show up when someone else views your document. Luckily, you 

can hide spelling and grammar errors in a document so the lines will not show 

up on any computer. 

From Backstage view, click Options. 
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Grade 5: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Select Proofing. 

In the drop-down box next to "Exceptions for:" select the correct 

document (if you have more than 

one document open). 

 

Put a check mark next to Hide 

spelling errors in this 

document only and Hide 

grammar errors in this 

document only. 

Click OK. 

Grade 5: Third year:  

Activity 1: Open an existing Word document prepared by the teacher.  

Correct the spelling errors. 

Correct the grammar errors. 

Client services 

and 

communication  

 

Work ethics 

 

Understand and deal with conflict in the 

office environment.  

 

Teacher’s note: Activities taken from the free website:  

http://www.gcflearnfree.org/jobsuccess/10 

Grade 5: First year: 

Activity 1: Participate in a discussion of what conflict is. What positive and negative 

consequences does conflict have in an office environment? List key words on the 

board.  

Activity 2: Search the internet to find examples of positive and negative methods of 

coping with conflict.  Illustrate you answer in a new document by writing a few 

sentences.  
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Grade 5: Term 3 

WEEK TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Activity 3: Participate in a discussion on the best ways to resolve conflict. Write key 

words on the board.  

Grade 5: Second year:  

Activity 1: Participate in a discussion about factors or behaviour that keeps conflict 

from happening. Type key words in a new document using WordArt. 

Activity 2: Search the internet to find examples of how to confront conflict.  

Illustrate you answer in a new document by writing a few sentences.  

Activity 3: Participate in a discussion on the best ways to resolve conflict. Use role-

play to practice resolving conflict in the best way possible.   

Grade 5: Third year:  

Activity 1: Participate in a discussion about the reasons behind workplace conflict. 

Create a mind map to illustrate the reasons.  

Activity 2: View videos on the internet about conflict management. Class 

discussion to follow after watching the videos on what was learned  

Activity 3: Use the template of the I-statement provided as a method of 

communication that can help you express your feelings in a manner that is 

acceptable.  

9 Fun activities Search the internet to find videos and play 

games.  

 

Grade 5: First, Second and Third year:  

Open the web browser and explore the following websites:  

Activity 1: Click-N-Learn 

Activity 2: www.babble.com/best-recipes 

Activity 3: cool websites for kids 

 

 

http://www.kids-online.net/learn/click/table.html
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FORMAL ASSESSMENT TASK: GRADE 5:  

Assessment is formally recorded during four (4) practical sessions with a minimum of four (4) skills reported. Learners, regardless of abilities, shall be assessed on 

the same skill. The following serves as suggestion of skills to record and report on. 

 

GRADE 5: FIRST YEAR: TERM 3 

Week 1-2: 

Participate in a discussion about the postal service and what they are used for and why. Can you think of other agencies that are used for this purpose? Write key 

words on the board.  

Visit the local post office to learn about receiving, distributing, sorting and dispatching mail. 

Find out what equipment is used in a mailroom. Copy and paste pictures of the equipment in a new document. 

Show learners a variety of paragraphs available, without and with headings. Search the internet for more examples.  

Use exercises from workbooks or prepared examples and copy 2 paragraphs correctly using capitol letters and punctuation marks. 

Practice typing 5 paragraphs without headings and 5 paragraphs with headings from text books. 

Participate in a discussion about having “needs” and “wants” and the difference between them. List ideas on the board. 

The teacher makes index cards with different “needs” and “wants” written on them. Each learner draws a card and explains in what category his card falls and 

why.   

Copy and paste pictures from the internet in a new document to illustrate “needs” or “wants” and present it to the class. 

Week 3-4: 

Participate in a discussion about the causes of delays in distributing incoming mail. What effect does this have on the office? 

Find out what equipment is required for outgoing mail. Copy and paste pictures of the equipment in a new document. 

Search the internet and list procedures for handling outgoing mail in a new document using sentences.  

Practice to indent text. 

Create or adjust a first-line indent or hanging indent. 

Use the indent commands. 

Participate in a discussion about income vs. expenditure. Explain that if your income is greater than your expenses, you will have money left over to save, spend 

and share. If your expenses are greater than your income, however, you will have to make some changes in order to avoid getting into debt. 
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Brainstorm ideas of how to earn extra pocket money as a teenager. List ideas in a new document.  

Pretend you want to buy a big item for e.g. a cell phone. Do research to find the best deal if you have R500 to spend. Make a presentation showing your income 

and what you will receive for this purchase. 

Week 5-6: 

Match words and pictures to illustrate unsafe practices in a general office environment. 

Participate in a discussion about general safety regulations. Write key words on the board. 

Inspect your working area and identify any potential hazards. Discuss how these hazards can be removed or reduced. 

Complete the worksheet by using the calculator to fill in the answers of 20 basic calculation sums.  

View videos about tricks to learn on the calculator and attempt one. Show and tell the class about your trick. 

Participate in a discussion about banks in South Africa. Discuss the service that banks provide and list key words on the board.  

List banks in South Africa in a new document using different font and sizes and visit their websites.  

Complete the worksheet by identifying parts of the ATM.  

Week 7-8: 

Participate in a discussion about fire hazards in the workplace or at home. List hazards in a new document using pictures and words. 

Participate in a discussion about why fire equipment should be checked and maintained on a regular basis. Create a check list that can be used when checking 

the fire equipment.  

Search the internet to find out about the different types of fire extinguishers. Illustrate the different types and where they are used in a new document using 

pictures and words.  

Run a spelling and grammar check. 

How to ignore “errors":  

Use automatic spelling and grammar check. 

Participate in a discussion of what conflict is. What positive and negative consequences does conflict have in an office environment? List key words on the board. 

Search the internet to find examples of positive and negative methods of coping with conflict.  Illustrate you answer in a new document by writing a few sentences.  

Participate in a discussion on the best ways to resolve conflict. Write key words on the board.  

 

 

GRADE 5: SECOND YEAR: TERM 3  
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Week 1-2: 

Organise a visit to the office block and find out how the school deals with incoming mail. Is it stamped and registered? List the procedures for incoming mail in a 

new document.  

Visit the SA Post office website. Work in groups and discuss what it means when mail is marked as follows: 

-fast mail 

-personal 

-high priority 

-promotional material 

Give feedback to the class after discussion.  

Search the internet and list procedures for sorting and opening incoming mail in a new document using sentences.  

Practice typing words by inserting different types of bullets or numbering. 

Open a new document and type personal information for e.g. name and surname, age, teacher, address etc. and then add different types of bullets to the text. 

Use exercises from workbooks or prepared examples to type sentences and inserting bullets or numbering. 

Participate in a discussion about having “needs” and “wants” and the difference between them. List ideas on the board. 

Each learner writes down the name of a “need” and a “want”. Put all the words in a bag and allow each learner to draw a word. Take turns to draw a word and tell 

the class if the word is a “need” or “want” and explain why. 

Learners practice AutoSum in a spreadsheet by listing basic needs in column A and the price in column B. Use AutoSum to get the total. 

Week 3-4: 

Show learners an example of how an envelope is addressed. 

Collect a brochure from a PostNet outlet and discuss the services they offer.  

Display the following items in the class: a 5kg parcel containing clothes and toiletries, a letter to a friend overseas, an expensive piece of jewellery, a book etc. 

Learners each get a turn to tell the class the best way of sending these parcels or mail.  

Add tab stops. 

Participate in a discussion about ways to reduce spending. Write key words on the board. Keep track of your expenses for one week by writing it down.  

Play the Grocery Game. 

View videos on the internet about what a budget is. Create a mind map to show what you have learned and present it to the class.  

Week 5-6: 
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Copy and paste pictures in a text document to illustrate unsafe practices in a general office environment. 

Search the Internet for a company that deals with dangerous substances and find out what its policies and procedures are regarding the handling of dangerous 

substances.  Discuss this in groups. 

Search the internet about instructions relating to exposure to dangerous substances and hazards. Write down key words in a text document. 

Complete the worksheet by using the calculator to fill in the answers of 20 basic calculation sums.  

View videos about tricks to learn on the calculator and attempt one. Show and tell the class about your trick. 

Use brochures from different and discuss the service that banks provide.  

What documentation is needed when one wants to open an account at the bank? List the documentation in a new document. 

Once you have opened an account you will receive a bank card. Discuss how this card is used and how to withdraw money safely. 

Week 7-8: 

Visit the fire brigade to find out how to use a fire extinguisher in different circumstances.  

There are 4 basic steps to follow when using a fire extinguisher. Illustrate these in a new document using pictures and words.  

Design a poster to show what steps should be taken once a fire breaks out in the office. Work in pairs and explain the steps to your classmate. 

Use the grammar check feature. 

Change the automatic spelling and grammar check settings. 

Hide spelling and grammar errors in a document. 

Participate in a discussion about factors or behaviour that keeps conflict from happening. Type key words in a new document using WordArt. 

Search the internet to find examples of how to confront conflict.  Illustrate you answer in a new document by writing a few sentences.  

Participate in a discussion on the best ways to resolve conflict. Use role-play to practice resolving conflict in the best way possible.   

 

GRADE 5: THIRD  YEAR: TERM 3  

Week 1-2: 

Identify and name safety procedures for handling mail.  

Participate in a discussion about suspect letters or parcels. List the possible features of suspicious mail on the board. 

Use role-play to illustrate what to do or not to do when faced with a suspect letter or parcel. 

Practice typing words by inserting different types of bullets or numbering.  

Use exercises from workbooks or prepared examples to type sentences and inserting bullets or numbering. 
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Give a prepared page to learners in hard copy.  Learners copy the page in a new document and practice to use different bullets and numbering. View the 

document on completion. 

View videos on the internet about “needs vs. wants PowerPoint Presentations”. Class discussion to follow after watching the presentations on what was learned. 

Create a PowerPoint Presentation and use pictures and words to illustrate “needs” and “wants”.  

Give the learner a “salary” of R 1000 (play money). Ask him to “buy” needs and wants out of advertisements that do not exceed the R1000. Help learners who 

struggle to count to add the amount on a calculator or use a spreadsheet to add the total. 

Week 3-4: 

Can you name courier services in South Africa? Search the internet and find out what services courier companies offer. List key words in a new document.  

What goods are usually sent through couriers? What are the timeframes for these couriers? How does it compare to the timeframes of the South African postal 

service? Use brochures or the internet to find answers.   

How do you track a parcel sent trough a postal service? Search the internet to find answers and discuss in pairs. Give feedback to the class on how you would 

track your parcel. 

Tab and indent challenge. 

Participate in a discussion about income vs. expenditure. Explain that if your income is greater than your expenses, you will have money left over to save, spend 

and share. If your expenses are greater than your income, however, you will have to make some changes in order to avoid getting into debt. 

Play the Grocery Game. Give learners a grocery list and have them calculate in a spreadsheet how much everything will cost. Identify places where you could 

save money by buying alternative cheaper items. 

Participate in a discussion about how much money a teenager needs to "live" each month. Write responses on the board. Ask learners to identify how they spend 

money (answers may include clothing, entertainment, savings, etc.). Ask learners how they obtain the money they spend. Answers may include allowance from 

parents, chores, jobs, gifts, etc. Rewrite the income and expense items in the form of a monthly budget. 

Week 5-6:  

Create a PowerPoint Presentation and use words and pictures to illustrate unsafe practices in a general office environment. 

Do a survey in the office block (use a checklist) and see if it complies with general safety regulations.  

Identify potential hazards in the office or reception area of the school.  Write a brief report on your findings. The report must include the potential hazards and how 

the hazards can be removed or reduced. 

Complete the worksheet by using the calculator to fill in the answers of 20 basic calculation sums.  

View videos about tricks to learn on the calculator and attempt one. Show and tell the class about your trick. 
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Display examples of deposit slips and cheques in the class and explain to learners what these are and how they are used. 

Practice to fill in a deposit slip using examples from various banks. 

Use a worksheet to practice writing a cheque.  

Week 7-8: 

Draw a floor plan of the school indicating where fire extinguishers, fire hoses and alarms are located.  

Use role-play to illustrate how you would use a fire extinguisher in case of a fire break out.  

Design a fire exit emergency plan for your classroom and discuss how it should be followed. 

Spelling and grammar challenge. 

Participate in a discussion about the reasons behind workplace conflict. Create a mind map to illustrate the reasons.  

View videos on the internet about conflict management. Class discussion to follow after watching the videos on what was learned. 

Use the template of the I-statement provided as a method of communication that can help you express your feelings in a manner that is acceptable. 
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3.2.8 Grade 4: 1st, 2nd  and 3rd year Term 4 

 

 Grade 5: Term 4 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

1-2 Office practice  

Storage areas  

 

Understand the difference between 

assets and consumables and how they 

are monitored and replaced.  

  

 

Grade 5: First year:  

Activity 1:  Discuss the equipment in the class and explain to the learners the difference 

between assets and consumables. Use brochures from stationary and computer shops to 

make a collage of all assets in the class.   

Activity 2:  Type a list with all the assets (monitors, keyboards, punch etc.) that can be 

identified in the classroom. 

Activity 3:  Work in pairs and find out in the office how often consumables are replaced. 

Give feedback to the class.  

 Grade 5: Second year:  

Activity 1:   Participate in a discussion of how to monitor stock and equipment. Look for 

examples of stock control cards on the internet.  

Activity 2: Create a PowerPoint Presentation that illustrates the assets of the office using 

pictures and words.   

Activity 3:  Practice to fill in a template of a requisition form. 

 Teacher’s note: Find examples of templates by searching images of “requisition forms” 

on the internet.  

Grade 5: Third year:  

Activity 1:   List assets and consumables of the office by inserting a table in a new 

document with 2 columns. Name the assets and consumables in the 2 different columns. 

Add an extra column and paste a picture of the item.  

Activity 2:  Create a PowerPoint Presentation that illustrates the consumables of the 

office using pictures and words.  

Activity 3: Practice to fill in a template of a stock control card. 
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 Grade 5: Term 4 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Teacher’s note: Find examples of templates by searching images of “stock control cards” 

on the internet.  

Computer 

application  

 

Electronic  mail 

 

Demonstrate an understanding of 

electronic mail. 

 

 

 

Teacher’s note: Activities and screenshots taken from the free website:  

http://www.gcflearnfree.org/email101/1 

Grade 5: First year:  

Activity 1: Participate in a discussion about what email is and why it is used by so many 

people. How does email compares to traditional mail? Write key words on the board. 

Activity 2: Illustrate the difference between email and traditional mail regarding: address, 

delivery, time, content and cost. Insert a table in a new document with 2 columns and 5 

rows and write words to show the difference.  

Activity 3: Participate in a discussion about how one would go about to start with email. 

What does a standard email address look like? What is an email account? Who is the 

email provider? 
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 Grade 5: Term 4 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

 

Grade 5: Second year:  

Activity 1: If you want to sign up for your own email account, we suggest choosing from 

one of the three major webmail providers. Explore the following links and decide which 

one is most suitable for you, if you are older than 13 years.  

Follow the links below to sign up for an email account: 

-http://mail.yahoo.com/ :Click Create Account 

-http://www.microsoft.com/en-us/outlook-com: Click Sign Up 

-http://www.gmail.com/: Click Create an account 

Activity 2:  Visit the following link for help on Setting Up a Gmail Account: 

http://www.gcflearnfree.org/gmail/2 

Activity 3: Visit the following link to learn about email 

basics:  http://www.gcflearnfree.org/gmail  

Grade 5: Third year:  

Activity 1: Sign up for an email account.  

Activity 2: Share you email address with your friends and in return write down their 

addresses.  

Activity 3: Visit the following link to learn about Gmail: 

http://www.gcflearnfree.org/gmail 

Client 

services and 

communica-

tion  

 

Job application 

Demonstrate an understanding of how to 

prepare a resume. 

 

 

  

Teacher’s note: Activities and screenshots taken from the free website:  

http://www.gcflearnfree.org/resumewriting 

Grade 5: First year:  

Activity 1: Participate in discussion about what a resume is and what information it 

contains.  Use the interactive at http://www.gcflearnfree.org/resumewriting/1.3 to learn 

more. 

http://www.gcflearnfree.org/gmail/2
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 Grade 5: Term 4 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

Activity 2: Participate in a discussion about why a resume is important in the job search.  

Activity 3:  View the different templates availablefor resume writing in a Microsoft Office 

Online. 

  

  

Grade 5: Second and Third year:  

Activity 1: Identify and list the information you have to include on your resume in a new 

document.  

Activity 2: Explore different formats for resumes for e.g. chronological, functional and 

combination through http://www.gcflearnfree.org/resumewriting/2 

3-4 Office practice  

 

Storage areas  

Demonstrate an understanding of how to 

store stock safely and to use an inventory 

checklist.  

Grade 5: First year:  

Activity 1:   Participate in a discussion of where to store assets and consumables in an 

office.  Write key words on the board.  
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 Grade 5: Term 4 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

  Activity 2:  Brainstorm ideas on how to use shelves, racks and pallets safely when 

storing stock. Write key words on the board.  

Activity 3:  Search the internet to find out how to store dangerous or hazardous 

materials. Discuss your findings in pairs. 

Grade 5: Second year:  

Activity 1:   Inspect the storage area in your classroom. List ideas in a new document to 

illustrate how to utilize the storage area to make stock take easier. Activity 2:   Create a 

PowerPoint Presentation that illustrates how to store dangerous or hazardous materials. 

Use pictures and words. 

Grade 5: Third year:  

Activity 1:  Practice counting the stock in the classroom and storage area for e.g. 

monitors, keyboards, text books, staplers etc. and write it down on an inventory checklist. 

 Teacher’s note:  Find examples of templates by searching images of “inventory 

checklist” on the internet. 

Activity 2:  Set up a code of conduct that explains safety measures when storing stock.  

Computer 

application  

 

Electronic mail 

 

Demonstrate an understanding of 

electronic mail.  

Teacher’s note: Activities and screenshots taken from the free website:  

http://www.gcflearnfree.org/email101/2 

http://www.gcflearnfree.org/email101/3 

http://www.gcflearnfree.org/email101/4 

Grade 5: First year:  
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 Grade 5: Term 4 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

 

  

 

 

Activity 1:  Understanding the 

email interface of Gmail: Inbox:  

The inbox is where you'll view and 

manage emails you receive. 

Emails are listed with the name of 

the sender, the subject of the 

message, and the date received. 

 

Message pane:  

When you select an email in the inbox, it will open in the Message pane. From here, you 
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 Grade 5: Term 4 

WEEK
K 

TOPICS with 
focus area 

CONTENT 
The learner must be able to: 

Practical tasks 

can read the message and choose how to respond with a variety of commands.  

 

Compose pane:   

Click the Compose or New button from your inbox to open the Compose pane to create 

your own email message. From here, you'll need to enter the recipient's email 

address and a subject. You'll also have the option to upload files (photos, documents, 

etc.) as attachments and add formatting to the message.  

 

 

A Compose pane will also appear when you select Reply or Forward. The text 

from the original message will be copied into the Compose pane. 
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Common email terms and actions:  

All email applications use certain terms and commands that you will need to 

understand before using email. The examples below use Gmail's Compose 

pane and Message pane to introduce basic email terms, but these will still be 

applicable for Yahoo! or Outlook.com. 

 

 

 

 

Grade 5: Second year:  

Activity 1: In addition to email services, most webmail providers also offer an online 
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calendar and address book. These features make it easy to stay organized and access 

your important information from anywhere. 

 

 

 

Calendar basics:  

Online calendars make 

it easy to schedule 

appointments, organize 

tasks, and manage your 

time, just like a desk 

calendar. But unlike a 

physical calendar, online 

calendars give you the freedom to quickly edit and rearrange your schedule whenever 

you want. You'll even be able to access your calendar on the go and sync it across 

multiple devices, such as your mobile phone and personal computer. 
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Creating appointments:  

It's easy to schedule, track, 

and edit upcoming appointments or events. 

When you create a new appointment, you 

should (at the very least) include a title, 

a start and end time, and a location, but 

you can also include lots of other 

information, such as reminder preferences, 

detailed notes, and more. 

 

Switching views:  

You can choose a variety of 

view options for your calendar, 

including a daily, weekly, 

or monthly summary of your 

upcoming appointments. 

 

Using multiple calendars:  

If you keep a lot of different appointments, you can create multiple calendars to help 

organize your schedules. For example, you 

might use one calendar to keep track of your 

personal tasks and another to manage your 

family's schedule. Each calendar is 

assigned its own colour, so it's easy to 

organize lots of different appointments. You 

can even toggle calendars on and off to 
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easily sort your appointments. 

 

Sharing calendars:  

You can share your calendar with anyone who uses the same webmail provider. Once 

you've shared a calendar, you'll be able to view and even edit a friend's calendar, 

depending on your sharing preferences. 

Grade 5: Third year:  

Activity 1: Participate in a discussion about the importance of email etiquette. Search 

videos on the internet to learn about this topic.  

Activity 2: Visit http://www.gcflearnfree.org/email101/4.4 to learn about using email in 

the workplace.  

Activity 3: Identify and list the differences between email etiquette for personal use vs. in 

the workplace. 

Client 

services and 

communi-

cation 

Job application 

Demonstrate an understanding of how to 

prepare a resume. 

 

Grade 5: First, Second and Third year:  

Activity 1: Choose one of the templates for resume writing in Microsoft Office Online and 

practice to type your resume.  

 

5-6 Office practice  

 

Filing methods 

and systems 

 

Demonstrate an understanding of basic 

filing. 

Grade 5: First year:  

Activity 1: Participate in a discussion about what filing and indexing is.  Explain to the 

learner that filing is a system of classifying and arranging documents in an office for later 

use. The filing system is such that documents can be retrieved easily. Indexing is used 

in large filing systems to facilitate finding files. A card system is used for indexing. Stress 

the importance of having an uncomplicated filing system that is easy to understand. 

Write key words on the board.  
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Activity 2: What are the requirements of a good filing system? List key words in a new 

document.  

Activity 3:  Organise with the office administrator to show the learners the filing system 

that is used at school and talk about the following:  

indexing, card system, easy to use, appropriate, cost-effective, usefulness over time, 

current, secure, neatness.   

Grade 5: Second and Third year:  

Activity 1:   Make a collage or poster using pictures from brochures illustrating filing and 

indexing.   

Activity 2:   What are the requirements of a good filing system? Create a checklist in a 

new document with requirements.  

Activity 3:   Arrange a visit to the administrative office and inspect their filing system 

using the checklist created in activity 2.  

Computer 

application  

 

Internet safety 

 

Demonstrate and understanding of 

internet safety.  

Grade 5: First year:  

Activity 1:  Participate in a discussion about online safety and what dangers to look 

out for when using email for e.g. scams, cyber bullies, phishing and online predators.  

Teacher’s note: View http://www.gcflearnfree.org/email101/online-phishing-

scams-tips-to-avoid-the-hook and http://www.gcflearnfree.org/internetsafety/1.3 

to learn about this topic. 

Activity 2: Identify and list the physical risks when using the computer or mobile 

device in a new document.  

Activity 3: Search the internet to find facts and figures regarding internet addictions. 

Discuss your finding in groups.  

Grade 5: Second year:  

Teacher’s note: Activities and screenshots taken from the free website: 
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 http://www.gcflearnfree.org/internetsafetyforkids 

Activity 1: Search the internet to find videos about online safety. Discuss what was 

learned in pairs.   

 Activity 2:  Search the internet to find tips regarding online safety. Copy and paste 

images from your search in a new document. Print and display in the class.  

Activity 3: Create a PowerPoint Presentation illustrating the important tips you 

learned about internet safety, using words and pictures.  

Grade 5: Third year:  

Activity 1: Explain the following guidelines regarding online predators to the learners: 

 While it's not necessarily likely that your child will be contacted by a predator, the 

danger does exist. Below are some guidelines you can tell your kids to help them stay 

safe from online predators. 

-Avoid using suggestive screen names or photos. These can result in unwanted 

attention from online predators. 

-If someone is flattering you online, you should be wary. Although many people 

online are genuinely nice, predators may use flattery to try to start a relationship with a 

teen. This doesn't mean you need to be suspicious of everyone, but you should be 

careful. 

-Don't talk to anyone who wants to get too personal. If they want to talk about 

things that are sexual or personal, you should end the conversation. Once you get 

pulled into a conversation (or a relationship), it may be more difficult to stop. 

-Keep in mind that people are not always who they say they are. Predators may 

pretend to be children or teenagers to talk to kids online. They may use a fake profile 

picture and add other profile details to appear more convincing. 

-Never arrange to meet with someone you met online. Predators may try to 
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arrange a face-to-face meeting with a child or teen. Even if the person seems nice, 

this can be dangerous. 

-Tell a parent or trusted adult if you encounter a problem. If anyone makes you 

feel uncomfortable online, you should tell a parent or trusted adult immediately. You 

should also save any emails or other communication because they may be needed as 

evidence. 

You can visit the Crimes Against Children Research Center to view statistics and 

tips for talking to your kids about online predators. 

Who to contact if there's a problem:  

If you think your child is being contacted by an online predator, seek immediate help 

from the following resources: 

-Local police: If your child is in immediate danger, you should call 10111. Otherwise, 

you can call your local police's non-emergency number to report a problem. 

-AlwaysCyberTipline: Visit www.cybertipline.com from the National Center for 

Missing & Exploited Children to report crimes against children, including online 

enticement of children for sexual acts, obscene material sent to a child, and child 

pornography. 

Client 

services and 

communicatio

n  

 

Job application 

Demonstrate an understanding of how to 

prepare a cover letter for a resume. 

Teacher’s note: Activities and screenshots taken from the free website:  

http://www.gcflearnfree.org/coverletters/1 

Grade 5: First year:  

Activity 1: Participate in a discussion about the purpose of a cover letter. Explain to the 

learners that cover letters provide you with an opportunity to: 

-Demonstrate how well you express yourself and that you have researched the 

organization and position 

-Tell prospective employers what position you’re interested in, why you are interested in 

http://www.unh.edu/ccrc/internet-crimes/safety_ed.html
http://www.cybertipline.com/
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it, and how you came to know about it 

-Highlight a few key skills that demonstrate your qualifications for the specific organization 

and position 

-Thank the hiring manager in advance for her time and consideration 

-Cover letters provide hiring managers with a chance to decide whether to look 

at your resume and select a small number of resumes to read more closely. 

Activity 2: Visit http://www.gcflearnfree.org/coverletters/1.2 to learn about the parts of 

a cover letter.  

Activity 3: Visit http://www.gcflearnfree.org/coverletters/1.3 for an example of an 

effective cover letter.  

Grade 5: Second and Third year:  

Activity 1: Practice to type a cover letter by using the template in Microsoft Online. Use 

the following tips to help you: 

-Gather all necessary information first. 

- Follow directions. 

- Address your letter to a specific individual. 

- Write a rough draft. 

- Use good writing techniques. 

Teacher’s note: Tips taken from the free website: 

http://www.gcflearnfree.org/coverletters/1.4 

7-8 Office practice 

 

Filing methods 

and systems 

 

Demonstrate an understanding of basic 

filing. 

Grade 5: First year:  

Activity 1: Participate in a discussion about classifying, sorting and recording 

documents. Write key words on the board.  

Activity 2:  Organise with the office administrator to show learners the content of the 

filing system and show them what alphabetical and numerical classification looks like. 
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Activity 3: Search the internet for pictures of alphabetical and numerical classification. 

Copy and paste the pictures in a new document.  

Grade 5: Second year:  

Activity 1:  View videos, images and articles on the internet to learn about an 

alphabetical filing system. Discuss your findings in the class.   

Activity 2:  View videos, images and articles on the internet to learn about a numeric 

filing system. Discuss your findings in the class.   

Activity 3:  View videos, images and articles on the internet to learn about an 

alphanumeric filing system. Discuss your findings in the class.   

Grade 5: Third year:  

Activity 1: Complete the worksheet by matching the correct picture with the method of 

classification.  

Activity 2: Participate in a discussion about the different ways in which paper-based files 

can be stored for e.g. horizontal, vertical, lateral, tubular, cabinets, concertina files and 

folders. Find pictures to illustrate the different types of files and make a collage.  

Activity 3: Display different folders that must be filed correctly in the class. Some folders 

are alphabetical and some folders are numeric. Group together and sort. File in a cabinet.  

Computer 

application  

 

Social 

networking 

Demonstrate knowledge and 

understanding of responsibilities when 

learning about and using social media. 

Grade 5: First year:  

Activity 1: Identify and list social networks that you use or are aware of in a new 

document.  

Activity 2:  Search the internet to find videos about social networking safety. Ask 

learners to share their findings in class.  

Activity 3: Participate in a discussion of what is appropriate to share or post on social 

media. Write key words on the board.  

Grade 5: Second year:  
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Activity 1:  Create a table in a new document with 2 columns and 10 rows. Identify 

and list social networks that you use or are aware of and indicate how often you use 

them.  

Activity 2:  Search the internet to find tips about social networking safety. Copy and 

paste images from your search in a new document. Print and display in the class.  

Activity 3: Create a mind map to illustrate do’s and dont’s when sharing or posting on 

social media.   

Grade 5: Third year:  

Activity 1: View http://www.gcflearnfree.org/internetsafety/7 to learn about smart 

social networking. Participate in a discussion about the tips you find useful.  

Activity 2:  Create a PowerPoint Presentation illustrating the important tips you 

learned about social networking safety, using words and pictures.  

Activity 3:  Explain the following guidelines on how to stay safe when using social 

media to the learners: 

-Keep your posts private. On most social networking sites, you can choose to only 

share things with your friends. It's important to use this setting whenever possible 

because it makes it more difficult for people you don't know to gain access to your 

information. 

-Check your privacy settings frequently. Facebook sometimes reorganizes its 

privacy and account settings, which can cause your information to be shared with 

more people than you want. With Facebook or any other social networking site, you 

should review your privacy settings to make sure they are set the way you want them 

to be. 

-Be careful what you share. Even if you're keeping posts private, it doesn't 

guarantee that other people won't be able to see it. For example, if you share a photo 
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with your friends, they can easily save it to their computers and post it to another 

website. You shouldn't post something online unless you're comfortable with everyone 

in the world seeing it. 

-Don't add strangers to your friends list. Although it may be tempting to have 

thousands of "friends" online, this increases the chances that your photos and 

personal information will be shared with the world. 

-Keep in mind that things you post online may stay there for years. Even if 

something doesn't seem embarrassing, it may damage your reputation years later 

when you're looking for a job or applying to college. Employers and colleges often 

check social networking sites for information on candidates, so a photo or other post 

could lower their impression of you. 

-Use good netiquette. Netiquette is a set of guidelines for communicating online. 

Using good netiquette helps to ensure that the things you say aren't misinterpreted.  

Teacher’s note: Activity taken from the free website: 

http://www.gcflearnfree.org/internetsafetyforkids/4.2 

Client 

services and 

communicatio

n  

 

Rights and 

responsibilities 

of office worker  

Demonstrate an understanding of 

characteristics to ensure job success, 

workplace attire and personal hygiene.   

 

Grade 5: First year:  

Activity 1: Participate in a discussion of ways to ensure job success. List key words on 

the board.  

Activity 2: List key words in a new document that describes appropriate workplace attire.  

Activity 3:  Play a matching game that teaches learners about tools for personal hygiene 

and which body part to use them on. Draw pictures of soap, a toothbrush, fingernail 

clippers or mouthwash on one set of cards. Create another set of cards that shoes hands, 

teeth, nails and mouth. Flip all of the cards over and have learners match the tool to the 

body part. 

Grade 5: Second year:  
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Activity 1:  Participate in a discussion of ways to ensure job success. List key words in a 

new document. 

Activity 2:  Copy and paste pictures from the internet to illustrate how you would dress 

for work. Show and tell the class about your poster. 

Activity 3:  Design a poster to illustrate products needed to ensure personal hygiene and 

healthy habits. Show and tell the class about your poster.  

Grade 5: Third year:  

Activity 1:  Participate in a discussion of ways to ensure job success. List key words in a 

new document using WordArt. 

Activity 2: Display different types of clothes and accessories in the class. Learners’ show 

and tell if the clothes are appropriate or inappropriate workplace attire.  

Activity 3: Search the internet for images showing hygiene tips. Copy and paste images 

in a new document and discuss in pairs.  

9 Fun activities 

  

 

Search the internet to find videos and 

play games.  

 

Grade 5: First, Second and Third year:  

Open the web browser and explore the following websites:  

Activity 1:  www.kidscomputerlab.org/ 

Activity 2: 24games.com 

Activity 3:   nickjr.com 

 

FORMAL ASSESSMENT TASK: GRADE 5:  

Assessment is formally recorded during four (4) practical sessions with a minimum of four (4) skills reported. Learners, regardless of abilities, shall 

be assessed on the same skill. The following serves as suggestion of skills to record and report on. 

GRADE 5: FIRST YEAR: TERM 4 Week 1-2: 

Discuss the equipment in the class and explain to the learners the difference between assets and consumables. Use brochures from stationary and computer 
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shops to make a collage of all assets in the class.   

Type a list with all the assets (monitors, keyboards, punch etc.) that can be identified in the classroom. 

Work in pairs and find out in the office how often consumables are replaced. Give feedback to the class. 

Participate in a discussion about what email is and why it is used by so many people. How does email compares to traditional mail? Write key words on the board. 

Illustrate the difference between email and traditional mail regarding: address, delivery, time, content and cost. Insert a table in a new document with 2 columns 

and 5 rows and write words to show the difference.  

Participate in a discussion about how one would go about to start with email. What does a standard email address look like? What is an email account? Who is 

the email provider?”  

Participate in discussion about what a resume is and what information it contains. 

Participate in a discussion about why a resume is important in the job search.   

View the different templates available for resume writing in a Microsoft Office Online.   

Week 3-4:  

Participate in a discussion of where to store assets and consumables in an office.  Write key words on the board.  

Brainstorm ideas on how to use shelves, racks and pallets safely when storing stock. Write key words on the board. 

Search the internet to find out how to store dangerous or hazardous materials. Discuss your findings in pairs. 

Learn how to interact with an email interface, including the inbox, the Message pane, and the Compose pane. 

Participate in a discussion about income vs. expenditure. Explain that if your income is greater than your expenses, you will have money left over to save, spend 

and share. If your expenses are greater than your income, however, you will have to make some changes in order to avoid getting into debt. 

Brainstorm ideas of how to earn extra pocket money as a teenager. List ideas in a new document.  

Pretend you want to buy a big item for e.g. a cell phone. Do research to find the best deal if you have R500 to spend. Make a presentation showing your income 

and what you will receive for this purchase. 

Choose one of the templates for resume writing in Microsoft Office Online and practice to type your resume.  

Week 5-6: 

Participate in a discussion about what filing and indexing is.   

What are the requirements of a good filing system? List key words in a new document.  

Organise with the office administrator to show the learners the filing system that is used at school. 

Participate in a discussion about online safety and what dangers to look out for when using email for e.g. scams, cyber bullies, phishing and online predators.  
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Identify and list the physical risks when using the computer or mobile device in a new document.  

Search the internet to find facts and figures regarding internet addictions. Discuss your finding in groups. Visit http://www.gcflearnfree.org/coverletters/1.3 for an 

example of an effective cover letter.  

Participate in a discussion about the purpose of a cover letter. 

Visit http://www.gcflearnfree.org/coverletters/1.2 to learn about the parts of a cover letter. 

Week 7-8:  

Participate in a discussion about classifying, sorting and recording documents. Write key words on the board.  

Organise with the office administrator to show learners the content of the filing system and show them what alphabetical and numerical classification looks like. 

Search the internet for pictures of alphabetical and numerical classification. Copy and paste the pictures in a new document.  

Identify and list social networks that you use or are aware of in a new document.  

Search the internet to find videos about social networking safety. Ask learners to share their findings in class. 

Participate in a discussion of what is appropriate to share or post on social media. Write key words on the board.  

Participate in a discussion of ways to ensure job success. List key words on the board.  

List key words in a new document that describes appropriate workplace attire.  

Play a matching game that teaches learners about tools for personal hygiene and which body part to use them on. Draw pictures of soap, a toothbrush, fingernail 

clippers or mouthwash on one set of cards. Create another set of cards that shoes hands, teeth, nails and mouth. Flip all of the cards over and have learners 

match the tool to the body part. 

 

GRADE 5:  

SECOND YEAR: TERM 4  

 

Week 1-2:  

Participate in a discussion of how to monitor stock and equipment. Look for examples of stock control cards on the internet.  

Create a PowerPoint Presentation that illustrates the assets of the office using pictures and words.   

Practice to fill in a template of a requisition form. 

Identify and list the information you have to include on your resume in a new document.  

Explore different formats for resumes for e.g. chronological, functional and combination through http://www.gcflearnfree.org/resumewriting/2 
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Week 3-4: 

Inspect the storage area in your classroom. List ideas in a new document to illustrate how to utilize the storage area to make stock take easier. 

Create a PowerPoint Presentation that illustrates how to store dangerous or hazardous materials. Use pictures and words. 

Understand the online calendar and address book. 

Choose one of the templates for resume writing in Microsoft Office Online and practice to type your resume.  

Week 5-6: 

Make a collage or poster using pictures from brochures illustrating filing and indexing.   

What are the requirements of a good filing system? Create a checklist in a new document with requirements. 

Arrange a visit to the administrative office and inspect their filing system using the checklist created in activity 2. 

Search the internet to find videos about online safety.  

Search the internet to find tips regarding online safety. Copy and paste images from your search in a new document. Print and display in the class.  

Create a PowerPoint Presentation illustrating the important tips you learned about internet safety, using words and pictures.  

Practice to type a cover letter by using the template in Microsoft Online. 

Week 7-8: 

View videos, images and articles on the internet to learn about an alphabetical filing system. 

View videos, images and articles on the internet to learn about a numeric filing system.  

View videos, images and articles on the internet to learn about an alphanumeric filing system.  

Create a table in a new document with 2 columns and 10 rows. Identify and list social networks that you use or are aware of and indicate how often you use them. 

Search the internet to find tips about social networking safety. Copy and paste images from your search in a new document. Print and display in the class.  

Create a mind map to illustrate do’s and dont’s when sharing or posting on social media.   

Participate in a discussion of ways to ensure job success. List key words in a new document. 

Copy and paste pictures from the internet to illustrate how you would dress for work. Show and tell the class about your poster. 

Design a poster to illustrate products needed to ensure personal hygiene and healthy habits. Show and tell the class about your poster. 

GRADE 5: THIRD  YEAR: TERM 4  

Week 1-2:  

List assets and consumables of the office by inserting a table in a new document with 2 columns. Name the assets and consumables in the 2 different columns. 

Add an extra column and paste a picture of the item. 
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Create a PowerPoint Presentation that illustrates the consumables of the office using pictures and words.  

Practice to fill in a template of a stock control card. 

Sign up for an email account. 

Share you email address with your friends and in return write down their addresses.  

Identify and list the information you have to include on your resume in a new document.  

Explore different formats for resumes for e.g. chronological, functional and combination through http://www.gcflearnfree.org/resumewriting/2. 

Week 3-4: 

Practice counting the stock in the classroom and storage area for e.g. monitors, keyboards, text books, staplers etc. and write it down on an inventory checklist. 

Set up a code of conduct that explains safety measures when storing stock. 

Participate in a discussion about the importance of email etiquette. Search videos on the internet to learn about this topic.  

Visit http://www.gcflearnfree.org/email101/4.4 to learn about using email in the workplace.  

Identify and list the differences between email etiquette for personal use vs. in the workplace. 

Participate in a discussion about income vs. expenditure. Explain that if your income is greater than your expenses, you will have money left over to save, spend 

and share. If your expenses are greater than your income, however, you will have to make some changes in order to avoid getting into debt. 

Play the Grocery Game. Give learners a grocery list and have them calculate in a spreadsheet how much everything will cost. Identify places where you could 

save money by buying alternative cheaper items. 

Participate in a discussion about how much money a teenager needs to "live" each month. Write responses on the board. Ask learners to identify how they spend 

money (answers may include clothing, entertainment, savings, etc.). Ask learners how they obtain the money they spend. Answers may include allowance from 

parents, chores, jobs, gifts, etc. Rewrite the income and expense items in the form of a monthly budget. 

Choose one of the templates for resume writing in Microsoft Office Online and practice to type your resume.  

Week 5-6: 

Make a collage or poster using pictures from brochures illustrating filing and indexing.   

What are the requirements of a good filing system? Create a checklist in a new document with requirements. 

Arrange a visit to the administrative office and inspect their filing system using the checklist. 

Understands guidelines regarding online predators. 

Practice to type a cover letter by using the template in Microsoft Online. 

Week 7-8: 
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Complete the worksheet by matching the correct picture with the method of classification. 

Participate in a discussion about the different ways in which paper-based files can be stored for e.g. horizontal, vertical, lateral, tubular, cabinets, concertina files 

and folders. Find pictures to illustrate the different types of files and make a collage.  

Display different folders that must be filed correctly in the class. Some folders are alphabetical and some folders are numeric. Group together and sort. File in a 

cabinet. 

 View http://www.gcflearnfree.org/internetsafety/7 to learn about smart social networking.  

 Create a PowerPoint Presentation illustrating the important tips you learned about social networking safety, using words and pictures. 

 Understand guidelines on how to stay safe when using social media. 

 Participate in a discussion of ways to ensure job success. List key words in a new document using WordArt. 

 Display different types of clothes and accessories in the class. Learners’ show and tell if the clothes are appropriate or inappropriate workplace attire.  

 Search the internet for images showing hygiene tips. Copy and paste images in a new document and discuss in pairs. 
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4 SECTION 4: 

ASSESSMENT 

Subject specific content to be added to generic section 4 after public comment changes/corrections have been 

made. 

Assessment across the 5 years 

Assessment is formally recorded during four (4) practical sessions with a minimum of four (4) 

skills reported. Learners, regardless of abilities, shall be assessed on the same skill. The teaching 

plan includes three suggested activities to be taught over the two or three years for the three 

topics for every two weeks. (Activity 1 is suggested for the first year the learner is in the grade, 

activity 2 for the second year the learner is in the grade and activity 3 for the third year the learner 

is in the grade). Activities should be chosen depending on resources, time available and level of 

understanding of learners. The teacher will choose the assessment goal for the relevant activity 

that was done. The following serves as suggestion of skills to record and report on. 

Grade 4 – Practical assessment tasks: choose a minimum of four (4) per term 

               – Theoretical assessment tasks: choose a minimum of one (1) per term 

TERM 1 

Week Assessment task 

1-2 Identify, point out or name the different parts of the computer. 

Identify, point out or name the different components on the keyboard i.e. the function, typing, 
numeric, control, windows, shift, alt, enter and cursor keys. 

Understand healthy personal habits for e.g. brush your teeth twice daily, shower or bath 
once a day, wash your hair regularly and wash your hands often. 

3-4 
 

Understand the basic operations on a computer: switch the computer on and off, move and 
click the mouse correctly, identify the basic keys on the keyboard, identify the icons of the 
programmes on the computer and exit the programmes. 

Identify, point out or name the different parts of the keyboard that are used for entering and 
editing (enter, backspace, space bar, delete keys and navigation/cursor keys (arrows for up, 
down, left and right). 

Understand the importance of personal grooming habits for customer services.  

5-6 Demonstrate the correct typing position and ergonomics.   

Demonstrate basic editing features in a word processor: to delete, select, copy and 
paste, cut and paste, drag and drop, find and replace.  

Understand dress code that is in accordance with a specific work place requirement. 

7-8 Understand how to take care of a computer by cleaning the peripherals and using removable 
devices carefully and correctly.  

Understand basic operations on the computer: open a programme, navigate the desktop 
moving through windows, save a document, close a document and activate an existing 
document. 

Understand the basic terms related to HIV and AIDS.  
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TERM 2 

Week Assessment task 

1-2 Review the different parts of the computer, e.g. screen, keyboard, mouse, system unit and 
printer. Review how to take care of the different parts of the computer. Review different 
electronic devices, e.g. tablets, cell phones, mp3 players, removable disks, CD’s and 
cameras. 

Identify, point out or name the components on the keyboard relating to the home row 
alphabet keys (asdfjkl ;). 

Understand the basic principles of office safety i.e. things that are dangerous in the office for 
e.g. liquids, stairs, windows, carpets, stacked items, plugs, sharp edges of furniture etc.  

3-4 Identify, point out or name general office equipment and what they are used for. 

Identify, point out or name the components on the keyboard relating to the top row alphabet 
keys (qwertyuiop). 

 Identify and or list the basic principles of fire safety and what to do if a fire breaks out in the 
office.  

5-6 Understand general office equipment: staplers, punches and a guillotine.  

Identify, point out or name the components on the keyboard relating to the bottom row 
alphabet keys (zxcvbnm). 

Understand basic first aid procedures for nose bleeds, cuts, scratches, fainting, bruising and 
sprains.  

7-8 Understand the basic operation of a photocopying and fax machine.   

Identify, point out or name the home, bottom and top row on the keyboard and understand 
the correct typing position. 

Identify, point out or name items needed in a first aid kit:first-aid manual, sterile gauze pads 
of different sizes, adhesive tape, aadhesive bandages in several sizes, elastic bandage, a 
splint, antiseptic wipes, soap, antiseptic solution , sharp scissors, safety pins, thermometer, 
plastic non-latex gloves, mouthpiece for administering CPR and list of emergency phone 
numbers. 

TERM 3 

Week Assessment task 

1-2 Understand the basic principles of office safety i.e. things that are dangerous in the office for 
e.g. loose carpets, faulty electrical wiring, broken windows, blocked fire escapes, stacked 
filing, heaters and open cupboards and drawers.   

Understand basic operations with tables: insert a table, change or delete borders, shading, 
vertical text, different alignment of cells and columns, insert or delete columns or rows, 
merge and split cells. 

Understand basic telephone etiquette. 

3-4 Understand the basic principles of office safety i.e. things that are dangerous in the office for 
e.g. loose carpets, faulty electrical wiring, broken windows, blocked fire escapes, stacked 
filing, heaters and open cupboards and drawers.   

Understand basic operations with headers and footers: typing capital letters and using the 
header / footer function. 

Speak professionally to clients over the telephone using general telephone etiquette. 

5-6 Identify, point out or name official safety signs in the office. 

Understand basic formatting features: bold, italics and underline. 

Understand the difference between “needs” and “wants” concerning personal finance.  

7-8 Understand an emergency evacuation drill.  
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Understand basic formatting features: change the font type, size and colour.  

Understand personal income vs. expenditure concerning personal finance. 
 

TERM 4 

Week Assessment task 

1-2 Understand the requirements for a successful reception area: verbal communication and 
non-verbal communication. 

Understand basic formatting features: change alignment (left, center, right, and justify) and 
the line spacing of the text.  

 Show an understanding about the need for ethics in the workplace.  

3-4 Understand the requirements for a successful reception area: characteristics of the office 
worker.  

Understand special characters on the computer: type special characters, symbols and 
punctuation marks available on the keyboard (!@#$%^&*?<>.,) 

Understand the basic rights and responsibilities of the office worker.  

5-6 Understand the requirements for a successful reception area: effective communication 

Demonstrate the page layout features: change the A4 orientation to landscape or portrait, 
change the paper size and page margins.  

Understand the types of customers one can expect to come across in the work 
environment. 

7-8 Understand the requirements for a successful reception area: human relations. 

Demonstrate basic operations of the computer: how to print a document.  

Understand how to greet a customer correctly.  

Grade 5 – Practical assessment tasks: choose a minimum of four (4) per term 

               – Theoretical assessment tasks: choose a minimum of one (1) per term 

TERM 1 

Week Assessment task 

1-2  Identify, point out or name the different parts of the computer. 

Demonstrate knowledge of the parts of the keyboard and use the correct typing position: the 
function, typing, numeric, control, windows, shift, alt, enter and cursor keys. 

Understand healthy personal habits and basic hygiene. 

3-4 Demonstrate how to take care of a computer by cleaning the peripherals and using removable 
devices carefully and correctly.  

Use the keyboard skilfully and accurately by typing the home row (asdfgh;lkj), top row 
(qwertyuiop) and bottom row (zxcvbnm), inserting a capital letter, using bold, italics and  
underline, change the font type and size and punctuation and  special characters.  

Understand unhealthy personal habits and bad basic hygiene and the basic principles of sick 
leave. 

5-6 Demonstrate basic operations on the computer: switch the computer on and off, move and click 
the mouse correctly, identify, point out or name the basic keys on the keyboard, the names and 
icons of the programmes on the computer and how to exit the programmes. 

Demonstrate basic editing features in a paragraph and tables: text selection, copy, paste, insert 
letters or words, delete letters or words, change order of words, insert or delete rows and 
columns, change borders and shadings, change cell alignment, change text direction, save with 
a new name.  
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Interpret body language in a business environment. 

7-8 Use general office equipment and understand the basic operation of a photocopying, fax and 
shredding machine.   

Demonstrate basic file management.  

Understand different methods of handshakes and the importance of personal space. 

TERM 2 

Week Assessment task 

1-2 Understand different types of office layouts: open plan, cubicle, corridor or panoramic layouts.  

Demonstrate basic operations with shapes: insert and edit a shape. 

Understand basic first aid procedures for nose bleeds, cuts, scratches, fainting, bruising and 
sprains.  

3-4 Interpret a basic office floor plan. 

Demonstrate how to insert a picture or clip art.  

Identify, point out or name potential hazards in the office environment.  

5-6 Understand what furniture is used in an office environment. 

Demonstrate the use of text boxes and WordArt and their effects. 

Understand the need to be punctual at work, the smoking policy and good listening skills.  

7-8 Understand why office cleanliness is important. 

Demonstrate basic operations with pictures: edit a picture. 

Understand the need for a positive attitude to work, to keep your colleagues informed about 
work activities and code of conduct in the workplace. 

TERM 3 

Week Assessment task 

1-2 Understand basic principles of mailing systems.  

Demonstrate basic formatting features on the computer: type a paragraph using bullets and 
numbering. 

Differentiate between “needs” and wants” concerning personal finance.  

3-4 Understand basic principles of mailing systems. 

Demonstrate basic formatting features on the computer: indents and tabs. 

Understand the basic personal financial principals of income vs. expenditure for example food, 
shelter, water air, bicycle, toys, sweets, bread or clothing. 

5-6 Understand and name unsafe practices, hazards and dangerous substances and how to reduce 
or remove them.  

 Understand the calculator utility. 

Demonstrate knowledge of banking services regarding accounts, credit card facilities and ATM 
use.  

7-8 Understand the need for and use of fire fighting equipment in the workplace.  
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Demonstrate the use of the spelling and grammar tool 

Understand and deal with conflict in the office environment. 

TERM 4 

Week Assessment task 

1-2 Understand the difference between assets and consumables and how they are monitored and 
replaced.  

Demonstrate an understanding of electronic mail. 

Demonstrate an understanding of how to prepare a resume. 

3-4 Demonstrate an understanding of how to store stock safely and to use an inventory checklist.  

Demonstrate an understanding of electronic mail.  

Demonstrate an understanding of how to prepare a resume. 

5-6 Demonstrate an understanding of basic filing. 

Demonstrate and understanding of internet safety.  

Demonstrate an understanding of how to prepare a cover letter for a resume. 
 

7-8 Demonstrate an understanding of basic filing. 

Demonstrate knowledge and understanding of responsibilities when learning about and using 
social media. 

Demonstrate an understanding of characteristics to ensure job success, workplace attire and 
personal hygiene.   

 

 

 

REFERENCE  

http://www.gcflearnfree.org/: (Permission granted to use tutorials, activities and screenshots). 

http://www.gcflearnfree.org/office2010/word2010 

http://www.gcflearnfree.org/office2010/powerpoint2010 

http://www.gcflearnfree.org/office2010/excel2010 

http://www.freetypinggame.net/proper-hand-placement.aspalex.state.al.us/lesson view.php?id=7505) 

http://www.avert.org/quizzes/hiv-aids-quiz-easy 

http://www.dancemattypingguide.com 

http://www.firefacts.org/ 

http://www.sdcda.org/office/girlsonlytoolkit/toolkit/got-05- 

http://healthfitness.ideafit.com/fitness-library/tools-for-teaching-effective-communicationcommunication.pdf 

http://www.slideshare.net/ 

http://www.andrewjensen.net/5-ways-to-properly-greet-a-customer/ 

http://www.kids-online.net/ 

Acthttp://windows.microsoft.com/en-za/windows7/using-calculator-in-windows-7  

Office Practice Student Book Level 2, Wanda Booysen and Danie Nel, Seyfferdt Publishers, 2007 

http://www.dancemattypingguide.com/
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Office Practice Hands-on Training 2, Ilse Serffontein, Future Managers, 2012 

Business Practice Student Book Level 2, Wanda Booysen, Seyfferdt Publishers, 2007 

Business Practice Hands-on Training, N. Cilliers and P. Bruwer, Future Managers 2006 

Office Data Processing 2 Hands-on Training MS Office 2010, Irma Fourie, Future Managers, 2013 

Office Data Processing, Student Book Level 2, M. Mguni and M. Dlamini, Seyfferdt Publishers, 2007 

The curriculum for Office Administration is based on the following SAQA Qualification and Unit Standards’: 

SAQA  

Qualification ID 

Qualification Title  

*23833  National Certificate: Business Administration Services  

Subfield: Office Administration, NQF level 2 

61755 General Education and Training Certificate: Business Practice 

Subfield:  Finance, Economics and Accounting 

 

SAQA:  

Unit Standard Number 

Title  

US ID 61755 

Use fundamental skills in an office environment 

Incorporate life skills in an employment or self-employment situation 

Understand basic business knowledge and attitude 

US ID 116932 Operate a personal computer system 

US ID 115091 Understand safety, health and environmental requirements 

 US ID 9357 
Develop keyboard techniques to key-in alpha and numeric text, symbols and 

special characters 

US ID 117924 
Use a Graphical User Interface (GUI) based word processor to create, edit and 

format documents 

US ID 7570 
Produce a variety of office documents according to acceptable business 

guidelines 

*US ID 116945   Use electronic mail to send and receive messages 

US ID 116931 Use graphical user interface (GUI) based web browser to search the internet 

*US ID 110082   Understand and apply good customer service 

US ID 12537 Identify, point out or name and apply good values and ethics in the workplace 

US ID 243189 Managing personal finance 

US ID 14656 Demonstrate an understanding of sexuality and STD’s 

US ID 243193 Practice good health, grooming habits and office etiquette 

 
Demonstrate knowledge and correct use of office equipment and mailing 

systems 

*US ID 14351   Maintain and manage the reception area 

*US ID 14338   Attend to customer enquiries in an office setting 

*US ID 14355   Maintain and manage storage area/Order and distribute office supplies 

*US ID 14352   Manage a diary for self and others 
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Understand the different filing methods and –systems and are up to date with 

filing accessories 

 Demonstrate an understanding of the job application process 

*US ID 110064  Contribute to the health and safety of the workplace 

*US ID 7571  
Demonstrate the ability to use electronic mail software to send and receive 

messages 

*US ID 8104  Operate and take care of equipment in an office environment 

*US ID 14348  Process incoming and outgoing telephone calls 

*US ID 10717  
Examine the applications of the Basic Conditions of Employment Act and its 

effect on earnings in own contract 

*US ID 7568  
Demonstrate knowledge of and produce word processing documents using basic 

functions 

US ID 243189 Manage personal finances 
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Based on the information you have provided, we are more than happy to grant you 
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The link below contains links to the offline version of our tutorials, which are available 
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can do to help you with the people you serve! 
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